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About This Manual
PREFACE

PREFACE

About This Manual
This manual relates to the Vibro-Meter VM600 Condition Monitoring System (CMS) Software.
This is Volume 1 of the CMS Software manual. It provides a general system description, as
well as instructions on installing, configuring and operating the CMS system.
Volume 2 of this manual describes optional modules of the CMS Software that can be
purchased separately.

Who Should Use This Manual
This manual is written for integrators and operators of condition monitoring systems using the
VM600 CMS Software. 
Integrators and operators are assumed to have the necessary technical training to install,
configure and use the CMS Software system.

Applicability of This Manual
This manual applies to Version 2.2 of the CMS Software package. It reflects the features
available with Version 2.2, and may not be applicable to earlier or later versions of the
software.
Please note that this manual describes use of the CMS Software with a standard Windows
configuration in English. If using a different locale, you may need to modify certain
parameters, for example, use a comma (“,”) as the decimal point in numbers.

Licensing
The purchase of the CMS Software includes licenses for the CMS Software, as well as the
embedded database package. 
The installation and use of the database package is strictly limited to the number of
licenses purchased through Vibro-Meter. Additional licenses must be purchased
directly or indirectly from Sybase. Also, the use of the database product embedded
into the delivery is strictly limited to exclusive use with the VM600 CMS Software.
Other uses must be explicitly authorised by Sybase. 

Related Publications and Documentation
Related documents are: 
• VM600 Condition Monitoring System (CMS) Software Manual, Volume 2 - Optional

Modules
Vibro-Meter Document No. MACMS-SW/E

• VM600 Condition Monitoring System (CMS) Quick Start Manual 
Vibro-Meter Document No. MACMS-QS/E

• VM600 Condition Monitoring System (CMS) Hardware Manual 
Vibro-Meter Document No. MACMS-HW/E
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• VM600 Networking Instruction Manual 
Vibro-Meter Document No. MAVM600-NET/E

Release Notes
Before continuing, please read the Release Notes provided with the CMS Software
Installation Kit. The Release Notes contain important information about:
• New product features 
• Resolved problems and bug fixes
• Known issues
• Compatibility with earlier software versions.
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SAFETY

Symbols and Styles Used in This Manual
The following symbols are used in this manual where appropriate :

NOTE : This is an example of the NOTE paragraph style. This draws the operator’s
attention to complementary information or advice relating to the subject being
treated.

The WARNING safety symbol
THIS INTRODUCES DIRECTIVES, PROCEDURES OR PRECAUTIONARY MEASURES WHICH
MUST BE EXECUTED OR FOLLOWED. FAILURE TO OBEY A WARNING CAN RESULT IN
INJURY TO THE OPERATOR OR THIRD PARTIES.

The CAUTION safety symbol
This draws the operator's attention to information, directives or procedures
which must be executed or followed. Failure to obey a caution can result in
damage to equipment.
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The VM600 Condition Monitoring System
INTRODUCTION

1 INTRODUCTION

1.1 The VM600 Condition Monitoring System
This chapter describes the main features of the VM600 Condition Monitoring System (CMS)
software. For hardware details, refer to the VM600 Condition Monitoring System (CMS)
Hardware Manual.
The VM600 CMS system integrates machinery protection and condition monitoring functions
in a single, modular system. As shown in Figure 1-1, the system is made up of: 
• Vibro-Meter machinery protection systems (MPS) and condition monitoring systems

installed in one or more VM600 racks. VM600 racks can contain CMS-only cards
(CMC 16, IOC 16T, etc.), or a mixture of CMS and MPS cards (for example, with
additional MPC 4, IOC 4T or RLC 16 cards).

• A relational database, in which the system’s configuration details, acquired
measurement data, and offline data are stored.

• CMS Software, a collection of software programs, including modules to manage the
transfer of data from the VM600 racks, store and retrieve data in the database and
process, and display the resulting data. 

VM600 Hardware Rack(s)

Acquire Data

CMS Software Database
Store and 
Retrieve 

Data

Machinery equipped with 
sensors

Process and 
Display Data

Transfer Data

Figure 1-1 : The VM600 CMS System
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1.2 Data Acquisition
The VM600 CMS system provides:
• Automatic acquisition and storage of all relevant data for the machinery being monitored
• Long-term trending and continuous checking for limit exceedences
• Event logging (hardware events, limit-related events, user-events)
• Complementary high-resolution data acquisition (for example, scheduled, “on alarm”) 
• Automatic run-up and run-down data acquisition
• Fast Fourier Transform (FFT) based processing

1.2.1 Data Acquisition Modes
The data acquisition modes represent the building blocks from which a condition monitoring
system is assembled. The focus necessarily varies a lot between applications, so it is
important to introduce the data acquisition capabilities–and thus to clearly define each in
physical terms.
In order to introduce the terms and definitions used in this chapter, Figure 1-2 shows the
basic parameters underlying every available measurement mode. 
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Raw Signal

Time Domain

Spectrum Data

• Number of samples
• Sampling frequency

• Number of lines
• Bandwidth

Derived from raw signal or spectrum
data:
• 1st harmonic
• Overall band
• etc.

Figure 1-2 : Basic Data Acquisition Parameters
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Where:
• Raw Signal. The start of the data acquisition chain is the acquisition of a raw signal from

a sensor representing a physical parameter. This time-domain data, or time series, is
made up of a specific number of samples, and a sampling frequency. 

• Spectrum Data. Based on the time-domain based data series, a spectrum is calculated
using Fast Fourier Transform (FFT) algorithms. The resulting representation of the data
in the frequency domain is characterized by the frequency resolution, or the number of
lines in the spectrum, together with the bandwidth. 

• Trend Data. The last step is the extraction of parameters that may be characteristic of a
certain machine condition, and which may be derived from either the time-domain or
spectrum data. For this, different types of rectifier functions (see 1.2.3 - Rectifiers:
Time-Domain Based Outputs vs FFT-Based Outputs) are available. Many features of the
CMS system are based on these derived parameters, which is the most condensed form
of data, and often the most efficient format to use to monitor the condition of machinery.
Trending these outputs over longer periods of time is most suitable for the detection of
future trends, which would be difficult to detect using raw signal data alone. The CMS
system is therefore equipped with advanced features for the processing of such trend
data and the automatic logging of relevant trend data. 

1.2.2 FFT-Based Processing
The VM600 CMC 16 card is an FFT-based card. This means that it is capable of acquiring
data in the time domain (e.g. vibration “waveforms”) and converting the data into the
frequency domain to obtain a spectrum. This is done using sophisticated mathematical
algorithms implemented in software embedded on the CMC 16 card itself.
Both the time- and frequency-domain information can be analysed to obtain a set of
characteristic numbers that may be meaningful for a particular machine condition. These
numbers can differ greatly between applications, and are very specific to the type of
machinery being monitored. As an example, for a vibration monitoring application, the
following parameters may be of interest: 
• First harmonic (amplitude and phase)
• Intensity within a frequency band (for example, shown as an RMS value)
Acquisition of the raw signal data is performed on all 16 channels of the CMC 16 card in
parallel. The signal processing, by contrast, is performed by a single Digital Signal Processor
(DSP) chip on the card. The architecture is dedicated to the measurement of dynamic,
constantly changing, data such as vibrations and pressures. However, the system can also
process slowly evolving data, also called “quasi-static” data, such as analog measurements,
temperatures, process values, and so on. This is possible because signal processing
requires only a subset of the functionality required for processing dynamic data. 
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1.2.3 Rectifiers: Time-Domain Based Outputs vs FFT-Based Outputs
Various rectifier functions are applicable for time-domain based, or FFT-based outputs, as
shown in Figure 1-3:

For time-domain based outputs, the following rectifier functions are available: 
• True RMS
• True Peak
• True Peak-to-Peak
• DC (Gap) component of the signal
• Smax. This is a special case of combined dual-channel processing, but is also based on

time-series data. 
For FFT-based outputs, the following rectifier functions are available:
• RMS
• Peak (scaled from RMS) 
• Peak-to-peak (scaled from RMS)
• Band peak. This function selects the highest amplitude within a certain frequency band

of a spectrum at any given moment.
The FFT-based outputs are also referred to as frequency bands. 

1.2.4 Frequency Band Extraction
The CMS Software allows the extraction of frequency bands (spectral components) for
machinery diagnostics, that is, the definition of frequency ranges to which a particular rectifier
function is applied. These outputs can be monitored and trended. Figure 1-4 below shows a
spectrum with several bands selected. In this example, “1X” refers to the 1st order, also
known as the first harmonic or fundamental frequency. 
The CMS Software allows individual orders to be extracted, for example, the 3rd order (3X).
Additionally, the spectral energy in a band can be monitored by defining a range such as
(0.2 to 0.6) X. It is thus possible to address individual lines in the spectrum, seamlessly stack
frequency bands to cover the entire measured range, and to analyse overlapping bands. 
Alarm and alert thresholds can be set individually for each output band.

Dynamic 
channel

Time-Domain 
Based

FFT-based Band Start
Band End

True RMS
True Peak

True Peak-to-Peak
DC (Gap)

Smax

RMS
Peak

Peak-to-Peak
Bank Peak

Point Setup Output Type Rectifier Function

Figure 1-3 : Time-Domain Based and FFT-Based Rectifiers
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1.2.5 Limits and Alarm Priorities
Each configured output (time-domain or FFT-based) has its own limits, against which it is
compared at the end of each processing cycle. The graph shown in Figure 1-5 shows the six
limits that can be configured, and which therefore define in which “range” the output is
considered to be by the system. Depending on the range, specific action can be taken.

Broadband Frequency
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(0.2 to 
0.6)X

1X

2X

3X

4X

Alert threshold

Alarm threshold

Alert threshold

Alarm threshold

Figure 1-4 : Principle of Band Extraction

time

Validation+

Alarm +

Alert +

Alert -
Alarm -

Validation -

HV+

HA+

Ha+

Ha-
HA-

HV-

Figure 1-5 : Alarm, Alert and Validation Levels
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Every change from one alert or alarm range to another automatically generates an entry in
the event log. A parameter called the “alarm priority” determines the action to be taken when
a high or low alarm exceedance occurs, as listed in Table 1-1. 

1.2.6 Averaging Waveform and Spectrum in scheduled mode
The CMC16 Card filters the vibration signal and then samples it before the waveform is
(Figure 1-6):
1- released 
2- submitted to the Fast Fourier Transformation to extract a Spectrum.

Figure 1-6 : Filtering and Sampling Vibration Signals

For scheduled data acquisition CMS offers an averaging feature for a) Fixed Frequency
Sampling: only Frequency domain averaging is available and b) orders sampling mode:
Averaging in the Time Domain (for waveform) and then in the Frequency Domain (for
spectrum) are available. Only one of averaging can be used and the value for the other
averaging must be one.

Figure 1-7 : Averaging in the Frequency and Time Domains

Table 1-1 : Alarm Priorities and Actions

Alarm priority Action

None No action taken.

Low The alarm is detected, an event is logged in the database, and the 
data acquisition rate is increased.

High The alarm is detected, an event is logged in the database, the data 
acquisition rate is increased, waveform and spectra are acquired. 

a) b)
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1.2.6.1 Time domain averaging

An average of n-waveforms is calculated. The resulting averaged waveform is then
FFT-processed. The resulting spectra are derived by complex averaging using amplitude and
phase (Figure 1-8).

Figure 1-8 : Process of Time Domain Averaging

1.2.6.2 Frequency domain averaging

n-waveforms are FFT-processed. The resulting n spectra are submitted to an amplitude
averaging function of mean value per line (Figure 1-9). The averaged spectrum can be with
linear, RMS or peak rectifying function. The phase from the last measurement (no average)
is provided. If time domain average is 1, then there is averaged waveform.

Figure 1-9 : Process of Time Domain Averaging
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1.3 Operating Modes
The CMS Software can operate in the following modes:
• Background 
• Transient
• Alternative
• Manual 
The operating mode is chosen either automatically by the system, or manually by the user.
The modes are shown in Figure 1-10.

1.3.1 Background Operating Mode
This is the system’s default operating mode. It is active for all possible machine states (see
1.4 - Machine States).
In background operating mode, the CMC 16 card assures the following:
• Continuous acquisition of 400-line spectra and extraction of predefined outputs
• Limit exceedance detection—the output status (normal/alert/alarm/validation) is

monitored
• Event logging—events are logged for channels and outputs to create a status history
• Logging of processed outputs according to predefined storage rates (see also

1.6 - Trending)
• System event detection and logging—hardware status, communication status, and so

on—are monitored
• Transient detection—tacho and channel status are checked as a basis for initiating

transient operating mode (see 1.3.2 - Transient Operating Mode below).
• Manual acquisition of real-time data—waveforms, spectra and orbits are transmitted to

the host and corresponding displays can be activated by the user
Data acquisition types available are:
• Trend data—time-domain based outputs, FFT-based outputs, or dual-channel based

Smax output.

"Background"
Operating Mode

(the default)

"Transient"
Operating Mode

"Manual"
Operating Mode

"Alternative"
Operating Mode

Continuous acquisition with logging
at predefined time intervals
(normal interval and alarm interval).
Averaging of measurements for
long-term trending

Acquisitions scheduled at
pre-defined time intervals
(allows high-resolution
acquisitions, etc.)

Real-time acquisitions
initiated by the user

Automatically activated on
detection of transient machine
condition (run-up, run-down, or
operational transient).
Acquisitions at pre-defined times
or machine speed intervals.

Figure 1-10 : VM600 Operating Modes
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1.3.2 Transient Operating Mode
This mode is activated when the system detects that the machine is in one of the transient
machine states (run-up, run-down, or operational transient).
Acquisition occurs at configurable time or speed intervals.
Data acquisition types available are:
• Transient cascade
• Transient trend data

1.3.3 Alternative Operating Mode
This mode is an alternative to the standard background operating mode. It is activated in the
following ways:
• On schedule: according to a pre-defined schedule (time interval)
• On alarm: on alarm exceedance, for example, when a vibration point exceeds the High

Alarm threshold.
Data acquisition in alternative mode occurs in parallel to background logging, that is,
background logging does not stop when alternative mode is activated.
Alternative mode can only be used when the machine state is “on load” (see 1.4 - Machine
States). The user can choose to acquire one of the following data types:
• Waveform only
• Spectrum only
• Waveform and spectrum
• Long waveform (also known as “oscilloscope mode”)
An Orbit acquisition may also be scheduled.

1.3.4 Manual Operating Mode
This mode allows the user to initiate real-time acquisition of the following: waveform,
spectrum, long waveform (“oscilloscope”), orbit and trend data (any configured output).
Manually requested data acquisition is only possible when the machine state (see
1.4 - Machine States) is “stopped” or “on load”. User requests for real-time data are
processed by the system with a lower priority than the other automatic data acquisition types. 

1.4 Machine States
The machine state describes the current condition of the rotating machinery being monitored.
Typically, the machine state is related to the rotational speed of the machinery. 
Machine states are closely related to data acquisition types (see 1.5 - Data Acquisition
Types), which describe data acquisition in physical terms, such as the number of samples,
sampling frequency, bandwidth, and so on. 
The following machine states can be identified during a typical engine cycle:
• Stopped

The machine speed is below a pre-defined threshold known as the Lowspeed Cutoff.
• Run-up

The machine has started up and its speed is between the Lowspeed Cutoff and the
Lowspeed Trigger values.

• Running “on load”
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This is the normal operating condition, with the machine running at or close to its nominal
speed. The condition is defined by the Overspeed Trigger and the Lowspeed Trigger
values.

• Operational transient
The machine speed has increased and has crossed the Overspeed Trigger value.

• Run-down
The machine speed has decreased and now lies between the Lowspeed Trigger and
Lowspeed Cutoff values.

The machine states are shown in Figure 1-11.

The Overspeed Trigger, Lowspeed Trigger and Lowspeed Cutoff values are separately set
at CMS Software configuration time for each machine being monitored: refer to
9.9.3 - Configuring Machines. 
All parameters refer to the same reference speed channel defined for each machine. In
applications without a speed measurement, or where the notion of speed is not applicable,
the system can be run in fixed frequency mode, which allows the same types of data
acquisition that are normally available while the machine is running “on load”. For this
purpose, a “Fixed speed” parameter can be selected when creating a rack configuration (see
Chapter 9 - Creating a Rack Configuration). 
Figure 1-12 below shows the correspondence between the operating modes introduced in
1.3 - Operating Modes and machine states. The column on the left of the table shows the
VM600 system operating modes and, under each of the headings, the measurement types
available (e.g. Spectrum, Waveform).

Figure 1-11 : Machine States for a Typical Operating Cycle

Speed

Time

Overspeed 
Trigger

Lowspeed
Trigger

Lowspeed
Cutoff

Stopped Run-Up Running "On Load"
Operational
Transient Run-Down
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Machine Operating State

Operating mode: Stopped Run-Up Running
“On Load”
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Smax
1

1. Smax is a special case obtained from Trend data

(9) (9) (9) (9) (9)

Transient
Transient Cascade - - - 9 - - - 9 9
Transient Trend Data - - - 9 - - - 9 9
Alternative
Waveform - - - - - - 92

2. In this situation, one of the following choices must be defined: (a) Waveform, (b) Spectrum only, (c)
Waveform and Spectrum, (d) Long Waveform (“oscilloscope mode”)

- - - - - -

Spectrum - - - - - - 92 - - - - - -

Long Waveform 9 - - - 92 - - - - - -

Orbit - - - - - - 9 - - - - - -

Manual
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Real-time Waveform 9 9 9 9 9
Real-time Spectrum 9 9 9 9 9
Real-time Long 
Waveform

9 - - - 9 - - - - - -

Real-time Orbit 9 9 9 9 9

Real-time Trend 9 9 9 9 9

Key: 9 Data type available - - - Data type not available

Figure 1-12 : Operating Modes for Various Machine States
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1.5 Data Acquisition Types
The CMS Software allows the following data types to be acquired:
• Trend (including time-domain, FFT-based outputs, or Smax)
• Transient Trend and Transient Cascade 
• Waveform and Spectrum
• Orbit
• Long Waveform

1.5.1 Trend Data Acquisition
This type of data acquisition is performed in background mode. Acquisition is based on a time
series of 1024 samples, which are processed to obtain 400-line spectra for band extraction
(frequency analysis). The sampling frequency is configurable and determines the bandwidth.
This is shown in Figure 1-13.

Note that only the predefined trend data (characteristic numbers) are stored in the database.
The raw (time-based) signal and the spectral components are not stored in the database.
Acquisition takes place at the following intervals:
• Normal—used when no alarm condition is present
• Alarm—data is acquired more rapidly when an alarm has been raised
A special case of trend data acquisition is the Smax acquisition, which is a frequently used
dual-channel processing data type used to compare vibration data from two sources. It is
based on the synchronously acquired time-series data of two associated channels, and is
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Trend Data
- - - - - - Stored in database - - - - - -

Figure 1-13 : Trend Data Acquisition
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performed in background mode. More specifically, in this mode, 512 samples are taken for
each of the two probes over four complete shaft revolutions (that is, 128 samples per
revolution). This is shown in Figure 1-14.

The Smax value is derived from the time series and stored in the database in the same way
as the other “trend” data points that make up long-term trend curves.
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Figure 1-14 : Smax Data Acquisition
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1.5.2 Transient Trend Data and Transient Cascade Acquisition
These two acquisition types (see below) are performed in Transient operating mode. They
are based on similar acquisition parameters to the trend data measured in background mode,
that is, data is taken in blocks of 1024 samples, allowing 400-line spectra to be generated. In
contrast to background mode, however, the spectral data are also retained for further
analysis. 
Up to 100 spectra can be acquired to produce a transient cascade plot, also known as a
“waterfall” plot. In this mode, both spectral data and transient trend data (characteristic
numbers) are stored in the database. The transient trend curves are different from the historic
trend curves in that the spacing of data points is based on delta-time or delta-RPM criteria,
and that for each data point the current speed value is stored as well. This is shown in
Figure 1-15.
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Figure 1-15 : Transient Trend and Transient Cascade Data Acquisition
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1.5.3 Alternative Mode Acquisition
Waveform and spectrum data can be produced when operating in Alternative operating
mode. 
The number of samples can be configured according to individual needs. Often, a large
number of samples (8192) is selected to provide high-resolution acquisition of data.
Data acquisition is initiated in the following ways:
• On schedule, that is, according to a pre-defined schedule (time interval)
• On alarm exceedance, that is, when a vibration point exceeds the High Alarm threshold

(see 1.2.5 - Limits and Alarm Priorities).
This is shown in Figure 1-16.
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Figure 1-16 : Waveform and Spectrum Data Acquisition
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1.5.4 Orbit Acquisition
This type of data acquisition is performed in Alternative operating mode. It can also be started
manually.
Synchronous time-domain data is obtained from an X- and Y-probe. Both sets of data are
stored in the database, allowing an orbit display to be generated subsequently. This is shown
in Figure 1-17.
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Figure 1-17 : Orbit Data Acquisition
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1.5.5 Long Waveform
A long waveform is obtained by taking 42 799 samples in the time domain.
This type of data acquisition (see Figure 1-18 below) is one of the options (along with
waveform and spectrum) that can be chosen in Alternative operating mode. 
A long waveform can also be acquired manually. 
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Figure 1-18 : Long Waveform Data Acquisition
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1.5.6 Long waveform when some channels are in transient mode
In a configuration with a mixed configuration showing some channels from the same logic
machine on Waveform + Spectra and others with long waveform as scheduled acquisition,
when the Machine switches into transient only the Waveform/spectra channels will switch to
acquire transient trend and cascade (Figure 1-19). 
The current setup is such that:
1- Users configure the long waveform to be scheduled in the Configuration Editor. This

choice excludes the configuration of other scheduled modes (WF, SP) for the
background acquisition. 

2- The VMCom effectively simulates a user request every scheduled-interval.
For the CMC card this looks like a user-requested long-waveform which is a low-priority task
and only gets processed whenever the card has enough resources to do so. 

Figure 1-19 : Transient Mode - Waveforms and Spectra
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1.6 Trending
The spacing of data points on the trend curve is determined by two primary parameters (see
Figure 1-20) : 
• The normal storage rate
• The alarm storage rate.
Once the output exceeds its high alarm threshold, the system switches automatically to alarm
storage rate. This is typically set to shorter values than the normal storage interval. The
minimum selectable interval is 1 second. Normal and Alarm storage intervals allow you to
tune the density of trend points “by time”. 

In addition, the two parameters Analog Resolution and Compression Ratio allow you to
capture data in a particular change of amplitude (Analog Resolution), that is, data points are
added to the trend curve when big changes occur in a short space of time. The Compression
Ratio allows you to further tune the width of this amplitude interval, and to reduce it when
approaching the alarm limit. 

Normal Storage Interval

Alarm Storage Interval

Analog Resolution & 
Compression Ratio

Figure 1-20 : Normal and Alarm Storage Intervals
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1.7 Event Logging
The CMS Software performs limit checks for each configured output, at every processing
cycle. Any exceedances, or amplitude changes across a user-defined limit, are logged into
the database, as shown in Figure 1-21. Additional hysteresis can be defined. 

High Alarm Event No Longer in Alarm

Normal Event

High Alert Event

Normal Event

Figure 1-21 : Event Logging
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The events available to the user are listed in Table 1-2: 

Table 1-2 : Event Types and Corresponding Events

Event Type Events

Speed-Related
Speed (Tacho) Pulse Lost

Speed (Tacho) Pulse Found

Hardware-Related

CMC 16 card offline

CMC 16 card online

Rack offline

Rack online

Level-Related

If Event Generation 
Selected by User:

If Event Generation Inhibited by 
User:

Normal FFT Window event (Inhibited) Band 
Normal

High Alarm FFT Window event (Inhibited) Band 
High Alarm

High Alert FFT Window event (Inhibited) Band 
High Alert

Low Alert FFT Window event (Inhibited) Band 
Low Alert

Low Alarm FFT Window event (Inhibited) Band 
Low Alarm

Validity Fault FFT Window event (Inhibited) Band 
Validity Fault

User User Note
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2 CMS SYSTEM ARCHITECTURE

2.1 Introduction
Figure 2-1 shows a general overview of the VM600 CMS Software system architecture. For
an introduction to VM600 networking concepts and an introduction to network addressing,
refer to the VM600 Networking Instruction Manual. 
The host PC is the computer on which the CMS Software is installed. The database may also
be installed on this PC. All configuration activities are done here (or they can also be done
from another PC via a LAN, an Intranet, or any other available network connection).
A hub allows users of a local intranet to configure the VM600 hardware, access the database
and perform all other activities possible on the host PC.
A modem may be installed to allow remote access through the phone line – which enables
the system for fully remote operation, including configuration, data analysis and machine
diagnostics, as well as maintenance of the data acquisition system. The presence of a
modem connection also facilitates remote technical support, by Vibro-Meter or other
authorized personnel. 

Modem

Intranet

VM 600 Hardware
Protection and Condition 
Monitoring Racks

Host PC
Running CMS Software

Data Storage & 
Management

VM 600 CMS Remote Support 
by Vibro-Meter

Interpretation & Diagnostics

Hub

Figure 2-1 : CMS Software System Architecture
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2.2 Configurations
Depending on the size and complexity of your installation, you can either install the CMS
Software on a single PC or on several interconnected PCs (referred to as a distributed
configuration).

2.2.1 Single-PC Configuration
In this configuration (see Figure 2-2 below) the VM600 hardware is connected to a single PC
over an Ethernet link. The link between the PC and the VM600 hardware can be established
either via a direct crossed-Ethernet cable, or using a Hub and suitable network cabling.
The host PC (or Data Acquisition Server) fulfils the following tasks:
• Stores and runs the database (Adaptive Server Anywhere)
• Communicates with the VM600 hardware
• Runs automatic data acquisition
• Allows access to individual CMS Software modules 
• Optionally, the database can be made accessible to the outside world. 

2.2.2 Distributed Configuration
In a distributed configuration (see Figure 2-3 below), tasks are distributed across several
PCs.
A dedicated PC (the Data Acquisition Host) can be used solely for acquiring data from the
VM600 rack.
Another dedicated PC can be used as the Database Server. Although the CMS Software is
delivered with a Windows-based database package, any other ODBC-compatible package
can be used and this PC could even run under a non-Windows operating system such as
Linux or UNIX.
Several operator PCs can be connected to the LAN, with one or more of the CMS Software
modules installed on each PC.
The obvious advantages of the distributed configuration are that system operation becomes
very flexible, and allows a more efficient division of tasks when several people work together

VM600 Hardware
Protection and Condition 
Monitoring Racks

Ethernet (or direct crossed-cable) link

Data Acquisition Server

Figure 2-2 : Single Host Configuration
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on it (site operators, maintenance engineers, machine diagnostics experts, and so on). Also,
the operation of the system is no longer dependent on the physical location. 

2.3 The CMS Software - Overview

2.3.1 Introduction
The CMS Software is delivered as part of a standard installation media kit consisting of the
following:

• One CD-ROM containing the Sybase SQL Anywhere Studio© (P/N 957.01.1000.0001)
database software

• One CD-ROM containing the VM600 CMS Software (P/N 209-500-600-SSS)

2.3.2 The Database Software
The CMS Software is designed around the core of an SQL-compliant database. The standard
version of the CMS Software is delivered with Sybase’s Adaptive Server Anywhere
database management software suite. However, the CMS Software can be made to run with
any other commercial off-the-shelf database management product that conforms to the ANSI
SQL 92 standard. 

VM600 Hardware

Protection and Condition 
Monitoring Racks Operator PC Operator PC

Operator PCDatabase Server

Runs database application
(Any operating system)

Data Acquisition
Host

Handles data acquisition
(runs under Windows)

Runs CMS Software: 
Configuration Editor module 
(runs under Windows)

Runs CMS Software 
Mimic module
(runs under Windows)

Runs CMS Software: 
Data Analyser module
(runs under Windows)

LAN

Figure 2-3 : Distributed Configuration
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Please ask your Vibro-Meter system vendor about compatibility with other database
management packages. The procedures described in this chapter describe the use of
Adaptive Server Anywhere only.

2.3.3 The VM600 CMS Software
The CMS Software is intended for use with Vibro-Meter’s VM600 series Condition Monitoring
System (CMS) hardware. The software packages allow:
• Configuration and operation of the CMS hardware
• Automatic acquisition and storage of machine data (allowing long-term logging and

trending)
• Limit exceedence check and event logging
• Real-time analysis of machine parameters 
• Advanced data analysis (online and offline)
• Data management
• Data export to and import from third-party systems
The packages run on various Microsoft Windows platforms. Refer to 2.4 Software and
Hardware Prerequisites below for details.

2.4 Software and Hardware Prerequisites

2.4.1 Supported Operating Systems
The CMS Software runs on the following operating systems:

• Microsoft® Windows NT® (Version 4 or later)

• Microsoft Windows® 2000
• Microsoft Windows XP
• Microsoft Server 2003
The software runs on both Workstation and Server versions of the operating systems. For
optimum system reliability, data security, and remote access capabilities, it is recommended
to use Server versions of the operating systems.

2.4.2 Hardware Requirements
The minimum hardware configuration recommended for the use of the CMS Software is
shown in Table 2-1. The actual requirements are strongly dependent on the type of use of the
system and the purpose (demonstrations or training, offline data analysis, acquisitions
server, database server, etc.). Typically, data acquisition servers and data servers have to
comply to increased requirements in terms of reliability, and availability. For these machines,
higher technical specifications are recommended. For other applications, such as
troubleshooting, commissioning, and training, less stringent requirements apply, and
practically any modern computer hardware can be used.
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Table 2-1 : Minimum and Recommended PC Configurations

Item, Parameter Minimum 
Configuration

Recommended 
Configuration

Computer type
Any (laptop, desktop, 
workstation, Industrial 
PC etc.)

Industrial Server with 
capabilities for redundant 
power supply, redundant 
hard disks (mirroring or 
RAID)

Processor type Intel® Pentium® Pentium III (or better)

Processor speed 233 MHz 1.2 GHz (or more)

Memory 128 MB RAM 512 MB RAM (or more)

Hard disk 1 GB 10 GB (or more)

CD-ROM CD-ROM drive CD-ROM drive

Ethernet Card
Any standard Ethernet 
hardware supported by 
the operating system

High-speed Ethernet 
hardware 

Display
Any colour display 
supported by the 
operating system

17" SVGA compatible or 
better (19" is preferable)

Backup (optional)  - 20/40GB DAT tape drive 
(or larger)

Mouse
Any pointer device 
supported by the 
operating system

3-button mouse 
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2.4.3 VM600 Hardware Requirements
The following Vibro-Meter hardware is required for use with the CMS Software system: one
or more VM600 racks with CMC 16 cards and their associated IOC 16T cards, as well as the
CPUM and IOCN cards set up for network communication over an Ethernet (TCP/IP)
network. The CMS Software is compatible with the following versions of cards: 

Table 2-2 : Minimum VM600 Hardware Requirements

VM600 Hardware 
component Description Version / Part Number

CMC 16 card Condition Monitoring Card

200-530-012-012 or 
200-530-012-013 or
200-530-021-013 or
200-530-022-014

IOC 16T card Input/Output Card for CMC 16
200-565-000-012 or
200-565-000-013

CPUM card Modular CPU Card (containing 
Disk-on-Chip)

200-595-034-111
(209-595-200-134) or
200-595-044-111 

IOCN card Input/Output Card for CPUM
200-566-000-012 or
200-566-000-112
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3 THE CMS SOFTWARE MODULES
This chapter introduces the CMS Software modules and describes general aspects of the
software’s operation. For more details on the individual program modules, refer to the
individual chapters of this manual or the online help of individual modules. 

3.1 Introduction
The CMS Software consists of a number of modules, each fulfilling a specific task. Most
modules are fully operational, stand-alone applications. In addition, many of the modules
provide useful menu shortcuts to allow you to switch quickly to a related module.
The CMS Software modules are logically divided into groups as follows: 

The CMS Software architecture allows various external systems to connect to the database.
Examples include:

Table 3-1 : CMS Software Groups

Group Modules

Configuration & Setup
Configuration Editor
VM600 Administrator
Diagnostics Rule Box

Communications & Data Storage
VMCom Communications Handler
Database Management System (DBMS) providing 
database servers and database

Display & Analysis

Mimic
Database Browser
Data Analyser
CMS Event Viewer

Data Import/Export

Modbus Client/Server
DDE Client/Server
ODBC Server
Keyboard Interface
OPC Client Server

Air Gap Monitoring Air Gap monitoring (integrated into Configuration 
Editor)

Table 3-2 : CMS Software External Groups

Group System

External Systems

Turbine Control System
Performance Monitoring
Lube Oil Analysis System
Special analysis tools
etc.
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The figure below provides an overview of the CMS Software architecture.

The configuration is written to the database using a standard ODBC connection, from where
it is transferred upon user request to the VM600 rack(s) by the VMCom communications
handler module.

VM600
Administrator

Mimic

Data 
Analyser

Database
Browser

Database Server

Turbine Control 
System etc.

Modbus

DDE

VM 600 Rack(s)

Data Import/Export:

Configuration
Editor

Event
Viewer

Display and Analysis 
Tools:

Configuration and Setup 
Tools:

Database

External Systems:

Communications and 
Data Storage Tools:

VMCom 
Communications 

Handler

Keyboard Interface

ODBC

Air Gap Monitoring

Air Gap

Diagnostics Rule 
Box

OPC

Figure 3-1 : VM600 Software Architecture
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3.2 The Modules

3.2.1 Database Management and Storage
All CMS Software modules connect to a central database. The database contains:
• Information relating to the VM600 system’s configuration
• Measurement data acquired from one or more VM600 racks. 
• Optionally, “offline” data acquired from external systems via DDE or Modbus protocols.
Some CMS Software modules store data in the database, while others extract measurement
data from the database and present it in a meaningful form to the users. 
A database management system is responsible for controlling access to the database and
other related tasks. Once correctly installed and configured, the database software runs in
the background and does not interact directly with the user. 
The CMS Software is delivered with a reliable and powerful third-party product, Sybase
Adaptive Server Anywhere, which provides the database functionality on behalf of the other
CMS Software modules. However, you can configure your system to use a different database
management software, such as Oracle, if you wish, provided that it is ODBC and SQL 92
compliant. 
See Chapter 7 - Administering Databases for details on the database utilities available.

3.2.2 The VMCom Communications Handler
The VMCom communications handler is responsible for setting up and controlling the flow of
data between the VM600 rack(s) and the database. 
The VMCom communications handler can either be set up as an automatically started
Windows service, or it can be launched manually. When first started, it downloads rack
configuration data to the VM600 rack(s) that will supply measurement data, prompting a reset
of the cards. Upon restarting, the cards are able to establish communications with the
database via the network and begin sending data directly to the database.
This module is described in detail in Chapter 8 - Setting Up the VMCom Communications
Handler.

3.2.3 The VM600 Administrator
This application is a “portal”, providing easy access to the other CMS Software modules, tools
for database management and commonly used operating system components. 
The VM600 Administrator is described in Chapter 6 - Using the VM600 Administrator.

3.2.4 The Configuration Editor
The Configuration Editor is used to define and update the system configuration. The system
configuration can include the configuration details of an individual processed output value, a
complete rack, machine-specific parameters for data logging or transients, or the entire
system hierarchy. 
The Configuration Editor is a stand-alone program, but can also be launched from within
other CMS Software modules, for example, the Mimic application. 
Using the Configuration Editor, the system configuration can be viewed or—provided the
correct password level is entered—changed and saved into the database. The Configuration
Editor commits configuration changes to the database and uses the VMCom communications
handler to send them to the VM600 hardware rack(s). 
This module is described in detail in Chapter 9 - Creating a Rack Configuration.
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3.2.5 Mimic
Mimic is a graphical tool that uses an easily customisable palette of predefined objects to
provide a hierarchical view of the monitored machinery, display real-time data from the
rack(s), and many other functions. Several of the other CMS Software modules can also be
launched directly from within Mimic when specialist tasks are required. Once the CMS
Software has been fully configured and has gone “live”, Mimic is therefore the only module
usually needed by operators. 
Also from the operator screen, a number of “real-time” data acquisition features are available
which allow the operator to manually request data from the hardware. These user requests
are handled by the VM600 hardware in addition to the automatic and pre-programmed data
acquisition. The operator can choose whether or not to write the data obtained in this way to
the database. This live data can sometimes facilitate the analysis of the current machine
condition. The real-time features are mostly useful for testing and commissioning purposes,
verifying the integrity of the CMS system, as well as for troubleshooting purposes. 
Real-time plots can be requested from various locations in the Mimic application, notably the
value or status indicators, or the tree items of the logical view. The Data Analyser module is
called directly to display the measurement data (see 3.2.7 - The Data Analyser).
Mimic is described in detail in Chapter 10 - Using the Mimic Module.

3.2.6 The Database Browser
The Database Browser is a tool for viewing the contents of the database. It visualises the
contents of stored datasets in an intuitive time-line representation, and allows you to quickly
navigate to the dataset of interest. A selection of several independent criteria (point, type of
data set, time) helps you to easily isolate the dataset of interest. From this application, a direct
link to the Data Analysis module is provided, as well as to the event log via the CMS Event
Viewer module. 
The Database Browser is described in Chapter 11 - Using the Database Browser.

3.2.7 The Data Analyser
The Data Analyser module is a graphical presentation tool used to display measurement data
from the database. 
The tool takes selected data from the data measurement points defined in the database,
applies user- or system-defined filters to the data, and displays the data in a variety of forms.
Typical filters that can be applied to the data are time, alarm status, machine status, or a
freely configurable filter that can be constructed based on any speed, analog, or digital data.
The Data Analyser module provides a detailed view of the contents of the measurement
database. It provides complete access to all existing datasets, and helps to quickly scan
through large quantities of data. The modules offer various independent criteria for effective
filtering and sorting.
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The following real-time graphs are available: 

NOTE : The VM600 CMS system being an automatic online data acquisition system, Mimic
and the other modules with graphical user interfaces are not necessary in order to
populate a database with measurement data. This aspect is handled automatically
in the background by the database and the VMCom communications handler.

NOTE : The Data Analyser module includes the same real-time data acquisition features
as Mimic. See 3.2.5 - Mimic for details.

The Data Analyser is described in detail in Chapter 12 - Using the Data Analyser to Create
Graphs.

3.2.8 The CMS Event Viewer
The CMS Event Viewer can be launched from within various other CMS Software
modules—including Mimic, the Data Analyser and Database Browser modules—or as a
separate program.
The CMS Event Viewer is used to view events in the database that have either been created
automatically by the system, or manually by users. It shows, in list form, the events that apply
to certain filtering criteria that can be set by the user. Invoking the tool from other modules is
context-sensitive, that is, the contents of the CMS Event Viewer windows always relate
directly to the module from which it was launched. For example, invoking it from the
“Unacknowledged Events” Indicator in the Mimic module shows only unacknowledged
events, whereas invoking it from a machine selected in the Mimic logical view shows only
events related to the selected machine. 
This tool is primarily used by the operator in conjunction with the Mimic screens, providing
immediate notification of any new occurrences in the system. New events are initially flagged
as “unacknowledged” until the operator manually acknowledges having read their contents.
However, the CMS Event Viewer is also useful for performing detailed data analysis, and
comparing the event log with measurement data. More specifically, the alarm event log is a

Table 3-3 : Real-Time Graph Types

Measurement Point Type

Speed Dynamic Analog Digital 

R
ea

l-t
im

e 
G

ra
ph

Bar graph 1 9 9 9 9

Trend 9 9 9 9

Waveform  - 9  -  - 

Spectrum  - 9  -  - 

Long Waveform 2 9 9 9 9

Orbit 3 - 9 - - 

1. For dynamic points, showing individual outputs, rather than the complete point.
2. Also referred to as “Oscilloscope Waveform”.
3. Available only for relative vibration points for which Orbits are defined.
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good starting point for searching for more detailed data that were triggered by limit
exceedence of specific outputs. 
For all limit-related events, a direct link to the relevant part of the historic trend curve is
available with a single click of the mouse. 
The CMS Event Viewer is described in Chapter 13 - Using the CMS Event Viewer.

3.3 Offline Systems
The term “offline” refers to any activity that occurs outside the basic VM600 CMS Software
system, for example, extracting data originating from non-VM600 systems, or gathering
measurement data from VM600 racks and further processing it in other non-VM600 systems
(by contrast, “online” activity refers to internal VM600 rack, CMS Software and
database-related activity).
Offline-generated data values become “current values” for the system, and can be displayed
from within Mimic, or any real-time plot type. From these “current values”, the VMCom
communications process automatically generates historic trends and limit exceedence
events, based on the current configuration. The existence of a common CMS Software
database enables you to correlate online data with offline values using standard plotting tools. 
The VM600 CMS Software currently supports the following offline systems:

Any of these offline data collection modules can be set up to run fully automatically as
Window system services running under a local system account.

3.3.0.1 The DDE Interface

Dynamic Data Exchange (DDE) is a communications protocol supported by Windows
operating systems which enables applications to communicate with each other. DDE
automates the process of manually copying and pasting data from one application to another
via the clipboard. 
The DDE Client/Server utility allows you to exchange data between VM600 CMS Software
databases and external Windows applications, such as Microsoft Excel.
The tool also supports the exporting of data from the database.
This tool is described in VM600 Condition Monitoring System (CMS) User Manual, Volume 2.

3.3.0.2 The ODBC Interface

ODBC (Open DataBase Connectivity) is a communications protocol built in to many
Windows operating systems. ODBC provides a standard method of connecting client

Table 3-4 : Offline Point Types and Related Modules

Offline Point Type Related Module

DDE points DDE Interface

ODBC points ODBC Interface

OPC points OPC Interface

Keyboard-entered points Keyboard Interface

Modbus points Modbus Interface

Calculated points Diagnostics Rule Box
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applications to database servers. ODBC makes it possible to access any data in any
database, regardless of which database management system (DBMS) is handling the data. 
In the same way as other types of “offline” data in CMS software, ODBC uses a client/server
architecture, in which the application requesting the data is called a “client” and the
application providing the data is called a “server”. The CMS Software can act as both client
and server, that is, it can:
• Import data from any ODBC-compatible application into a CMS Software database.
• Allow any ODBC-compatible application to request data from a CMS Software database.
The ODBC tool is described in VM600 Condition Monitoring System (CMS) User Manual,
Volume 2.

3.3.0.3 The OPC Interface 

OLE for Process Control (OPC) is an open connectivity mechanism enabling the exchange
of data between OPC-compatible data sources. These data sources can include “intelligent”
devices on the factory floor, databases in a control room, and software applications such as
third-party applications.
OPC has a client/server architecture. CMS Software can function as both OPC server and
OPC client. The CMS Software includes an OPC configuration utility to allow you to define
and configure instances of OPC servers and OPC clients.
The ODBC tool is described in VM600 Condition Monitoring System (CMS) User Manual,
Volume 2.

3.3.0.4 The Keyboard Interface

This tool allows you to manually set the values of slowly-varying offline data points by
entering their values with the keyboard.
From a configuration point of view, keyboard-entered points are a form of offline system, and
as such can also be created from within the Configuration Editor. Keyboard-entered points
are treated similarly to other offline points, such as calculated points, DDE points, Modbus
points, and so on. 
While this tool is primarily intended for the keyboard entry of selected, slowly varying
parameters, it can also be used to temporarily replace data imported from other (automatic)
external interfaces in situations where these are currently unavailable. For this purpose, it is
possible from within the Configuration Editor to “move” configured points from another offline
point group to the keyboard-entered area of the database. 
This tool is described in VM600 Condition Monitoring System (CMS) User Manual, Volume 2.

3.3.0.5 The Modbus Interface

Modbus is a widely used database communications protocol originally developed by Modicon
(now a part of Schneider Automation). The Modbus Client/Server tool can be used to collect
data for offline points from external sources via the Modbus protocol and store the data in the
VM600 database.
The tool also supports the exporting of data from the database.
This tool is described in VM600 Condition Monitoring System (CMS) User Manual, Volume 2.

3.3.0.6 The Diagnostics Rule Box

This tool is a powerful, fully automated, decision support system for operators and machinery
experts. Any information in a CMS Software database, including measurement data and
imported “offline” data, can be used to generate complex diagnostics rules. You can also
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develop templates for standard diagnostics procedures and activate them for any item of
machinery. 
Calculated points output by the Diagnostics Rule Box tool can be directly stored as “offline”
data in the CMS Software database.
This tool is based on the concept of fully customizable scripts and rules:
Scripts are assemblies of rules that are ready to be executed according to user-defined
parameters. Scripts can contain sequences, loops and branches, and allow you to customize
their execution according to the particular needs of the diagnostics rules.   
Rules are composed of three elements: 
• Input Level: Any number of customizable input criteria, such as exceedance checks,

points' status, counters, and so on, which are associated with either individual
measurement points or groups of measurement points. 

• Logical Level: A freely-configurable assembly of logical combinations of the results from
Input Level elements.

• Actions Level: Any number of user-defined actions that are executed based upon
results from the Logical Level. 

These three elements are interconnected using a user-friendly and intuitive graphical editor.
Simulation tools are provided to allow easy visual verification and testing of the rules, using
simple colour-coding techniques.
Diagnostics rules are easy to adapt and enhance without affecting normal system operation.
The Diagnostics Server subsequently runs independently and performs the tasks defined in
the Diagnostics Rule Box, working in parallel with the normal data acquisition tasks of the
system. 
This tool is described in VM600 Condition Monitoring System (CMS) User Manual, Volume 2.

3.4 Air Gap Monitoring System
The Air Gap module CMS Software is key component in Vibro-Meter’s air gap diagnostics
solution, designed to provide continual monitoring the distance between the rotor and stator
of turbines. Large hydroelectric turbines are subjected to constantly varying centrifugal,
thermal, and magnetic forces that are capable of distorting the stator and rotor of the turbine,
thereby causing this air gap to vary. Monitoring the air gap is an essential part of condition
monitoring as it can provide early warning of impending problems and facilitates timely
maintenance procedures.
The Air Gap Monitoring system allows the following types of measurement:
• Rotor profile measurement in one or more planes
• Stator profile measurement (roundness, eccentricity) in one or more layers (“planes”)
• The ability to generate alarms for each sensor
• Minimum, maximum, and average air gap over one complete rotation
• Identification of the pole numbers producing the minimum and maximum air gap
• Magnetic flux measurement,
The air gap monitoring solution is described in VM600 Condition Monitoring System (CMS)
User Manual, Volume 2.
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3.5 External Systems
The architecture allows various external systems to be connected to the database. Examples
include:
• Turbine Control System
• Distributed Control System (DCS) 
• Lube Oil Analysis System
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4 INSTALLING CMS SOFTWARE 

4.1 Installing CMS Software
To install the CMS Software:
1- First, install the database software, as described in 4.1.1 Installing Adaptive Server

Anywhere Database Software below.
2- Then, install the CMS Software itself, as described in 4.1.2 Installing the CMS Software

Programs. 

NOTE : It is not mandatory to install the database software before the CMS Software.
However, the CMS Software’s setup program attempts to install a sample
database on your system and can only do so if the database software has already
been installed. If you reverse the order of installation, you must manually configure
the sample database before using it.

4.1.1 Installing Adaptive Server Anywhere Database Software
To install the database software on the Database Server PC:
1- Insert the CD-ROM labelled Sybase SQL Anywhere Studio in the CD-ROM drive.

If the setup procedure does not start automatically, use Windows Explorer to navigate to
the CD-ROM drive and double-click the setup.exe file.

2- The setup procedure starts automatically. Follow the installation instructions.
3- You are prompted to select the components of Adaptive Server Anywhere to install.

Refer to Table 4-1.

Table 4-1 : Adaptive Server Anywhere Installable Components

Component Choice Comments

Adaptive Server 
Anywhere MANDATORY The main database component.

Synchronization tools OPTIONAL
Select this option only if you need to 
synchronize the contents of databases with 
other databases or remote users.

Sybase Central MANDATORY Database management utility.

jConnect NOT NEEDED Select this option only if you intend using 
Java-based tools to access your databases.

Online Books RECOMMENDED Online reference manuals.

InstallShield Objects 
and Templates NOT NEEDED Select this option only if you intend 

developing your own database applications.
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4- If you have purchased a Server license, the following window appears:

Specify the number of Licensed Seats you have purchased—according to the number
of remote access stations that will be used to access the server—and click Next to
continue the installation.

5- Remove the CD-ROM from the drive and reboot your computer when prompted. 

4.1.2 Installing the CMS Software Programs
To install the CMS Software programs:
1- Insert the CD-ROM containing the CMS Software in the CD-ROM drive.
2- Use Windows Explorer to navigate to the CD-ROM drive and double-click the setup.exe

file.
3- If you are upgrading or reinstalling the CMS Software, the setup program detects that a

version of the CMS Software has already been installed on this computer. You must
uninstall an existing version of the CMS Software whenever you upgrade to a more
recent version, change installation options, or activate optional program modules that
you have purchased. 

To automatically remove the CMS Software system, proceed as follows:
a. Click Remove.

b. Click OK on the first install window to confirm removal.

c. The setup program proceeds to automatically uninstall the existing version. When
finished, click Finish.

d. Double-click the setup.exe file to restart the setup program.

4- Click Yes to accept the terms of the license agreement.

Figure 4-1 : The Server License Window

Although the data integrity of your system is fully preserved throughout
the upgrade or reinstallation process, you are strongly recommended to
make a backup of your database before upgrading or reinstalling.
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5- When prompted, enter a User Name, Company Name, and the License Key provided
to you by Vibro-Meter. This license key automatically selects the installation language
and any optional components you ordered with the product.
If you have not received a license key from Vibro-Meter, you can still install the CMS
Software in “demonstration” mode by entering “DEMO” in the License Key field. In this
case, the product is installed in a special demonstration mode: all product components
are installed, but the Mimic module and any programs launched from within Mimic will
shut down after 20 minutes of activity.

NOTE : If you install the CMS Software using the DEMO license key and subsequently
receive a full license key from Vibro-Meter, you will be prompted to uninstall the
DEMO version, as described in Step 2 above. Then proceed to install the CMS
Software, entering the valid license key when prompted.

6- When prompted to select the destination folder for the installation, enter the desired
location, or accept the proposed default. Special requirements (such as the use of a
separate disk partition for the CMS Software installation) may be considered here. 

7- Select the type of installation: Typical, Compact, or Custom. Typical is the default and
is recommended—it contains all relevant components as well as some useful optional
components, example files etc. 

The result of the installation is a new directory with the following structure:

Table 4-2 : Default Installation Directories

Directory Subdirectory Contents

VM600_CMS  Root installation directory of all CMS components

Admin Files and executables relating to the Administrative tools. 

Bin Collection of executables, libraries, and necessary files 

DB

Use this directory to store databases. For increased data 
safety, customer databases may be located on a 
separate disk, disk partition, or a dedicated server on the 
network. 
SQL script files for database creation are also stored 
here. 

Examples Sample databases, Mimic documents, and other objects

Firmware CMC 16 card firmware updates

Help The CMS Software and CMS Hardware manuals, in 
Acrobat PDF format.

Image Bitmaps used by various applications

Projects

Contains project-specific information. A separate 
sub-folder is created for each CMS Software database 
you create, containing all configuration files and Mimic 
documents relating to the database.
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If you used the proposed default settings, the following items are added to Start > Programs
> VM600 CMS Software and as shortcut icons on your desktop: 

Refer to Chapter 3 - The CMS Software Modules for details on the CMS Software programs.

4.2 Upgrading the Adaptive Server Anywhere Database Software
Upgrading to a more recent version of the CMS Software does not normally require
reinstallation of the Adaptive Server Anywhere database software referred to in
4.1.1 - Installing Adaptive Server Anywhere Database Software. This situation is illustrated in
Figure 4-2:

VM600 Administrator

VM600 Mimic

VM600 Configuration Editor 

VM600 Data Analyzer

VM600 DB Browser

CMS 
Software 

V1.4

Database Software

CMS 
Software 

V1.5

CMS 
Software 

V2.1

CMS 
Software 

Vx.x

Upgrade Sybase when 
upgrading CMS

Upgrade

Reinstall CMS Software 
and Sybase when 

required or advised 
(this will be stated in the 

release notes)

Figure 4-2 : Upgrading and Reinstalling the Adaptive Server Anywhere Database Software
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4.3 Uninstalling the CMS Software Manually

NOTE : When upgrading to a more recent version of the CMS Software or reinstalling the
software, you are automatically prompted to uninstall the CMS Software by the
setup program. It is not necessary to uninstall the Database Software before
upgrading or reinstalling the software.

To uninstall the CMS Software manually:
1- Close any documents open in any of the CMS Software applications and close any

running CMS Software programs, which may create conflicts or inconsistencies during
the upgrade. 

2- Stop any running processes related to the CMS Software. In particular, you must stop
the VMCom communications handler if it is running in the background. To do this:

a. Choose Start Menu > Settings > Control Panel > Administrative
Tools > Services

b. If the VM600 VMCom process is present in the list, highlight it as shown below:

c. Right-click and choose Stop. The Status column displays Stopped.

To verify that the service is no longer running:
a. Press Ctrl-Alt-Del and click Task List.
b. Select the Processes property sheet.

Figure 4-3 : The Windows Services Window
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3- If the VMCom.exe process still appears in the list, as shown below, the service could not
be shut down automatically. If this is this case, select the VMCom.exe process and click
End Process.

4- Choose Start Menu > Settings > Control Panel > Add/Remove Programs.
5- Select VM600 CMS Software from the list of currently installed programs:

Before stopping, the VMCom.exe process must itself stop a number of
other background processes, which takes approximately 10 to 20 seconds
to complete. You must wait until the VMCom.exe entry disappears from the
task list before proceeding, otherwise a second VMCom.exe process may
be launched. This can lead to VM600 hardware problems as only one
process can be associated with an ODBC system DSN at any one time.

Figure 4-4 : The Windows Task Manager

Figure 4-5 : Uninstalling CMS Software
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6- Click Change/Remove.
7- When the uninstall wizard starts, choose Remove.
8- Click Next and follow the on-screen instructions.
This uninstalls all programs and libraries required by the CMS Software, but leaves all
existing databases and related project information in place.

4.4 Uninstalling the Adaptive Server Anywhere Database Software
To uninstall the Adaptive Server Anywhere database software:
1- Choose Start Menu > Settings > Control Panel > Add/Remove Programs
2- Select SQL Anywhere Studio from the list of currently installed programs:

3- Click Change/Remove.
4- When the uninstall wizard starts, choose Remove.
5- Click Next and follow the on-screen instructions.
This uninstalls the Adaptive Server Anywhere components, but leaves all existing databases
and the CMS Software in place.

4.5 Avoiding Up- and Downgrading the Software
To facilitate both your and Vibro-Meter’s work, it is recommended not to upgrade or
downgrade the CMS Software and CMC 16 firmware frequently. Some modifications to the
database made when upgrading cannot be undone, so downgrading software versions can
cause problems.
It always helps to analyse the problem first, then upgrade to a new software version only
when necessary. Proceed as follows:
1- Describe the problem to Vibro-Meter’s Customer Support department.
2- You will receive a response describing how to fix the problem and possibly

recommending a change of CMS Software version, firmware, or both).
3- Learn about the other features included in the recommended software version.
4- Make a decision whether to upgrade or not.
5- Perform the upgrade.

Figure 4-6 : Uninstalling SQL Anywhere Studio
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5 CMC 16 CARD FIRMWARE MANAGEMENT
The CMS Software requires that all connected CMC 16 cards run the same firmware version.
In addition, individual releases of the VM600 CMS Software require specific versions of
firmware. The following table lists the CMS Software versions, part numbers of available
CMC 16 cards, and the corresponding firmware versions supported:

Table 5-1 : Supported Firmware Versions for CMS Software

VM600 CMS Software CMC 16 Card 
Part Number

Firmware Version 
NumberVersion Part Number

1.3.x 209-500-600-013

200-530-012-012 5.04

200-530-012-013 5.04

200-530-013-012 5.05

200-530-013-013 5.05

1.4.x 209-500-600-014

200-530-012-012 5.04

200-530-012-013 5.04

200-530-013-012 5.05

200-530-013-013 5.05

1.5.0 209-500-600-015
200-530-020-012 6.00

200-530-020-013 6.00

1.5.1 209-500-600-015
200-530-021-012 6.01

200-530-021-013 6.01

1.5.2 209-500-600-015
200-530-021-013 6.01

200-530-022-014 6.02

1.5.3 209-500-600-015
200-530-021-013 6.01

200-530-022-014 6.02

1.5.4 209-500-600-015
200-530-021-013 6.01

200-530-022-014 6.02

2.0 209-500-600-020
200-530-023-013 6.03

200-530-023-014 6.03

2.1 209-500-600-020
200-530-025-013 6.05

200-530-025-014 6.05

2.2 209-500-600-022

200-530-025-012 6.05

200-530-025-013 6.05

200-530-025-014 6.05
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Each new release of the CMS Software systematically upgrades the firmware versions of all
cards to the latest supported firmware version. The CMS Software also provides a utility to
allow you to update the firmware version installed in a CMC 16 card from anywhere on the
network. 

5.1 Firmware Versions
When upgrading firmware versions, you must respect the following rules:
• Same version of firmware on all cards

The system does not support a mixture of several versions of CMC 16 cards (firmware)
in the same rack or system. If you add or exchange a new card, you must ensure that all
cards have the same firmware version loaded. If necessary, upgrade to the firmware
version matching your CMS Software version. Also, check whether you need to upgrade
to a higher firmware version for the new CMC card 200-530-025-014, which requires
firmware version 6.05.

• Firmware version must match the CMC 16 card
For the new CMC 16 card P/N 200-530-025-014, you must upgrade to firmware Version
6.05 or higher. Remember that you must upgrade all other CMC 16 cards in all
racks/systems connected to the host PC to the same firmware version. 

• Firmware version must match the CMS Software version
If you upgrade your CMS Software version, check Table 5-1 carefully to ensure that it still
works with your current firmware version.
A Constraining factor with real time measurements is a general change in the protocol
made between CMS versions 1.4 and 1.5. If running CMS 1.4 then Firmware 5.05 must
be used. With CMS 1.5 rev x and all the builds of CMS 2.0, 2.1 and 2.2 Firmware 6.0x is
required. It is recommended that at least version 6.02 is used (6.01 does not run on cards
-014), and ideally version 6.05.

5.1.1 The Download CMC Firmware Utility
To download a firmware update:
1- Make sure the computer where the CMS Software is installed is connected to the VM600

rack containing the CMC 16 card to be upgraded.
For this special task, it may be worth considering connecting the computer directly to the
VM600 rack using a crossed Ethernet cable to avoid any risk of upgrading other CMC 16
racks by mistake.

2- Start the VM600 Administrator program
3- Expand the System Tools icon in the structure view on the left, 
4- Double-click CMC Firmware Update. The following window is displayed:

Managing firmware upgrades is a specialist task that can, if used
unintentionally or incorrectly, lead to malfunctioning of the CMC 16 card
and affect proper function of data acquisition. It is therefore strongly
recommended to use the utility for the purposes described in the following
description only.
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5- Click Browse Network (only when searching for a populated IP Address)
6- Enter IP Address and click Browse Rack. A list of CMC 16 cards “visible” across the

network from this computer is displayed: 

7- Click the browse button and navigate to the folder containing the firmware upgrade,
by default C:\Program Files\VM600_CMS\Firmware:

Figure 5-1 : The CMC Firmware Update Window

Figure 5-2 : Current Firmware Versions in Detected CMC 16 Cards

Figure 5-3 : Available CMC Firmware Upgrades
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8- Consult Table 5-1 and select the firmware version that corresponds with the correct
CMC 16 card number and CMS Software version. Select the latest firmware file for use
with the current version of CMS Software, for example fwcmc604.400 and click Open.
Other firmware upgrade files are contained in the same folder. 

9- Select the CMC 16 card to be upgraded.
10- Click Download. The firmware is downloaded to the selected card.
11- One the download is complete, this can be repeated on the additional CMC 16 cards.

NOTE : Using this tool, it is possible to download any available firmware version to any
version of CMC 16 card. It is therefore possible to downgrade a card to a previous
firmware version as well as upgrading a card. This feature may be useful for
exchanging spare cards between several racks that are being used by different
versions of the CMS Software.
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6 USING THE VM600 ADMINISTRATOR

6.1 Introduction
The VM600 Administrator module is a “portal” providing quick and convenient access to all
other CMS Software modules, as well as to a number of useful Windows system tools and
database utilities.

NOTE : Certain programs can also be started from the CMS Software’s Windows menu:

Start > Programs > VM600 CMS Software > modulename

To start the VM600 Administrator:
Start > Programs > VM600 CMS Software > Administrator

or double-click the shortcut on the desktop. The VM600 Administrator window shown
in Figure 6-1 appears:

The left-hand side of the window contains a list of the programs that can be launched directly
from within the VM600 Administrator. They are divided into the following groups:
• VM600 Applications
• Data Import/Export tools
• Database Utilities
• System Tools

Figure 6-1 : The VM600 Administrator Tool
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6.2 Applications
This section links directly to the following VM600 applications:
• Mimic
• CMS Event Viewer
• Data Analyser
• Database Browser
• Configuration Editor
• VM600 Communication Thread
• Diagnostics Rule Box*
Refer to the individual chapters of Part III - Using the System for more details on the
programs.
* Optional component described in VM600 Condition Monitoring System (CMS) User Manual,
Volume 2.

6.3 Data Import/Export Tools
This section contains links to optional tools that are only present if purchased with your
VM600 CMS Software system/
• DDE Interface 
• Modbus Interface 
• ODBC Interface
• OPC Interface
• Keyboard Interface
These utilities are described in VM600 Condition Monitoring System (CMS) User Manual,
Volume 2.

6.4 Database Utilities
This section contains links to directly launch the following database tools:
• Create
• Snapshot Copy
• Advanced Copy
• Backup
• Initialize Configuration Tables
• Update Internal Database Structure
• Update Measurement Tables
• Delete Baseline Data from database
• Delete Measurement Data from Database
• Database Maintenance Tool
These tools are described in Chapter 7 - Administering Databases.
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6.5 System Tools
This section contains links to Windows system tools and a tool to update the firmware in the
CMC 16 card:
• ODBC Administrator
• Windows Services
• Application Service Setup
• CMC Firmware Update. 
The ODBC Administrator and Windows Services tools are described in the Windows online
help. The Application Service Setup tool is described in Chapter 8 - Setting Up the VMCom
Communications Handler, while the CMC Firmware Update tool is described in Chapter
5 - CMC 16 Card Firmware Management.

6.6 Administrator Options 
Figure 6-2 shows the options available on the administrator.

Figure 6-2 : Administrator Options

6.6.1 Changing the Language
The language can be changed between English (default) and French. To change to the
French version of CMS (if purchased and installed) 
1- Open the Language… dialog
2- Select the required language from the choicebox
3- Close the VM600 Administrator
All CMS Applications opened will then run in the language chosen.

6.6.2 Changing the ODBC Selection
In all CMS Applications, users are requested to connect to their database. De-selecting the
option “show ODBC selection dialog...” causes the software to open the datasource which
was last used. This is useful for users who always connect to the same database.

6.6.2.1 The ODBC Selection Dialog

Figure 6-3 shows the default ODBC selection dialog.
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Figure 6-3 : The Select ODBC Data Source Window

To change the database being used:
1- Choose the ODBC system DSN of the required database. The five most recently used

system DSNs are listed. To use a different system DSN, click Other and select a DSN
from the Machine Data Source.

2- Type in a valid ODBC User ID (e.g. "DBA") and Password (e.g. "SQL") for the database
and click OK.

3- Optionally, select the Remember the password option. When this is selected, the
password is stored in the Windows Registry and displayed automatically when logging
into the database. Furthermore, the User ID and Password are passed to any
applications launched from within the application (e.g. opening the Event Viewer from
Mimic). When not selected the User ID and password are required to access applications
each time.

If the application is unable to establish a connection to the selected database (e.g. because
the database server is not running, or because the database could not be opened), the utility
exits. Use the Database Maintenance tool (see 7.6.2- Using the Database Maintenance Tool)
to determine the reason for the failure, then correct the fault and restart the application.

6.6.2.2 Access without ODBC Selection Dialog

If the show ODBC selection dialog... is not selected, the application directly opens using the
last used DSN, with the last used User ID (e.g. "DBA") and Password (e.g. "SQL").

Passwords and system DSNs appear in "clear" in the Windows Registry, i.e.
they are not encrypted. Take appropriate security precautions to protect
your Windows system.
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6.7 Running a Version Check
Some CMS Software modules are optional and must be purchased from Vibro-Meter
separately. 
To check which components of CMS Software are installed, choose Version Check from the
Help menu:

Optional modules for which you have no license (for example, because you installed the
demonstration version of CMS Software) are shown with a warning symbol . More serious
problems, for example missing files, are indicated by an error symbol .
Only installed programs for which licenses have been purchased are listed in the VM600
Administrator tool window. If items do not appear in the list, check the installation options and
verify your license key.
Click Save Report to export details to a text file, which you can send to Vibro-Meter customer
support in case of problems.

Figure 6-4 : The Version Check Window
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7 ADMINISTERING DATABASES
This chapter describes how to set up and manage the relational databases in which CMS
Software stores measurement and configuration data. 

7.1 Terminology
The following terms are used in this manual to describe basic database concepts.

7.1.1 Database
A database is a system for storing and retrieving data in which data is organized in tables.
Each table contains data stored in rows and columns. A relational database consists of a
collection of tables that store interrelated data.

7.1.2 Database Management System (DBMS)
A database management system (DBMS) is a collection of programs that allow you to create,
use and manage databases.
The DBMS delivered with the VM600 CMS Software is Sybase’s Adaptive Server Anywhere.
You can use any other SQL 92 compatible DBMS with the VM600 CMS Software—see
7.7.4 - Creating a Backup Before Changing Configurations. See 7.1.6 - SQL for an
introduction to SQL.

7.1.3 Database Server
A database server is a software program set up by and run under the control of the DBMS
The database server regulates all access to the information stored in a database. Thereafter,
applications do not access the database directly, but communicate only with the database
server. A network database server regulates access for both local and network-wide
applications.
In the VM600 system, Adaptive Server Anywhere sets up database servers as Windows
system services, which allows them to continue running when no users are logged on to a
PC and to start and stop the database servers automatically.

NOTE : The Sybase documentation also uses the term “database engine”.

7.1.4 Transaction Log Files
A transaction log file is a cumulative record of all the changes made to a database since it
was first created, or since the log file was last deleted. 
Using a transaction log makes it possible to: 
• Schedule regular backups. Backups based on transaction logs are faster and easier than

full database backups that do not use transaction logging. 
• Recover from a media failure. If you have a media failure, you can restore the most

recent full backup, then use the transaction log to add the data that was not written to
disk. 

• Recover from a system crash. When the server restarts, it runs through the end of the
transaction logs and recovers any writes that were not made to disk at the time of the
crash. Logged databases do not require a consistency check. 
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The disadvantage of using a transaction log file is that it can grow quickly, often much faster
than the physical database file itself:

You can use a utility, VMDelete, provided with the CMS Software, to regularly delete the
contents of the transaction log file, for example, each day, and so ensure that it doesn’t grow
too large, for example:

In this case, you may need to do daily backups to capture database changes before they are
overwritten.
If you choose not to use a transaction log file, be aware that the physical database file will be
larger than it would otherwise be:
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Figure 7-1 : A Transaction Log File Can Grow Quickly
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Figure 7-2 : Using VMDelete To Limit Transaction Log File Size
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Figure 7-3 : The Effect of Logging on Database File Size
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Refer to 7.6.9 - Changing Transaction Log File Settings for details on modifying the default
transaction log file settings.

7.1.5 Client/Server Architecture
A client application is a program that is a requester of services. A server is a program that is
the provider of services to client applications. Although the server and client applications are
often installed on two physically remote PCs within the same network, both can be installed
and run on the same PC in simple configurations.
The VM600 CMS Software system has a client/server architecture; the database server runs
on a server PC, while the CMS Software modules, whether running on the same PC or on
remote PCs in the network, are client applications.

7.1.6 SQL
When a client application needs to carry out a database-related task, such as retrieving
information or inserting new data into a table, it describes the task using Structured Query
Language (SQL) statements. SQL is a programming language specially developed for
databases and which has been standardized by the ANSI and ISO standards bodies. The
most recent version, to which the CMS Software complies, is SQL 92. 
In the CMS Software environment, most SQL requests are hidden from the user: they are
sent directly from the CMS Software modules to the database server. For example, the
VMCom communications handler continuously and transparently stores acquired
measurement data in the database using SQL statements. Similarly, various CMS Software
modules extract data from the database and display it on the screen, for example, in the form
of a bar chart.
Most DBMS systems provide a simple graphical tool for building, generating, and running
SQL statements. Adaptive Server Anywhere provides the Interactive SQL tool. Refer to
Sybase Central’s online help for further details (Start > Programs > Sybase SQL
Anywhere 8 > Online Books). 

7.1.7 ODBC
ODBC (Open DataBase Connectivity) is a communications protocol built in to the
Windows NT, Windows 2000 and Windows XP operating systems.
ODBC provides a standard method of connecting client applications to database servers. The
advantage of using ODBC is that it can be used by any application that includes support for
ODBC, and to communicate with any database server that supports ODBC. Furthermore,
since ODBC is network compatible, the application and database server can be located on
different PCs anywhere on the network.
As shown in Figure 7-4 below, ODBC works by inserting a middle layer, called an ODBC
driver, between the application and the database server. The ODBC driver translates the
application's requests into commands that are understood by any ODBC-compliant database
server. 
In ODBC terminology, the database being used is called a data source. Think of a data
source as a combination of:
• The physical database file being accessed
• The information required to access that data (for example, security parameters)
• The physical location of the database
Each ODBC data source is identified by a unique Data Source Name (DSN). ODBC defines
a number of different types of DSN: 
• User DSNs are visible only to the currently logged in user
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• System DSNs are visible to all network users and to Windows services 
• File DSNs are visible by several users sharing the same database file.
• Machine DSN is a term used to describe DSNs that are present on the local PC, that is,

user DSNs or system DSNs.
System DSNs are used by the VM600 CMS Software to ensure that databases are
continuously available to all users and can be accessed across a network.
Figure 7-4 shows the basic ODBC components within the CMS Software architecture.

7.2 Structure of CMS Software Databases
Each CMS Software database is logically divided into a number of segments:
• Configuration Data. The online portion of the database contains all data relating to the

configuration of the VM600 rack or racks, as well as internal CMS Software configuration
details such as Mimic documents and security settings. Online configuration data is
stored in the database by using the Configuration Editor module.

• Mimic Documents. The graphical documents you create with the Mimic application to
display the contents of the database are stored within the database itself. These
documents can display both online and offline data.

ODBC-Compliant 
Database Server

SQL Queries

CMS Software 
Module

ODBC Driver

Data Queries

Commands in Standard 
ODBC FormatNetwork

Database

Figure 7-4 : ODBC Database Components
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• Measurement Data. This part of the database contains both online data, that is, the
actual data that has been collected from VM600 rack outputs, and historic data, that is,
the data used to construct spectra, trends, waveforms, and orbits. 

The “offline” portion of the database contains details of all offline points. These are special
database tables in which data collected by external control or monitoring systems, such as
turbine control systems, or via specialist communications protocols, such as Modbus or
Dynamic Data Exchange (DDE). 
The database structure is shown in Figure 7-5:

7.3 Essential Database Tasks
Creating a database that is ready to begin storing measurement and configuration data
involves:
1- Creating a new physical database file. This is the file (typically stored on the database

server PC, but it can be located on any PC in the network) in which the data is stored. 
A utility is provided with the CMS Software to help you create new database files: refer
to 7.3.1 - Creating a Physical Database File.

2- Preparing the internal structure of the database. 
The Create database utility also divides a newly-created database file into separate
areas to hold configuration data and measurement data, and prepares the internal
database structure for use.

3- Setting up the database to accept measurement data. The necessary tasks are
described in 7.4.3 - Establishing a Remote Connection from a Client PC without Sybase.
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Figure 7-5 : Structure of a VM600 CMS Software Database
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7.3.1 Creating a Physical Database File
Use the Create utility to create a new database for use with the VM600 CMS Software. The
utility creates the database in three stages:
• Creates the physical database file
• Defines the ODBC data source name of the database server that is to manage the

database file (refer to 7.4.3 - Establishing a Remote Connection from a Client PC without
Sybase)

• Generates the internal database structure needed to hold VM600 configuration and
measurement data for offline points, online points or both.

To create a new database:
1- Stop any existing database servers that are currently running on the local PC. Refer to

7.5.4 - Stopping Database Servers for details on how to do this. 
2- Start the VM600 Administrator program (Start > Programs > VM600 CMS Software

> Administrator).
3- Expand the Database Utilities icon and double-click Create. The Create New VM600

Database window is displayed:

4- Click Browse. 
5- Navigate to the folder in which to store the database file and type the name of the file,

with a “.db” extension (for example, “cms_sw.db”), and click Save.

NOTE : The C:\Program Files\VM600_CMS\DB folder is provided as a default location for
databases.

6- Type the ODBC Data source name to assign to the database. To simplify name
management, it is recommended to use the upper case equivalent of the database file

DATABASE FILES ARE TYPICALLY 1 TO 2 MB IN SIZE WHEN FIRST CREATED.
HOWEVER, WHEN LIVE MEASUREMENT DATA IS BEING STORED, THE FILE SIZE CAN
GROW QUICKLY AND LARGE DATABASES CAN REACH 5 GB OR MORE IN SIZE. 
BEFORE CREATING A DATABASE, BE SURE TO RESERVE SUFFICIENT FREE DISK SPACE
FOR IT.

Figure 7-6 : The Create New VM600 Database Window
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name, minus the extension. For example, if the database file is “cms_sw.db”, type
“CMS_SW”, as shown in Figure 7-7:

The data source name subsequently appears in the list of available databases in, for
example, the VM600 Configuration Editor module.
Refer to 7.4.3 - Establishing a Remote Connection from a Client PC without Sybase
below for further information on ODBC data source names.

7- The Include login information is selected by default, which means that the user ID and
password you specify (see below) will be automatically used on behalf of users whenever
they access the database using ODBC. If you deselect this option, users must enter a
user ID and password before using any of the CMS Software modules with this database. 

8- Specify a User ID and Password for access to the database. Retype the password as
confirmation. 

NOTE : The default values proposed are “DBA” for the user ID and “SQL” for the password.
You can change the default user ID and password to provide additional security.
Refer to 7.5.1 - Controlling Access to the Database Server for details.

9- Click OK. The utility creates the physical database file, sets initial security settings and
creates default database configuration data.

10- When the “Task finished successfully!” message is displayed, click OK to close the
Create Database tool.

The new database can now be used to store configuration and measurement data. 

7.3.2 Creating a Database Server
For each database you create (see 7.3.1 - Creating a Physical Database File), you must also
create a database server to manage communications with the database.
In the following example, a database server named VM600_DB_SERVER is created to
manage the physical database file C:\Program Files\VM600_CMS\DB\test.db and allow
TCP/IP network connections to the database. 
To create a database server:
1- Launch Sybase Central (Start > Programs > Sybase SQL Anywhere 8 > Sybase

Central)

Figure 7-7 : Specifying the DSN
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2- Select Services, then double-click Add Service.
3- Type a name for the database server (for example “VM600_DB_SERVER”)  and click

Next.
4- Select Network Database Server and click Next. A network database server is required

to support client/server communications across a network.
5- Select the executable program for the database server: 

NOTE : Depending on the type of Sybase license used on the computer, either dbeng8.exe
or dbsrv8.exe (as shown in Figure 7-8 above) may appear as the name of the
executable. You must use dbsrv8.exe. If dbeng8.exe appears, click Browse and
select the dbsrv8.exe program manually. 

6- Specify command-line parameters for the database server and click Next. The following
parameters are usually sufficient:

-x tcpip Add TCP/IP network support for the database server

-ch 32M
Use a cache size of 32 MB. See 7.5.3 - Database Server 
Cache Memory Size Optimization for information on 
specifying cache sizes

-n VM600_DB_SERVER

Name the database server “VM600_DB_SERVER”. This is 
the name that appears in the list of available database 
servers in Sybase Central, and as the name of the system 
service in Windows

databasename
The path and file name of the physical database file that is to 
be managed by the database server, for example, 
“C:\Program Files\VM600_CMS\DB\server1.db”

NOTE : If the path or file name of the database contains spaces, you must type quotation
marks (“) around the parameter. 

Figure 7-8 : Selecting the Executable for a Database Server
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For example:

For a complete list of command-line parameters, refer to the Adaptive Server Anywhere
online help (search for “database servers, command line”, for example)

7- Leave the default value Local System Account selected and click Next. 
8- Specify whether the database server is to be started automatically or manually. In most

cases, you can leave the default value Automatic selected and click Next. This means
that the database server is started automatically when you next restart Windows.

9- To start the database server immediately, select the Start the service now check box.
Otherwise, deselect the check box. You must then start the database server manually or
automatically during the next system restart. Refer to 7.3.3 - Starting a Database Server.

10- Click Finish to create the service. 
There are several ways to check that the database server has been created correctly and that
it is running:

• Verify that a database server icon  has appeared in the Windows system tray to
indicate that the server is running. Double-click the database server icon to display a
console window showing information about the service:

Figure 7-9 : Database Server Command Line Parameters

Figure 7-10 : The Database Server Console
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• Display the Sybase Central window and click Services. The new database server
appears in the list on the right, as shown in Figure 7-11:

• Display the list of Windows system services (Start > Settings > Control Panel >
Administrative Tools > Services). The text “Adaptive Server Anywhere” appears in
front of the database server name, for example:

7.3.3 Starting a Database Server
If you did not choose the Start the service now option when creating the database server,
you can subsequently start the database server either automatically or manually.

7.3.3.1 Automatic Start

If you selected the default Automatic setting selected when creating the database server,
the database server is configured to run as an automatic Windows service and starts
automatically when you next restart Windows.

7.3.3.2 Manual Start

If you selected the Manual option, you must force the service to start manually using either
Sybase Studio, or directly from the Services window as follows:
1- Display the Services window (Start > Settings > Control Panel > Administrative

Tools > Services).
2- Right-click on the service name in the list of available services and select Start.

Figure 7-11 : The New Database Server in Sybase Central

Figure 7-12 : A Database Service in the Services Window
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Or, in Sybase Central:
1- Start Sybase Central.
2- Click Services
3- Right-click on the service in the list on the right and select Start.

7.4 Next Steps
If the database server and CMS Software are installed on the same PC, you can now proceed
to Chapter 8 - Setting Up the VMCom Communications Handler.
If they are installed on different PCs, however, you must now prepare the database server to
accept remote connections, and establish a connection to the PC on which the database
server is running from the remote operator PC or PCs on which the CMS Software is running,
as shown in Figure 7-13:

Figure 7-13 : Setting Up a Remote TCP/IP Connection to the Database Server

7.4.1 Preparing the Database Server to Accept Remote Connections

NOTE : The following task is only required if your database and the CMS Software modules
are installed on different PCs. 

To configure a database server to accept remote connections:
1- Verify that a database has been created, the internal structure prepared and a database

server exists for the database. Refer to 7.3.1 - Creating a Physical Database File and
7.3.2 - Creating a Database Server, respectively. 

2- Determine the TCP/IP address of the local PC. For example, open a Command Prompt
window and type ipconfig:

In the above example, the TCP/IP address of the local PC is “10.10.10.12”. Note down
this address.

NOTE : If your network uses DHCP to allocate TCP/IP addresses dynamically, this address
is likely to change from one Windows login to the next. In this case, use the host
name of the local PC instead. Contact your network administrator if you are unsure
of the value to use.

“Local” PC “Remote” PC

TCP/IP

Operator PCDatabase Server

C:\>ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix  . : vm.lan

IP Address. . . . . . . . . . . . : 10.10.10.12

Subnet Mask . . . . . . . . . . . : 255.255.0.0

Default Gateway . . . . . . . . . : 10.10.1.254
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3- Start the ODBC Administrator (for example, with VM600 Administrator > System Tools
> ODBC Administrator).

4- Select the System DSN property sheet.
5- Select the data source to which remote access is to be enabled and click Configure.
6- Click the Database property sheet and check that the database Server name is correct

(for example, “VM600_DB_SERVER”) and corresponds to the Database file name.
7- Click the Network property sheet. 
8- Select the TCP/IP check box and enter the network protocol options, which must include

the host name or address of the local PC that you noted previously. For example:
HOST=10.10.10.12;UDP=NO;

9- Click the ODBC property sheet and click Test Connection. A “Connection successful”
message is displayed. If the test fails, check that the database server name and TCP/IP
address of the local PC are correct. 

10- Click OK.
The database server is now ready to accept remote connections.

7.4.2 Establishing Remote Connections to the Database Server

NOTE : The following task is only required if your database and the CMS Software modules
are installed on different PCs. 

Perform the following procedure on the remote PC, that is, the PC on which the CMS
Software is installed and from where you wish to connect to a database server on a different
PC (see Figure 7-13).
1- First, test the network connection to the remote PC:

a. Open a Command Prompt window on the remote PC.

b. Type ping ipaddress, where ipaddress is the TCP/IP address or host name of the
PC running the database server. For example:

C:\>ping 10.10.10.12

Pinging 10.10.10.12 with 32 bytes of data:

Reply from 10.10.10.12: bytes=32 time<10ms TTL=128

Reply from 10.10.10.12: bytes=32 time<10ms TTL=128

Reply from 10.10.10.12: bytes=32 time<10ms TTL=128

Reply from 10.10.10.12: bytes=32 time<10ms TTL=128

Ping statistics for 10.10.10.12:

 Packets: Sent = 4, Received = 4, Lost = 0 (0% loss)

Approximate round trip times in milli-seconds:

Minimum = 0ms, Maximum =  0ms, Average =  0ms

If the remote PC cannot be reached using the ping command, contact your network
administrator.

2- Start the ODBC Administrator (for example, with VM600 Administrator > System >
Administration Tools > ODBC Administrator).

3- Select the System DSN property sheet.
4- Click Add.
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5- Select the Adaptive Server Anywhere 8.0 ODBC driver, and click Finish:

6- On the ODBC Configuration window that appears, type a Data source name. This is a
system DSN that will be created on the local PC to identify the database server on the
remote PC, for example, “REMOTE_VM600_DB”.

7- Optionally, type a Description, for example “System DSN for remote CMS database”.
8- Select the Login property sheet and enter a valid User ID and Password to connect to

the database (the default values are “DBA” for the user ID and “SQL” for the password).
9- Select the Database property sheet. 
10- Type the Server Name of the remote database server, for example

VM600_DB_SERVER.
11- Type the Database Name of the database you wish to access using the database server

(this is important if the database server is managing several databases):

Figure 7-14 : Creating a New Data Source Name

Figure 7-15 : Configuring ODBC Database Settings
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12- Click the Network property sheet. 
13- Select the TCP/IP check box and enter the TCP/IP address of the remote PC. For

example: 

NOTE : If your network uses DHCP to allocate TCP/IP addresses dynamically, this address
is likely to change from login to login. In this case, use the host name of the local
PC instead. Contact your network administrator if you are unsure of the value to
use.

14- Click the ODBC property sheet.
15- Click Test Connection. A “Connection successful” message is displayed:

16- Click OK to complete creating the remote ODBC link. 
If the test fails, check that the database server name and TCP/IP address of the remote
PC are correct.

To test the connection from a CMS Software module, launch the module and attempt to
access the database server identified by the DSN name you assigned in Step 6 above, for
example “REMOTE_VM600_DB”. The following figure shows a list of available databases in
the VM600 Configuration Editor module:

HOST=ipaddress; Where ipaddress is the TCP/IP address of the PC on which 
the database server is running, for example “10.10.10.12”.

UDP=NO;
Connections to the PC do not use the User Datagram 
Protocol (UDP). Use of UDP is optional: it can improve data 
transfer times between Windows PCs.

Figure 7-16 : Testing the ODBC Connection
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7.4.3 Establishing a Remote Connection from a Client PC without Sybase
You can remotely access a database server from a client PC that does not have the Adaptive
Server Anywhere software installed on it. 
To prepare the server:
1- Test the network connection between the server and the client PC using the ping

command.
2- Start the network database server program on the server, and load the correct database.
3- Be sure to allocate an adequate number of client licenses when installing the Adaptive

Server Anywhere software (see 4.1.1 - Installing Adaptive Server Anywhere Database
Software)

To install and configure the client PC:
1- Install the CMS Software programs on the client PC, as described in Chapter

4 - Installing CMS Software, but do not install the Adaptive Server Anywhere database
software.

2- Locate the following ODBC driver files on the server (by default, C:\Program
Files\Sybase\SQL Anywhere 8\win32):

• dbodbc8.dll
• dblgen8.dll
• dbcon8.dll

Copy the files to the C:\Windows\System32 directory on the client PC. 
3- Register the ODBC driver as follows:

• Open a Windows command prompt.
• Change directory to C\Windows\System32
• Type regsvr32 dbodbc32.dll

4- Run the ODBC Administrator program (odbcad32.exe). 
5- Select the data source in the list and click Configure.
6- Select the Network property sheet.
7- Select the TCP/IP check box and type HOST=ip_address, where ip_address is the

TCP/IP address of the server. 

Figure 7-17 : A Remote Database in the List of ODBC Sources
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8- Click OK.
9- Connect directly to a database file (single access) or to a Sybase database server (for

multiple TCP/IP access).

7.5 Managing Database Servers

7.5.1 Controlling Access to the Database Server
The information needed to establish a connection between an ODBC-compliant client
application (that is, a CMS Software module) and an ODBC data source (that is, a database
server) is managed by a Windows program called the ODBC Administrator. Use ODBC
Administrator to identify the data source to use, manage the available ODBC drivers, and
configure security parameters for ODBC connections.

7.5.1.1 Starting ODBC Administrator

To start the ODBC Administrator:
1- Start VM600 Administrator.
2- Expand the System Tools icon and double-click ODBC Administrator.
3- The ODBC Data Source Administrator window is displayed:

NOTE : You can also access the ODBC Administrator window via the VM600 Administrator
module. See Chapter 6 - Using the VM600 Administrator.

7.5.1.2 Entering the User ID and Password to Access a Database Server 

When you start any of the CMS Software modules, the module’s ODBC driver must be able
to connect to the chosen data source. To do this, it must provide the following parameters: 
• The ODBC data source name (DSN)
• The User ID (UID) of the ODBC connection
• The Password (PWD) associated with the user ID.

Figure 7-18 : The ODBC Administrator Window
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If, when creating the database, you chose to allow CMS Software modules to automatically
reuse the ODBC user ID and password (refer to 7.3.1 - Creating a Physical Database File),
starting any of the CMS Software modules does not require a user ID and password to be
entered. 
Otherwise, if you do not select automatic reuse, the following window is displayed whenever
you start any of the CMS Software modules:

You must type a valid user ID and password to access the data source. Adaptive Server
Anywhere uses the following default values:
• User ID: DBA
• Password: SQL

NOTE : Both the user ID and password are case-sensitive.

Additional user IDs can be created using Sybase Central. See Logging On With a Different
User ID and Password below for details.

7.5.1.3 Logging On with a Password Only

Using the ODBC Administrator program, you can force users to enter only a password when
accessing a database:
1- Start the ODBC Administrator program.
2- Click the System DSN property sheet.
3- Select the DSN of the database from the list and click Configure.
4- Click the Login property sheet.
5- Delete the Password.
6- Click OK twice.

Figure 7-19 : Connecting to a CMS Software Module 
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At the next login, the User ID field contains the default user ID “DBA”, but the password field
is empty and must be typed by the user before access to the data source is granted:

7.5.1.4 Logging On With a Different User ID and Password

To modify both the default user ID and password to use for the ODBC connection to a
database:
1- Start Sybase Central.
2- Connect to the database and create a new user. Specify the user ID and password and

configure the user account’s permissions and properties as required.
Refer to Sybase Central’s online help for details.

At the next login, the user must enter both the user ID and password to access the database. 

7.5.2 Modifying Database Server Command Line Parameters 
To subsequently modify any of the command line parameters or startup options of a database
server, use Sybase Central. For example, you may later wish to add another database to the
service so that the database server manages several databases, or to change the name of
the current working database.
To modify the parameters of a database server:
1- Stop the database server, from either the Services window or Sybase Central. See

7.6.5 - Updating Databases from Previous Releases of the CMS Software.
2- In Sybase Central, click Services.
3- Right-click on the database server and choose Properties.
4- Select the Configuration property sheet.
5- Change the parameters as required, then click OK.
6- Restart the database server.

7.5.3 Database Server Cache Memory Size Optimization
You can configure a database server to use cache memory in which to store frequently
accessed database data. Since accessing cache memory is much faster than accessing a
hard disk, the use of cache memory can improve database performance significantly. The
larger the cache, the more pages are accessible in the cache, the fewer times the database
server needs to read data from disk, and so the bigger the performance improvement.

Figure 7-20 : Prompting for a Password Only
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In Adaptive Server Anywhere, the following database server parameters are used to
determine the cache memory size:

Use the information in Table 7-1 to determine the initial recommended cache memory size:

An additional constraint is that the cache memory size should occupy no more than 25% of
the total amount of random access memory (RAM) installed on the PC, and never more than
50%. 
For example, if the PC has 512MB of RAM, the cache memory setting should be 128MB. For
a 4-rack system, therefore, use:
-c 64M -ch 128M

7.5.4 Stopping Database Servers
You can stop a database server from Windows, Sybase Central or the database server
console window. 
To stop a database server from the Windows Services window:
1- Display the Services window (directly from the VM600 Administration utility, or choose

Start > Settings > Control Panel > Administrative Tools > Services).
2- Right-click on the service and select Stop.
To stop a database server from Sybase Central:
1- Start Sybase Central.
2- Click Services.
3- Right-click on the service in the list on the right and select Stop.
To stop a database server from the database server console:

1- Double-click the database server icon in the Windows system tray to display the
console window (as shown in Figure 7-10).

2- Click Shutdown.

7.5.5 Deleting Database Servers

NOTE : You cannot delete a database server directly from the Windows Services window.

-c Sets the initial memory reserved for caching database pages and other server 
information. The default value is 2M (2MB).

-ch Sets a maximum cache size, as a limit to automatic cache growth.

Table 7-1 : Recommended Initial Cache Memory Settings

Number of VM600 Racks -c -ch

1 32M 64M

2 32M 64M

3 64M 128M

4 64M 128M
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To delete a service:
1- Open Sybase Central > Adaptive Server Anywhere 8 > Services
2- Check that the service is not running - if it is stop it. Open the pop-up menu with a right

mouse click on the service and click the left button to stop the service

3- Right click on the service and select delete from the pop-up menu
4- Close Sybase
5- Click Exit.
6- Shut down and restart Windows.
The service is removed from the list of available services. This can be checked in the
Services window (Start > Settings > Control Panel > Administrative Tools > Services).

7.6 Managing Databases

7.6.1 Database Monitoring
VMCom automatically monitors the size of the database and the log file. 
VMCom maintains log files in the C:\Program Files\VM600_CMS\Projects directory. This log
file contains:
• A timestamped entry whenever a predetermined increase in database size occurs.
• An entry to report an automatic purge of a database or log file after it has reached a

predetermined size.
You can use this log file to predict database growth and determine a sensible backup strategy
using:
• The VMCom DELETE parameter.
• Performing a database copy into a backup directory.

Figure 7-21 : Deleting a Service
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Figure 7-22 shows an extract from a log file:

7.6.2 Using the Database Maintenance Tool
The Database Maintenance Tool checks the presence and integrity of CMS Software
databases on your system. It allows you to access all relevant information concerning an
ODBC data source, including its name, the presence and type of the database files (*.db and
*.log), and the presence and name of the respective database engine. This information
provides a quick overview of where the database files are physically stored, by which
database engine they are being deployed as data sources, and with which name. 
To begin database maintenance:
1- Start VM600 Administrator.
2- Expand the Database Utilities icon and double-click Database Maintenance Tool. The

Database Maintenance Tool window is displayed:
When the utility starts up, it lists all system DSNs existing on the local machine, with the
Status column showing “???”. 

Figure 7-22 : A Database Log File



7 - 22 CMS Software Manual (Volume 1) MACMS-SW/E
Edition 10 - Jul 26/07

Managing Databases
ADMINISTERING DATABASES

Click Check Status to force the utility to attempt to connect to all the listed databases and
display the result of the connection attempt:

A “Connection successful” message indicates that a connection is possible. Other messages
may indicate that the utility is unable to connect to the database. Refer to Appendix
A - Troubleshooting and Frequently Asked Questions for more information. 
The Path column gives the location of physical database files. 
The Total Size column gives the total size of databases, in megabytes (MB). The size is
shown as:

Total Size (Database Size + Transaction Log File Size) MB
For example:

14(14+0) MB

You can perform the following database maintenance tasks:
• To delete a database’s system DSN (but leave the corresponding physical database file

untouched):
a. Select a database from the list

b. Click Delete DSN.

• To delete both the database’s system DSN and the corresponding physical database file:
a. Select a database

b. Click Delete DSN & DB.

c. A window appears warning you that the entire contents of the database will be
deleted and cannot be recovered. Click OK to continue, or Cancel to abandon the
operation.

Click Refresh to update the display.
Click Exit to quit the tool.

7.6.3 Creating a “Snapshot” Copy of a Database
A database utility is provided to copy measurement data from one (source) database to a
second (target) database. This creates an instant “snapshot” of the data contained in a
database. You can select the time frame for which you want to collect the data into your
snapshot. For example, you can create snapshot databases of all measurement data
collected on certain days, merge the snapshot databases into a single composite database,

Figure 7-23 : The Database Maintenance Utility
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then delete the last “x” days’ data from the main data collection database, as shown in the
figure below. Baseline Data will not be copied into the Snapshot (neither the BL table nor the
associated datasets).

Refer to 7.2 - Structure of CMS Software Databases for an overview of the database
structure.

NOTE : To copy configuration data from one database to another, use the Advanced
Copy database utility instead. See 7.6.4 - Advanced Database Copying below.

To create a “snapshot” database: 
1- Start VM600 Administrator.
2- Expand the Database Utilities icon and double-click Snapshot Copy. The Snapshot

Copy window is displayed:

Snapshot 2Snapshot 1 Snapshot 1
+Snapshot 2

DELETE = x days

t

Today

+ =

Data
collection

Figure 7-24 : Creating Snapshot Copies of a Database

Figure 7-25 : The Snapshot Copy Window
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3- Type the system DSN or click Select and choose the database to copy the measurement
data from.

4- Enter a valid User name and Password for the database.
5- Click Select to choose the destination database. Click Create to create a new database

in which to store the data.
6- Enter a valid User name and Password for the target database.
7- Choose whether to copy all measurement data, or only data collected over a specified

period of time, such as the past 1 month or 3 days.
8- Click OK to begin the copy immediately. 
9- Alternatively, click Create batch file to generate a Windows command file (*.bat)

containing the instructions required to carry out the snapshot copy. Examples of batch
file use are given in the next section.

The Consistency check is also affected when copying databases using: 
1- Snapshot Copy: check runs on source database (before copy process) and destination

database (after copy)
2- Advanced Copy: check additionally runs on source database and destination database

(before copy process) and again on the destination database (after copy process).
If these checks are passed without exceptions, these procedures run silently in the
background. A one-line summary is added to the copy.log (Figure 7-26).

Figure 7-26 :  Copy.log After Copying a Database

7.6.3.1 Creating Snapshot Batch Files

The Create batch file button on the Snapshot copy window generates a batch file containing
the instructions necessary to create a snapshot copy of a database. 

Figure 7-27 : CopyDB.bat After Creating a Snapshot

The following is an example of a generated batch file:

# SNAPSHOT COPY BATCH FILE

# MODIFY DIRECTLY AT YOUR OWN RISK!

"C:\Program Files\VM600_CMS\Admin\CopyDB.exe" CMD=SNAPSHOT; 
SOURCE=SAMPLE,DBA,SQL; DEST=0,ANOTHER,DBA,SQL;  FILTER=743,0;

You can use the batch files, for example, to create snapshot databases containing all data
generated today, or during the past 24 hours. You can set up Windows to run the batch files
automatically, for example, at specific times of the day. 
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7.6.3.2 Merging Snapshot Files

When you have created several snapshot databases, you can use the Snapshot Copy utility
to copy the measurement data from one snapshot database to another. To do this:
1- Run the Snapshot Copy utility.
2- On the Snapshot Copy window, select the most recent snapshot database you created

as the Source Database and the earlier-created database as the Destination
Database.

3- Choose Copy All Measurement Data.
4- Click OK.
The measurement data from the older snapshot database is copied to the newer database.
Progress, warning and error messages are written to a status window. An example is shown
in Figure 7-28: 

7.6.3.3 Scheduled Task Snapshot Merge

This merge program copies all measurement data from the source database into the
destination database. After running a daily 24 hour Snapshot copy as a backup, the following
command can be used to automatically amend the data slice to another database (i.e. large
backup) of the same configuration. Data already existing in the destination database will not
be re-copied. Due to a configuration check, the process is interrupted before copying the data
if configuration changes have been made.
To amend the merge to an existing backup procedure:
1- Open the existing snapshot.bat file created in 7.6.3.1- Creating Snapshot Batch Files
2- Add the new command line replacing the following with your settings (see Figure 7-29)
"C:\Program Files\VM600_CMS\Admin\copydb.exe" CMD=DATA_MERGE; 
Source=<dsn>,<uid>,<pwd>;DEST=<dsn>,<uid>,<pwd>;

Figure 7-29 :  Adding a New Command Line to the snapshot.bat File

Figure 7-28 : Copying Snapshot Databases
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To create a new scheduled task
1- Choose Start > Settings > Control Panel and double-click Scheduled Task.
2- Double-click Add scheduled task.
3- Click Next.
4- Click Browse.
5- Select the executable program copyDB.exe 

(e.g. C:\Program Files\VM600_CMS\Admin\copydb.exe) and click Open.
6- Select the frequency at which the backup is to be performed, e.g. "Daily".
7- Click Next.
8- Select the time, frequency and start date for the backup and click Next. Before starting

the data merge ensure that the copy of the backup slice from the running database has
finished.

9- Enter the name and password of the Windows user account that is to run the scheduled
task.

10- Select Open advanced properties for this task and click Finish. The advanced
properties window for the CopyDB program will be displayed (Figure 7-30).

Figure 7-30 : Advanced Properties for Database Merge

7.6.4 Advanced Database Copying
A utility is provided to copy the complete or partial contents of one (source) database to
another (target) database. You can choose to copy measurement data, configuration data, or
both. Refer to 7.2 - Structure of CMS Software Databases for an overview of the database
structure.

NOTE : To copy measurement data from one database to another, consider using the
Snapshot Copy utility instead. See 7.6 - Managing Databases.

To copy a database: 
1- Start VM600 Administrator.
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2- Expand the Database Utilities icon and double-click Advanced Copy. The Select
Source DSN window is displayed:

3- Click Select. 
4- On the Select Data Source window, select the Machine Data Source property sheet,

choose the data source name of the source database (that is, the database that is to be
copied) and click OK.

NOTE : The database to be copied must not currently be in use by the CMS Software.

5- Type the ODBC User ID and Password for the ODBC connection to the source
database. By default, the user name is “DBA” and the password “SQL”.

6- Click Next. The Select Target DSN window is displayed:

7- Repeat steps 3 to 6 to select and log in to the target database.
8- Optionally, select any of the following options:

• Delete the contents of the target database first, then copy the source database
contents.

• Do not carry out a check that all database tables and columns that exist in the source
database also exist in the target database before starting the copy. It is not
recommended to skip this check.

Figure 7-31 : The Select Source DSN Window

Figure 7-32 : The Select Target DSN Window
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• Automatically launch the VM600 Configuration Editor module when copying is
complete.

9- Click Next. You are prompted to provide a Super user password for the destination
database:

Type a valid password and click OK to continue.
10- The Copying Options window is displayed:

11- Select one of the following options:
• Copy Configuration. Copy configuration data only from the source database to the

target database. You can choose to copy configuration data for online points only,
offline points only, or both. In addition, you can choose to copy all Mimic documents
stored in the database, and to automatically create any measurement tables that
exist in the source database but are missing from the target database.

• Advanced. Select one of the options listed in Table 7-2 below.

Figure 7-33 : The Privilege Level Window

Figure 7-34 : The Copying Options Window
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• Copy Measurement Data. Copy configuration data only from the source database
to the target database.

12- Click Finish to begin copying.
Depending on the type of operation performed, wizards are provided to guide you through
various questions that are important for the consistency of the new system architecture, such
as station, machine and point name associations. For example, the following window might
appear to allow you to select points in the source database from which to copy measurement
data:

Table 7-2 : Advanced Database Functions

Advanced Functions Description

APPEND RACK Adds a complete VM600 rack, including all cards, points 
and associated outputs to the target database.

APPEND STATION 
Adds a complete Station, including all attached 
machines, racks, points, and outputs to the target 
database.

APPEND MIMICS Adds selected Mimic documents to the target database.

EMPTY DB Clear the target database of its entire contents.

UPDATE DB Update the target database to match the structure and 
contents of the source database.

APPEND ALL Append the entire contents of the source database to the 
target database.

ONLINE 
CONFIGURATION

Copy all configuration data from online data points to the 
target database.

Figure 7-35 : Selecting Points to Copy in the Source Database
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Source and target database table and column names at the same hierarchical level must be
unique. More explicitly, the following constraints apply: 
• All Station names within the same database must be unique.
• All Machine names within the same station must be unique.
• All Point tag names associated with the same machine must be unique 
• All output Tag names associated with the same point must be unique.

NOTE : Measurement data can only be copied from one machine to another if their
configurations are identical, that is, the same number and type of points, outputs,
cards, channels used, tags).

Using this utility, it is possible to use the same database as both source and target DSN,
which allows you to very efficiently build up large systems that consist of many identical
machines or stations. The advanced options then allow you to rapidly duplicate portions of a
configuration (racks, machines, stations) with minimum effort. This functionality also allows
you to prepare “template configurations” for particular machines, or parts of machinery, from
which real system configurations can then be assembled. 

7.6.5 Updating Databases from Previous Releases of the CMS Software
The internal structure of CMS Software databases can differ from one release to the next. A
utility is therefore provided to automatically update the internal structure of a database
created with an earlier release of the CMS Software to the structure required by the currently
installed release.
To upgrade a database to the latest release:
1- If it is not already running, start the VM600 Administrator program.
2- Expand the Database Utilities icon and double-click Update Internal Database

Structure. The window shown in Figure 7-36 is displayed:

3- Enter the ODBC data source name of the database in which to create the tables.
4- Type a valid user ID and password for the ODBC connection to the specified data source.

If you accepted the default values when creating the database, type “DBA” for the User
ID and “SQL” for the Password.

5- Click Finish.
6- Enter a valid super user password when prompted and click OK.

Figure 7-36 : The Create Database Tables Utility
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7.6.6 Updating Measurement Tables

NOTE : You must have Super user privileges to use this utility.

The CMS Software stores measurement data in database tables. These tables are managed
dynamically by the system, that is, they are continuously updated to be fully consistent with
the system configuration.
The VMCom communications handler module verifies the consistency of the existing
measurement tables against the current configuration whenever it is started and—if
needed—automatically adapts the database table structure accordingly. 
Consequently, this utility is not normally required. Nevertheless the presence of the
measurement tables is required by some CMS Software modules in order to be fully
functional. In particular, the Mimic module requires the existence of measurement tables in
order to be able to correctly assign indicators to values. The preparation of functional Mimic
documents that include values and/or status indicator objects is therefore only possible if
these tables already exist. 
This utility manually completes the internal database structure, including the measurement
tables, without requiring you to launch the VMCom communications handler. This may be
relevant when preparing databases offline, that is, without hardware, or for integration work
where third-party systems need to refer to measurement tables. 

NOTE : The database file, ODBC data source name and configuration must already exist. 

To create missing measurement tables:
1- Start VM600 Administrator.
2- Expand the Database Utilities icon and double-click Update measurement tables. The

Select Database window is displayed (Figure 7-36).
3- Click Select. 
4- On the Select Data Source window, select the Machine Data Source property sheet,

choose the system DSN name of the database to be updated and click OK.
5- Type the ODBC User Name and Password for the ODBC connection to the source

database. By default, the user name is “DBA” and the password “SQL”.
6- Optionally, select the Initialize missing records with default values check box to write

default values into the newly created database records. 
7- Click Finish.
8- When prompted, enter a valid super user password for the selected database:

9- Click OK.

Figure 7-37 : The Privilege Level Window
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10- The utility runs and status messages are displayed. In the example shown in Figure 7-38,
two new database tables are added and initialized with default values:

11- Optionally, click Save log to write the contents of the window to a file.
12- Click OK to shut the window.

7.6.7 Deleting Measurement Data from a Database

This utility deletes all measurement data from a specified database. Configuration data and
Mimic documents stored in the database are unaffected. 
To delete measurement data from a database:
1- Start VM600 Administrator.
2- Expand the Database Utilities icon and double-click Delete measurement data from

database. 

Figure 7-38 : Output from Create Missing Measurement Tables

This utility should be used with extreme care, and only by experienced
users. Under normal circumstances its operation should be strictly limited
to cleaning up measurement data that has already been backed up, or to
eliminate unwanted data produced, for example during testing,
commissioning, or training.

Figure 7-39 : The Delete Measurement Data Utility
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3- Enter the ODBC Data source name of the database to delete measurement data from.
4- Type the User ID and Password of the ODBC connection to the specified data source.
5- Specify the “last valid” date and time. To modify the date, you can either:

• Click on any of the data or tile fields and type a new value.
• Click the down arrow on the data field to display a monthly calendar and select the

click to select a date:

6- Click Delete Data. All measurement data acquired before the selected valid date and
time is permanently deleted from the database. Record sets defined as Baseline data will
not be deleted.

7.6.8 Deleting Baseline Pointers
This tool deletes all entries in the Baseline table. The VM Delete program will then eliminate
the linked datasets from the database once they are outside the selected time window.

7.6.9 Changing Transaction Log File Settings
Transaction logging is activated by default on all new databases created using the Create
utility (see 7.3.1 - Creating a Physical Database File). However, you can activate it for
existing databases, or disable it if it is not required. 
To configure a database to use a transaction log file:
1- Choose Start > Programs > Sybase SQL Anywhere > Sybase Central.
2- Double-click on Utilities.
3- Double-click Change Log File Settings.
4- Click Next.
5- Click Browse and select the database file to change log file settings for.

Figure 7-40 : The Calendar
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6- Click Next to view the current log file settings of the database. Figure 7-41 shows a
database that does not currently use a transaction log file: 

7- Click Next.
8- Select Maintain the following transaction log file. The transaction log file name

suggested is the same as the physical database file name but with a “.log” extension, as
shown in Figure 7-42. It is recommended to respect this naming convention. If you do not
specify a path, the log file is stored in the same directory as the database file.

9- Click Next to display mirror file settings for the database. The use of a mirror file improves
data security but reduces system performance considerably, and is not required for the
CMS Software system. Leave this option unchecked.

10- Click Finish and close Sybase Central. The database continues to run normally, but with
a log file.

Figure 7-41 : The Current Log File Settings

Figure 7-42 : Specifying the Transaction Log File Name



CMS Software Manual (Volume 1) MACMS-SW/E 7 - 35
Edition 10 - Jul 26/07

Managing Databases
ADMINISTERING DATABASES

7.6.10 Viewing the Contents of a Transaction Log File
Transaction log files are stored in a binary format. Viewing the contents of the log file
therefore requires that you translate it to a text file. Sybase Central includes a utility to do this:
1- Launch Sybase Central.
2- Double-click on Utilities.
3- Double-click on Translate Log File. The Translate a Log File wizard starts.
4- Click Next.
5- Click Browse and choose the transaction log file.
6- Choose the name of the text file in which to store the translated log file contents and click

Next.
7- Select any of the options you require:

• Generate ANSI SQL only. Adaptive Server Anywhere uses Embedded SQL, an
implementation of the ANSI standard. You are recommended NOT to select this
option as it does not include any data in the log file.

• Include uncommitted transactions. Since uncommitted transactions represent
data that has not yet been saved, you are recommended to select this option.

• Include trigger-generated transactions. Triggers (automatically executed
procedures stored in the database) are an important part of the database, and it is
recommended to select this option. Do not select Include as comments only, so
that they can be used again.

8- Click Next.
9- Optionally, choose Translate from the following checkpoint only and choose to

translate either from the last checkpoint or the last checkpoint prior to a specific date 
10- Click Finish.
A typical translated log file might contain: 
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--CONNECT-1001-0000281085-DBA-2004/apr/11 11:05

--BEGIN TRANSACTION-1001-0000281096

BEGIN TRANSACTION

go

--SQL-1001-0000281097

create server TEST class 'ODBC' using 'TEST'

go

--COMMIT-1001-0000281151

COMMIT WORK

go

--ROLLBACK-1001-0000281152

ROLLBACK WORK

go

--CHECKPOINT-0000-0000281159-2004/apr/11 11:05

--CONNECT-1001-0000281185-DBA-2004/apr/11 11:05

--BEGIN TRANSACTION-1001-0000281196

BEGIN TRANSACTION

go

--SQL-1001-0000281197

create domain

  ALARM_PRIORITY integer not null default 1 check(ALARM_PRIORITY between 0
and 2)

go

7.7 Backing Up Databases
Measurement data stored in VM600 CMS Software databases should be backed up and
archived on a regular basis. Standard Windows backup procedures cannot back up the
contents of a database while it is actually running because the database server locks files for
its exclusive use when running. There are, however, several ways of backing up databases
while the database server is still running:
• Using the CMS Software’s Backup Database utility
• Using a utility provided with Adaptive Server Anywhere
• Automatically, using an Adaptive Server Anywhere utility and the Windows task

scheduling facility.
You are advised to store the backed up database on a physically different device, for example
a different PC or physical hard disk drive. Using the Delete Measurement Data utility
described in 7.6.7 - Deleting Measurement Data from a Database, you can then reduce the
contents of the running database to improve performance.

7.7.1 Using the CMS Software’s Backup Database Utility
This tool creates an archive version of a running database. The resulting file can be stored
on the local system or on a network drive. The archived backup contains all information inside
the source database, including configuration data, Mimic documents and measurement data.
No changes are made to the source database itself. If the specified source database is not
running when you start the utility, its database server is temporarily started for the duration of
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the backup process. The creation of an archive copy allows you to restore a database at any
time using utilities provided by Adaptive Server Anywhere. 

To create a backup copy of a database:
1- Start VM600 Administrator.
2- Expand the Database Utilities icon and double-click Backup database. 
3- Enter the ODBC data source name of the database to back up.
4- Type the user ID and password of the ODBC connection to the specified data source.
5- Click Browse and select the folder in which to store the archive copy of the database.
6- Optionally, select Create backup log file and select the name and location of a log file.
7- Click Start.

7.7.2 Using the Adaptive Server Anywhere Backup Utility
Sybase SQL Anywhere provides a database backup facility that can be used to back up a
database while it is running. 
To back up a database while it is running:
1- Select Start > Programs > Sybase SQL Anywhere 8 > Sybase Central.
2- Choose Tools > Connect.
3- On the New Connection window, choose Adaptive Server Anywhere 8 and click OK.
4- Select ODBC Data Source Name and select the database to be backed up, as shown

in Figure 7-43:

5- Enter a valid User name (for example “DBA”) and Password (for example, “SQL”) to
access the database. You are now connected to the database and can perform
maintenance tasks on it. 

When using this utility, it is strongly recommended to specify A
DIFFERENT location than the drive or folder containing the source
database. This avoids potential complications due to file names or file
size/available disk space conflicts. 

Figure 7-43 : Connecting to an ODBC Data Source in Sybase Central
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6- In Sybase Central, select Utilities then double-click Backup Database.
7- Click Next to display a list of databases. Select the database to back up and click Next.
8- Specify the location on disk or the tape drive on which to store the backup copy and click

Next.
9- Add an optional comment and click Finish to start the backup operation.

7.7.3 Performing Automatic Database Backups
Database backups can be scheduled to run automatically at predetermined dates and times. 
To set up scheduled database backups:
1- Choose Start > Settings > Control Panel and double-click Scheduled Task.
2- Double-click Add scheduled task.
3- Click Next.
4- Click Browse.
5- Select the executable program dbbackup.exe (for example, C:\Program

Files\Sybase\SQL Anywhere 8\win32) and click Open.
6- Select the frequency at which the backup is to be performed, for example “Daily”.
7- Click Next.
8- Select the time, frequency and start date for the backup and click Next.
9- Enter the name and password of the Windows user account that is to run the scheduled

task.
10- Select Open advanced properties for this task and click Finish. The advanced

properties window for the dbbackup program appears, as shown in Figure 7-44:

Figure 7-44 : Advanced Properties for DBBackup



CMS Software Manual (Volume 1) MACMS-SW/E 7 - 39
Edition 10 - Jul 26/07

Backing Up Databases
ADMINISTERING DATABASES

11- In the Run field, add the command-line parameters for the dbbackup program. For
example:

"C:\Program Files\Sybase\SQL Anywhere 8\win32\dbbackup.exe" -c DSN=SAMPLE;
-d -o backup_log.txt D:\VM600_BACKUPS

12- Click OK when finished. The backup task is added to the list of scheduled tasks.

NOTE : You are STRONGLY recommended to first run the scheduled task manually to test
that it runs correctly. To do this, right-click on the task in the Scheduled Tasks
window and select Run.

The command-line options for the database backup utility are listed in Table 7-3 below:

7.7.4 Creating a Backup Before Changing Configurations
Always create a backup copy of a database (both the database and the transaction log file)
before modifying your system’s configuration.
If you only do a simple file copy, detach the log file from the copied database file (Sybase
Central > Adaptive Server Anywhere > Utilities > Change log file settings).
If you normally retain the same configuration, but simply need to add a few data points and
need to save space, make an advanced copy (VM600 Administrator > Database Utilities
> Advanced Copy) of the existing configuration data.
To be sure, use the Snapshot Copy utility (VM600 Administrator > Database Utilities >
Snapshot Copy) to make a complete copy of the database.
You can also save your existing configuration by performing a dump-to-file extraction of all
defined parameters to Excel spreadsheet format. This allows you to archive all settings: It is
not, however, a substitute for making a full (snapshot) copy of the database.

Table 7-3 : Command-Line Parameters for the Database Backup Utility

Switch Description

-c “keyword=value; ...” Supply database connection parameters

-d1 Backup main database file

-l filename Live backup of transaction log to filename

-n Rename local backup of transaction log to match server

-o filename Write output messages to filename

-q Quiet: do not print messages

-r Rename and restart the transaction log

-t1 Back up the transaction log file

-w1 Back up write file

-x Delete and restart the transaction log file

-xo Delete and restart the transaction log without backup

-y Create directory or replace files without confirmation

1. If none of the -d, -t or -w options are specified, all files in the database are backed up



7 - 40 CMS Software Manual (Volume 1) MACMS-SW/E
Edition 10 - Jul 26/07

Permanently Deleting Data from a Database
ADMINISTERING DATABASES

7.8 Permanently Deleting Data from a Database
You can permanently delete data from a database:
• Automatically, using the daily delete feature in the VMCom communications handler.

Refer to Chapter 8 - Setting Up the VMCom Communications Handler.
• Manually, by entering the VMDelete command at a Windows command prompt:
VMDelete DSN=”myDB”; UID=DBA; PWD=SQL;LASTTIME=100;
The LASTTIME parameter specifies the number of days’ data you wish to retain in the
database. In this example, all data older than 100 days is deleted.
Alternatively, you can specify a date with the LASTTIME parameter, for example:
VMDelete DSN=”myDB”; UID=DBA; PWD=SQL;LASTTIME=2005-01-01;
In this case, all data stored in the database before the specified date is deleted.

7.9 Using a Different DBMS
It is recommended that you use the supplied Adaptive Server Anywhere package to create
and manage databases in which to store your VM600 data. However, you can instead store
your data in any other ODBC-compliant DBMS, for example:
• Oracle
• Microsoft Access
• Microsoft Excel
• Microsoft SQL Server
• IBM DBASE
• Paradox
Contact your nearest Vibro-Meter sales office for details. 

The loss of data from these tasks is permanent and cannot be recovered. You
must ensure you have backed up all data before using the VMDelete command.
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8 SETTING UP THE VMCOM COMMUNICATIONS 
HANDLER

8.1 Introduction
The VMCom communications handler is responsible for managing the flow of data between
the VM600 rack(s) and the database server. Only one VMCom communications handler can
exist on one PC at any one time.
You can either run the VMCom communications handler manually, or set it up to run as an
automatically started Windows service:
• It is recommended to set up the VMCom communications handler as a Windows system

service. This allows it to benefit from operating system features such as automatic start
on power-up of the PC, autoboot in case of repeated failure, or automatic restart in case
of the problems with other processes. This option also provides the greatest security and
reliability, as once running it is invisible to the normal user. This is described in
8.3.2 - Running VMCom from the VM600 Administrator.

• For testing and commissioning purposes, it is possible to start the VMCom
communications handler manually from the Windows desktop or run the VMDiag.exe
program directly from the Windows Explorer or command prompt. This is described in
8.3 - Running the VMCom Communications Handler Manually.

When started, the database server sends the VMCom communications handler the
configuration data of all configured VM600 racks. This data is then downloaded to the
CMC 16 card(s) in the VM600 rack(s), prompting an automatic reset of the cards. When the
CMC 16 card(s) have restarted with the required configuration, they can immediately start
sending data to the database server, which stores it in the database as measurement data.
Once the measurement data has been stored in the database, it can be extracted by other
CMS Software modules to be, for example, displayed as a chart. This is shown in Figure 8-1:
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Figure 8-1 : The VMCom Communications Handler Environment
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Correctly configured, starting the VMCom communications handler automatically establishes
communications between the VM600 rack(s) and the database server and data collection
begins. No further manual user intervention is required. Subsequent use of other CMS
Software modules such as Mimic to exploit the measurement data is optional.

8.2 Checking the VM600 Rack Status
Before starting the VMCom communications handler, use the following procedures to check
the status of CMC 16 cards in the VM600 rack. 

8.2.1 Checking the TCP/IP Address of the VM600 Rack
The VM600 Networking Instruction Manual describes how to check that the rack’s TCP/IP
address is valid and accessible across the network.
If the rack cannot be reached using the ping command, contact your network administrator.
Refer to the VM600 CMS Hardware Manual for details on how to set and subsequently
modify the TCP/IP address.

NOTE : It is a good idea to attach a label to the front of the rack indicating the card’s TCP/IP
address.

8.2.2 Checking the Communications Status
If the DIAG LED on the front panel of a CMC 16 card is flashing green, the card has received
no communications for more than 200 seconds. 
Within 30 seconds of the VMCom communications handler starting correctly, the DIAG LED
should change to continual green, indicating normal operation. 

8.3 Running the VMCom Communications Handler Manually
For testing and commissioning purposes, it is possible to start the VMCom communications
handler manually. This is possible in several ways:
1- From the desktop using a shortcut.
2- By running the VMDiag.exe program directly from a command prompt or the Windows

Explorer. 

8.3.1 Running VMCom from a Shortcut
To create a desktop shortcut to start the VMCom communications handler: 
1- Right-click on the Windows desktop and select New > Shortcut.
2- Click Browse and select the VMCom.exe program, for example “C:\Program

Files\VM600_CMS\Bin\VMCom.exe”.
3- Type a name for the shortcut and click Finish.



CMS Software Manual (Volume 1) MACMS-SW/E 8 - 3
Edition 10 - Jul 26/07

Running the VMCom Communications Handler Manually
SETTING UP THE VMCOM COMMUNICATIONS HANDLER

4- Right-click on the shortcut that appears on the desktop and choose Properties. The
following Properties window appears:

Figure 8-2 : Specifying VMCom Properties

5- On the Target line, leave a space and type the command line parameters (refer to
Table 8-1).

6- In the Start in field, type the name of the folder in which the VMCom.exe program is to
start up, for example “C:\Program Files\VM600_CMS\Bin”.

7- Click OK to create the desktop shortcut.
8- Double-click the shortcut to start the VMCom process.
To verify the status of the system, or to check for the presence of the services, the Windows
Task List can be used—both the database server process (dbsrv8.exe), and the VMCom
communications handler (VMCom.exe) are listed when they are running. 
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8.3.2 Running VMCom from the VM600 Administrator
To run VMCom.exe directly from the VM600 Administrator:
1- Start the VM600 Administrator program.
2- Expand the VM600 Administrator and Applications icons on the left.
3- Double-click the VM600 Communication Thread item. The Command Line Parameters

window appears:

Figure 8-3 : VMCom Command Line Parameters

4- Specify mandatory and optional startup parameters. Refer to Table 8-1 for details on the
meaning of the command line parameters.

5- Click OK to start the VMCom communications handler.

8.3.3 VMCom Debug options
To use the Debug mode:
1- Tick the Debug mode check box
2- Tick the Create logfiles tick box 

Other options available are: 
• not send the configuration when VMCom is started 
• automatically run the Delete Data from Database utility 10 minutes after the start of

VMCom and every 24 hours after that. 
The latter option keeps the size and content of the database reduced to the number of days
specified.
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8.4 Running the VMCom Communications Handler as a Service
To set up the VMCom communications handler to run as a Windows system service:
1- Start the VM600 Administrator program.
2- Expand the VM600 Administrator and System Tools icons on the left.
3- Double-click the Application Service Setup item. The Setup Service window appears:

Figure 8-4 : The Service Setup Window

4- On the Setup Service window:
a. Enter a name for the Service name, for example “VMCom - Gas Turbine”.

NOTE : The name you specify appears in the list of Windows services. Choose a name that
will be easily identifiable as the VMCom service.

b. Leave the AGCom.exe program selected. This program manages the VMCom
communications handler process.

c. In the Parameters field, enter the startup parameters for the VMCom
communications handler. The VMCom communications handler accepts a number
of command-line options and parameters, with the following syntax:

VMCom.exe -O1 -O2 -O3 ... parameter1; parameter2; parameter3; ...

where O1, O2 and O3 are options and parameter1, parameter2 and parameter3 are
parameters. All options must be prefixed by a dash (“-”), while each parameter must
end with a semi-colon (“;”). Each option and parameter must be separated by at least
one space. 
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Table 8-1 lists the possible command line options and parameters:

Table 8-1 : VMCom Communications Handler Startup Parameters (Part 1 of 2)

Option/Parameter Explanation Comment

Options

-D

Debug mode. Additional troubleshooting 
information is displayed and recorded when the 
VMCom communications handler starts up.
Activating debug mode causes the Windows 
Application Log File to grow rapidly. See 
8.8 - Managing the Application Log File for 
details on how to set a maximum log file size 
(overwriting events as required), or specify a 
period of time that information is to be kept. This 
purging activity is launched by VMCom every 24 
hours, starting 10 minutes after VMCom is 
launched.

NOTE : It is not recommended to implement
Debug mode during “live”
operations—only for test purposes. 

Optional

-N

No download. Configuration data is not 
downloaded to the VM600 rack(s) when the 
VMCom communications handler starts. The 
VMCom communications handler assumes that 
the CMC 16 cards are already configured and 
begins collecting data immediately. 
This option is useful when you want to preserve a 
configuration that is already in the rack’s cards. It 
avoids the approximate 30 second delay that is 
normally required for a normal reset and 
reconfiguration. 
If you add this option, you can still download 
configuration data manually at a later time (see 
9.14 - Downloading the Configuration to the 
Rack), even while the VMCom communications 
handler is still running.

Optional

Parameters

DSN=”myDB”;
The system DSN of the database server with 
which the VMCom communications handler is to 
exchange configuration data.

Mandatory
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NOTE : The DSN=”myDB”; parameter is mandatory. During system pre-commissioning
and testing, it is recommended to also use the –D debugging option to force display
of the console window. However, to avoid accidental interaction of users with the
services, this option should not be used with live installations.

UID=userID;
PWD=password;

The ODBC user ID and password needed to 
connect to the database server. 
If specified, these values override any manually 
entered user ID and password values. If these 
values are not supplied, VMCom uses the 
appropriate entries established elsewhere for the 
ODBC link.

Optional

DELETE=numdays;

This option indirectly limits the size of the 
database by requesting the deletion of all data 
older than numdays. When active, a dedicated 
program starts up automatically 10 minutes after 
the VMCom communications handler, and 
thereafter once daily. This program deletes all 
database data that is older than the specified 
number of days, and truncates the log file.
When used in conjunction with scheduled 
backups defined at the operating system level, 
this parameter allows you to secure data and 
manage database size. However, it must be used 
with care as it can effectively inhibit the collection 
and analysis of valid data. 
The default value is zero, meaning that the 
parameter is not active: the database is free to 
grow in size up to the limits established 
elsewhere (for example, storage intervals).

NOTE : The emptied database is not
compressed, so you might not see a
reduction in file size. However, the
database’s growth rate will slow as the
freed space is reused for new data.

NOTE : Establish a regular backup procedure
to avoid the loss of any potentially
valuable data.

Optional

PORT=portno

This option is used only for a few specific 
installations. Unless requested differently when 
setting up your system, leave the default value 
unchanged.

Table 8-1 : VMCom Communications Handler Startup Parameters (Part 2 of 2)

Option/Parameter Explanation Comment
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5- Click the Account property sheet. Leave the default value Automatic selected to
automatically start the VMCom communications handler at Windows startup time. 

6- Click the Dependence property sheet. To automatically start the VMCom
communications handler whenever the corresponding database server service is
started, select an Adaptive Server Anywhere database server name from the list of
services, for example:

Figure 8-5 : Setting Up Dependencies

7- Click the Service property sheet. 
8- Click Install. The following window is displayed:

Figure 8-6 : Successful Service Creation Message

If an error message appears, refer to Chapter A - Troubleshooting and Frequently Asked
Questions.
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9- The VMCom communications handler starts. If the -D debug command-line option was
specified, the console window shows detailed messages, as shown in Figure 8-7:

Figure 8-7 : The VMCom Console Window

From this console window, you can:
• Click Scroll stop and Scroll to respectively stop and restart the scrolling of text within

the console window.
• Click Shutdown to stop the VMCom communications handler. 
• Minimise the console window to leave the VMCom communications handler service

running. 

A small icon appears in the Windows system tray to indicate that the service is running.
You can double-click this icon at any time to restore the console window.

8.5 Manually Restarting the VMCom Communications Handler
To manually restart the VMCom Communications Handler:
1- Open the Windows Services window. The VM600 Administrator program provides a

shortcut:
a. Start the VM600 Administrator program.

b. Expand the VM600 Administrator and System Tools icons on the left.

c. Double-click the Windows Services item.

2- Scroll down the Name column until you find the VMCom Communications Handler name
you assigned in the Service name field of the Service Setup window (see Figure 8-4).
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3- Double-click on the service name to display its properties: 

Figure 8-8 : Windows Service Properties

To manually start the service, click Start.

The VMCom communications handler icon  appears in the Windows system tray and the
console window appears (see Figure 8-7).
Click OK to return to the services list.

8.6 Stopping the VMCom Communications Handler
The VMCom communications handler can be stopped:
1- From the Windows Services window:

a. Display the Windows Services window

b. Double-click the name of the VMCom communications handler from the list of
services (this was specified when creating the service—refer to 8.3.2 - Running
VMCom from the VM600 Administrator)

c. Click the Stop button

2- From the Windows task list: 
a. Press Ctrl+Alt+Del

b. Click Task List
c. Select the Processes property sheet

d. Select the VMCom.exe task entry

e. Click End Process
3- If it was launched manually, using the Shutdown button on the VMCom communications

handler window.
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Before stopping, the VMCom.exe process must itself stop a number of other background
processes, which takes approximately 10 to 20 seconds to complete. You must wait until the
VMCom.exe entry disappears from the task list before restarting the process, otherwise a
second VMCom.exe process may be launched. This can in turn lead to VM600 hardware
problems as only one process can be associated with an ODBC system DSN at any one time.

8.7 Deleting the VMCom Service
Proceed as follows to delete the VMCom communications handler from the list of Windows
services:
1- Stop the VMCom communications handler as described in 8.6 - Stopping the VMCom

Communications Handler above.
2- Start the VM600 Administrator program.
3- Expand the VM600 and System icons on the left.
4- Double-click the VMCom service setup item.
5- On the Setup Service window:

a. Type the name of the service to be deleted in the Service name, for example
“VM600 VMCom process”. Be sure to enter the name exactly as it appears in the list
of Windows Services (the Name column).

6- Click Remove. If successful, a “DeleteService SUCCESS” message is displayed. 

NOTE : The Error Message “failure: OpenService (0x424)” indicates that the service could
not be deleted. Check the name of the service in the Windows Services window
and try again.

7- On the Windows Services window, click the Refresh button to update the list of
remaining services.

8.8 Managing the Application Log File
In common with other Windows applications, the VMCom communications handler writes
messages to the Windows application log file whenever an event occurs. For example, an
entry is written to the application log file whenever another CMS software application
connects to or disconnects from the VMCom communications handler. When running the
VMCom communications handler in debug mode, the large number of events can cause the
application log file to grow very large. 
To manage the size of the application log file:
1- Select Start > Control Panel > Administrative Tools > Event Viewer and click on

Application Log to display the Windows application log, as shown in Figure 8-9.
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“VMCom” in the Source column identifies the VMCom communications handler as the
source of the event:

Figure 8-9 : Windows Application Log File

2- Right-click on Application in the list of log types on the left and select Properties. The
Application Log Properties window is displayed as shown in Figure 8-10:

Figure 8-10 : The Application Log Properties Window

3- Change the default option Overwrite events older than to Overwrite events as
needed. This means that when the log file exceeds the Maximum log size value, each
new entry automatically causes the older entry to be deleted so that the file cannot
exceed the maximum size. You can also increase the maximum log size value, or
decrease the number of days that events stay in the log file.

4- Click Apply.
5- Click OK to return to the Event Viewer window.
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9 CREATING A RACK CONFIGURATION

9.1 Before Starting the Configuration Editor

9.1.1 Gathering Information about Your System’s Configuration
The Configuration Editor is a graphical tool used to set up the desired configuration of
CMC 16 and IOC 16T cards in VM600 racks.

NOTE : At this stage, it can be helpful to use a configuration sheet (for example, a
spreadsheet) to map out the required channels, signal types and card inputs.

Once the configuration is complete, the Configuration Editor allows you to print out a
computer-generated schematic diagram of the corresponding switch settings required on the
IOC 16T card, which you can use to manually configure the IOC 16T card accordingly.
The Configuration Editor stores interim configuration updates in the database. When the
configuration is ready, you “commit” the complete configuration, which prompts the VMCom
communications handler module to retrieve configuration data from the database and
download it to the VM600 rack. This process is illustrated in Figure 9-1.

VM600 
Communications

 Handler

Configuration 
Editor Database

VM600 Rack

CMC 16 
card

CPU card

Machinery 
equipped with sensors

Downloads configuration 
to the rack

Stores configuration 
in database

"Commits" 
configuration

Configuration Sheet

Front

Rear

IOC 16T card

Tacho/Raw Bus

Retrieves configuration 

Figure 9-1 : The Configuration Editor
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9.1.2 Ensuring VMCom is Running
The Configuration Editor requires that the VMCom communications handler is running to
manage the connection between the CMS Software, the database, and the VM600 rack or
racks. Before starting the Configuration Editor, check that the VMCom communications
handler is running as follows:

1- Verify that a VMCom communications handler icon appears in the Windows system
tray (bottom right corner of the Windows desktop). 
If there is no icon, VMCom may not be running—refer to 8.3 - Running the VMCom
Communications Handler Manually for details on how to start the VMCom
communications handler.

2- If the icon is displayed, click it once. The VMCom console window appears: 

Figure 9-2 : The VMCom Console Window

3- If an error message appears instead, VMCom may be running but incorrectly configured.
Refer to Appendix A - Troubleshooting and Frequently Asked Questions for further
information.

4- Optionally, minimise the console window.

9.2 Starting the Configuration Editor

NOTE : The Configuration Editor can also be launched from within other CMS Software
modules, for example, Mimic. Refer to the respective chapters of this manual for
further details.

To start the configuration editor:
1- Choose Start > Programs > VM600 CMS Software > Configuration Editor
2- Start the VM600 Administrator program, choosing Applications in the structure view on

the left, then double-clicking the Configuration Editor.

Alternatively, double-click the  shortcut on the desktop. The Select ODBC Data Source
window shown in Figure 9-3 appears:
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Figure 9-3 : Select ODBC Data Source Window

9.3 Selecting a Database
When first started, the Configuration Editor displays a list of available databases. Each ODBC

system DSN existing on the local PC is listed next to a database icon . 
To select the database to work with:
1- In the DSN list, choose the ODBC system DSN of the database to work with. The five

most recently used system DSNs are listed. To use a different system DSN, click Other.
2- Type in a valid ODBC User ID (e.g. "DBA") and Password (e.g. "SQL") for the database

and click OK. Optionally, select the Remember the password option. When selected,
the password is stored in the Windows Registry and is displayed automatically when you
next log in to the database.

3- The Configuration Editor reads the current configuration from the selected database and
displays a structured view of the configuration, as shown in Figure 9-4.

Figure 9-4 : Structured View of the Configuration
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The initial view of a database allows you to:
• Browse the current configuration
• Switch between architectural and logical views of the configuration
• Switch to a higher level of privileges
• Display information about the selected database.

NOTE : You cannot create or delete complete databases from within the Configuration
Editor. Utilities are provided to do this; refer to Chapter 7 - Administering
Databases for details.

9.4 System Security

9.4.1 Setting Privilege Levels
The CMS Software supports four different privilege levels to control access to security
aspects of the configuration:
• Read. This is the privilege level with the lowest security level: no password is required

for access. With read privileges, you can only view the current configuration. This is the
default level granted when you first start the Configuration Editor.

• User. User level currently provides the same privileges as Read level, that is, you can
view the current configuration only. 

• Master. Master level users can enable and disable parts of the current configuration and
save database changes. 

• Super. Super level users can modify the current configuration and save any changes. 
User, Master and Super levels can be protected with passwords. You can change the
password for your own privilege level and that for any lower privilege level, but not that for a
higher level. For example, an operator with Master level privilege may change the User and
Master level passwords, but not the Super level password.
Table 9-1 lists, for each privilege level, which functions are authorized for users having the
appropriate privilege level:

Table 9-1 : Privilege Levels

Function
Privilege Level

Read User Master Super

View the current configuration 9 9 9 9

Enable/disable parts of the configuration 9 9

Modify the configuration 9

Write changes to a database (9) 9

Download the configuration to VM600 racks (9) 9
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NOTE : Super user privileges automatically revert to Read privileges after a number of
minutes of inactivity. The number of minutes can be set in the Mimic program
options (see 10.9 - Setting Mimic Options).

The current privilege level is displayed in the bottom left corner of the Configuration Editor
window, as shown in Figure 9-5. 

Figure 9-5 : The Current Privilege Level

9.4.2 Entering Passwords
To enter a password:

1- Click the Password icon on the toolbar, or choose Security from the Tools menu.
The Change Privilege Level window is displayed:

Figure 9-6 : The Change Password Level Window

2- Choose the required level of Privileges: Read, User, Master or Super. Type the
appropriate password and click OK. The default passwords are:

• User level: “user”
• Master level: “master”
• Super level: “super”

NOTE : Passwords are case sensitive, that is, “user”, “User” and “USER” are three different
passwords.

To change the default passwords, see 9.4.3 - Changing Passwords below.
All features that are supported by the privilege level are displayed or activated in the
structured view window. For example, for a super user, COMMIT and CONNECTION buttons
are displayed.

Current privilege level
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9.4.3 Changing Passwords

NOTE : Changing passwords in the Configuration Editor changes the password in all other
CMS Software modules.

To change a password:
1- Choose Tools > Modify Passwords. 
2- Type a valid Super user level password.
3- The Modify Passwords window appears:

Figure 9-7 : The Modify Passwords Window

4- Type the new User Password, Master Password, or Super Password.
5- Type the new password again in the corresponding Confirm field.
6- Click OK. 

9.5 Viewing the Current Configuration
You can view the current configuration in two ways; a logical view and an architectural view. 

9.5.1 The Logical View
The Logical view shows the system hierarchy from the
operator’s perspective, i.e. the structure in terms of: 
• Databases
• Stations
• Machines
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9.5.2 The Architectural View
The architectural view represents the system from a
hardware perspective. It shows the system hierarchy in
terms of: 
• Database
• Racks
• Cards (e.g. CMC 16)
• Channels
• Outputs (e.g. frequency bands)
• Offline points

9.5.3 Switching Views
To switch from the logical view to the architectural view or vice versa:
1- Click Logical View or Architectural View at the bottom of the tree view.

9.6 Creating a New Configuration

9.6.1 Overview
To begin a new configuration:
1- Ensure you have Super user privileges.
2- Switch to the architectural view if it is not already displayed and:

a. Define and configure the VM600 racks, as described in 9.7.1 - Defining a New Rack.

b. Define and configure the cards in each rack, as described in 9.7.4 - Configuring
Cards.

NOTE : The current version of the VM600 CMS Software only supports CMC 16 cards.

c. Define and configure the channels and outputs for each card, as described in
9.7.6 - Configuring Channels.

3- Switch to the logical view (refer to 9.5.3 - Switching Views) and:
a. Define and configure the stations, as described in 9.9.1 - Attributing a Station to a

Database.

b. Attribute each machine to a station, as described in 9.9.2 - Attributing Machines to
a Station.

c. Configure individual machines, as described in 9.9.3 - Configuring Machines.
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4- When the configuration is complete, save the changes to the database and force the new
configuration to be downloaded to the VM600 rack by clicking the Commit button, as
described in 9.14 - Downloading the Configuration to the Rack.

9.6.2 Grouping Similar Outputs Together
For performance reasons relating to the way that the IOC 16 card collects data, it is
recommended to implement the following guidelines 
• Only the first four channels on the card can be configured as Speed (tacho) points. 
• Group signals of the same type (processing parameters) on adjacent channels (relative

vibrations, absolute vibrations, air gap, and so on). For example:

Figure 9-8 : Configuring Speed Channels

• Place all speed channels before any other measuring points (dynamic and analog
points).

• Configure channels from the top downwards (that is, configure the point that appears first
in the list of available points, then configure the second point, and so on).

• Group together channels related in terms of speed, rather than of the same type.
Figure 9-9 shows a typical IOC 16T card configuration:

rather than...
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Figure 9-9 : Grouping Inputs

How to display this graphical image of the IOC 16T card is described in 9.15 - Configuring the
IOC 16T Card.

9.7 Working with the Architectural View
The architectural view allows you to define the VM600 racks used in the VM600 CMS
Software and attribute them to the databases that are to store their measurement data. The
cards used in each rack are then defined, along with the slot position they occupy. Finally,
the inputs and outputs of the individual cards are configured.

9.7.1 Defining a New Rack
You must define one rack object in the Configuration Editor for each physical rack in your
VM600 system. 

Check that you are working with the correct IOC 16T card: refer to Table 2-2
for details.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

Channel
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Speed

Dynamic
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Dynamic
Accel
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Dynamic
Accel
4 VAC
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To define a new rack:
1- Open the database in which the rack’s configuration data is to be stored (see

9.3 - Selecting a Database).
2- Ensure you have Super user privileges.
3- In architectural view, right-click on the top-level database icon and select New Rack, or

select the database and choose New Rack from the Database menu.
4- Type a unique Tag identifier for the rack (up to 16 alphanumeric characters).
5- Optionally, type a description of the rack.
6- Click OK.

7- Click the Save button  on the toolbar.

9.7.2 Configuring a Rack
To configure a rack:
1- Display the Architectural view.
2- Ensure you have Super user privileges.
3- Click on the rack to configure. The current or default properties of the rack are displayed

on the right:

Figure 9-10 : General Properties of a VM600 Rack

4- Optionally, modify the Tag for the rack that you entered when creating the rack. 
5- Optionally, enter a description of the rack’s Physical Location.
6- Select CPU Present and enter the Hostname or TCP/IP Address of the rack’s CPUM

card. The TCP/IP address must match that assigned to the CPUM card when it was first
installed. Refer to the VM600 CMS Hardware Manual for details on how to set and if
necessary modify the TCP/IP address. It may be useful to attach a label to the front of
the rack indicating the card’s TCP/IP address.

7- If the CPUM card is equipped with a second Ethernet card, you can enter the host name
or TCP/IP address of the second card in the second Hostname or TCP/IP Address field.

The Rack Rear Layout box displays the rack slots containing cards. For example, selecting
CPU Present to indicate the presence of a CPUM card automatically shows slots 1 and 2 as
being used. Slots containing CMC 16/IOC 16T cards (see 9.7.3 - Adding Cards to the Rack)
are automatically selected and the slot number occupied appears in blue.
8- Optionally, modify the Description of the rack that you entered when creating the rack.
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9- Click the Save button on the toolbar to store the changes in the database.

NOTE : You are also prompted to save changes whenever you click on another rack.

9.7.3 Adding Cards to the Rack
The next step is to specify the configuration of all CMC 16 cards that are present in the
VM600 rack. 
To add a card to a rack:
1- Ensure you have Super user privileges.
2- In the architectural view, right-click on a rack and choose Add Card to Rack (or select

the rack and choose Add Card to Rack from the File menu).

Figure 9-11 : The New Card Window

3- Select the Slot Number physically occupied by the CMC 16/IOC 16T card pair in the
rack. Enter a number between 3 and 14 inclusive (slots 1 and 2 are reserved for CPUM
cards, while slots 15 and 16 are reserved for RPS 6U rack power supply cards).

4- Optionally, type a Description of the card.
5- Click OK.
The card is added to the architectural view, together with a minimum default definition of
channels and outputs. 

9.7.4 Configuring Cards
To configure a card:
1- Ensure you have Super user privileges.
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2- In the architectural view, select the card to configure. The current or default properties of
the card are displayed on the right:

Figure 9-12 : Configuring a Card

3- Optionally, modify the Slot Number and Description that you entered when creating the
card.

4- Specify whether the card is to be Enabled or Disabled. The configuration data of
disabled cards are stored in the database, but only measurement data from enabled
cards is stored in the database. This can be useful to temporarily inhibit data collection
from slots where the card has been removed.

5- Specify the part numbers (P/N) of the CMC 16 card located in the front of the rack and
the corresponding IOC 16T card located at the rear of the rack. 

6- Expand the card’s icon in the architectural view and configure each of the channels in
the card that are to be used for data collection, as described in 9.7.6 - Configuring
Channels.

7- Optionally, add an orbit display output as described in 9.7.14 - Configuring Orbit
Displays.

8- When you have finished, click the Save button  to store the changes in the database.

NOTE : You are automatically prompted to save changes whenever you click on another
card or rack.

9.7.5 Cloning Cards with Drag and Drop
To quickly copy a card’s configuration when adding a card with an identical or similar
configuration to a new or different VM600 rack:
1- Ensure you have Super user privileges.
2- If necessary, add the new VM600 rack as described in 9.7.1 - Defining a New Rack.
3- In the architectural view, click on the card to copy, hold down the mouse button, drag the

card’s icon over the new rack’s icon, and release the mouse button. 
4- On the New Card window, add an optional description of the card and click OK.
5- Click Yes to confirm adding the card.
6- A message is displayed warning you to check the card’s configuration. Click OK to

continue.
The card’s configuration is copied to the new rack. However, you must complete certain
configuration details specific to the card. For example, copied measurement points must
always be manually attached to a machine.
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9.7.6 Configuring Channels 
To configure a channel:
1- Ensure you have Super user privileges.
2- Switch to the Architectural view.
3- If the channel’s configuration is similar to that of another channel that you have already

configured, consider cloning the channel’s configuration as described in 9.7.13 - Cloning
Configurations.

NOTE : If copying card configurations to a different rack, take particular care to check all
settings in order to receive an error-free configuration. Correctly configured inputs
cannot always be simply copied to another rack—you may have to modify the
configuration manually.

4- Expand the card’s icon in the structure view and click on the channel to configure. The
current or default properties of the channel are displayed on the right:

Figure 9-13 : Configuring a Channel

5- Type a Point Tag to uniquely identify the channel, for example “Speed/Tacho 1”.
6- In the Machine Attached To list, select the machine from which the channel is to collect

measurement data. If no machines are available for selection, switch to the Logical view
and define at least one station and one machine, as described in 9.9.2 - Attributing
Machines to a Station.

7- Select the type of input signal from the Signal Type list on the property sheet on the right:
• Dynamic: A waveform formed by a combination of signals at different frequencies

with different amplitudes. Refer to Configuring Dynamic Channels below.
• Analog: A DC level giving a single value at any one time, for example temperature,

pressure, or flow. Also known as a “process” signal. Refer to Configuring Analog
Channels.

• Digital: A signal that has only two possible states, “on” or “off”. Used to monitor
on/off switches or open/close relays. Refer to Configuring Digital Channels below.

• Speed: An analog signal measuring the velocity of a point, usually in RPM. Also
known as a tacho input. Only channels 1 to 4 of a CMC 16 card can be configured
as speed inputs. Refer to Configuring Speed (Tacho) Channels below.
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Signals can be acquired either internally from adjacent Machinery Protection Cards
(MPC 4) via the VM600 rack’s raw bus or tacho bus, or externally via the screw terminal
connectors on the matching IOC 16T card at the rear of the rack. For details on
configuring the IOC 16T card, refer to 9.15 - Configuring the IOC 16T Card.

8- Configure the parameters associated with the channel as described in the sections that
follow.

9- Click the Save button to store the configuration in the database.

9.7.7 Configuring Dynamic Channels

Figure 9-14 : Configuring a Dynamic Channel

1- Type a unique Point Tag to assign to the channel.
2- In the Machine Attached To list, select the machine from which the channel is to collect

measurement data. If no machines are available for selection, switch to the Logical view
and define at least one station and one machine, as described in 9.9.2 - Attributing
Machines to a Station.

3- In the Sensor Family list, indicate the type of dynamic signal being acquired:
• General (AC). For measurements of “general” signal types with AC components.
• General (AC/DC). For measurements of “general” signal types with a mixture of AC

and DC components. It is possible to dedicate one of the outputs to DC, which can
be used for Line checks or plausibility checks in cases where a DC signal
component is expected.

• General (AC/DC) Air Gap. Similar to the General (AC/DC) type, but with predefined
values that have been set up for correct measurement. It can be considered as a
template for air gap sensors.

• Absolute Vibration (AC). For absolute bearing vibration measurements. This
sensor family provides integration.

• Relative Vibration (AC/DC). For measurements of relative vibration, typically for
proximity probes. AC represents the dynamic relative vibration and the DC
component represents the gap.
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4- Select the Signal Origin. Indicate whether the signal originates from the screw terminal
connectors on the IOC 16T card at the rear of the rack, or from one of the lines of the
VM600 rack’s raw or tacho bus.

5- Set the AC Signal Input Range. Select the conditioning range of the incoming signal. A
range of pre-selected values are available between 100 mV and 20 V. Depending on the
type of Sensor Family selected, the corresponding DC Signal Input Range is displayed. 

6- The Signal Sensitivity is the ratio of the change induced in the output to a change in the
input signal. Specify a non-zero value. Refer to the datasheet or calibration sheet of the
sensor.

7- Choose the collection units for the data in the Sensor Sensitivity Units field below. A
typical signal sensitivity value for a proximity probe transducer, for example, is 7.87 mV
per micron (200 mV per mil).

8- In the Background Sampling Mode field, specify whether order tracking or fixed
frequency is to be used to trigger the time-series data acquisition. Order tracking should
be chosen when accurate phase information is required, and whenever speed-related
frequency components are of interest.

9- Depending on the selected sampling mode, choose the order or fixed frequency
Bandwidth to be logged:

• For Orders (machine speed multiplication factor), choose one of the pre-selected
values between 1.56 orders (range 0 to 1.56 times the running speed of the
machine) and 400 orders.

• For Fixed frequency (maximum frequency in Hertz), choose one of the pre-selected
values between 100 Hz (range 0 to 100 Hz) and 20 kHz.

10- The Speed Reference Channel ID is the speed (tacho) channel from which the
machine’s speed data is derived. If more than one channel is configured, select the
speed channel to use. 

NOTE : Only speed channels on the same CMC 16 card and associated with the same
machine can be selected as the reference speed channel.

11- Sensor Orientation specifies the physical mounting orientation of the input sensor in
degrees. The default value, 90, corresponds to 12 o’clock (TDC, top dead centre), while
270 corresponds to 6 o’clock. The value must be in the range 0 to 360.

12- The DC Measurement Type is used to determine the DC (Gap) value from the vibration
signal. In the case of relative vibration channels, the DC component represents the gap
between the probe tip and the target material (e.g. the shaft). Select:

• Minimum. The minimum value of the vibration signal is used.
• Maximum. The maximum value of the vibration signal is used.
• Mean (the default). The mean average value of the vibration signal is used.

This is only applicable to the Relative Vibration sensor family. 
13- The Sensor Signal Range is used to specify the polarity of the input signal. This can be

used to invert the time waveform data. A positive voltage implies that the minimum DC
gap corresponds to the minimum display value. A negative voltage implies that the
minimum DC (Gap) value corresponds to a maximum display value. 
This is only applicable to the Relative Vibration sensor family. 

14- The DC Offset Display Base is the minimum value of DC (Gap) that it is possible to
display. It is determined by the thickness of the sensors.
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This is only applicable to the Relative Vibration sensor family. 

NOTE : For information on which direction for the offset definition of relative vibration
points, refer to Q. Which direction for the offset definition of relative vibration
points? in Chapter A - Troubleshooting and Frequently Asked Questions.

15- In the “Display Unit = Storage Unit” field, choose the units in which to display the DC
(Gap): microns or mils. Any engineering units with the same unit family as the collection
unit (sensor calibration unit) can be selected. In the case of integration, the appropriate
choice is offered for absolute vibration signals. All data is stored and displayed in the
chosen units.

On the Scheduling property sheet:

Figure 9-15 : The Scheduling Property Sheet

1- Specify the Display Fullscale to be used. This is the maximum value to be displayed for
scheduled datasets. The value is in the currently selected display units.

2- Select and configure the type of data to be collected when operating in Alternative mode
(see 1.3.3 - Alternative Operating Mode). The choices are:

a. None. No waveform data is collected.

b. Spectrum. Store scheduled frequency spectra only. 

c. Waveform. Store scheduled time waveforms only.

d. Spectrum and waveform. Store both scheduled time waveforms and frequency
spectra.

e. Long Waveform. Store long waveform (also known as oscilloscope) data only. This
is useful for the extended capture of time-based data (for example, over several
minutes).

For Spectrum, Waveform, or Spectrum and Waveform data, specify:
• Resolution. Select the number of spectral lines or waveform points to include in the

spectrum.
• Scheduled Sampling Mode. Select “Orders” or “Fixed Frequency” and the

corresponding bandwidth.
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• Number of Revs (when Orders sampling mode is selected). The value is displayed
for information only, and depends on the values of resolution and the bandwidth.

• Sampling Duration (when Fixed Frequency sampling mode is selected). The
calculated sampling duration. The value is displayed for information only, and
depends on the values of resolution and the bandwidth.

• Time Domain Averages. The number of synchronous time-domain samples to be
used to calculate the average time waveform (used to eliminate random data).

The following values apply only to Spectrum data:
• Windowing. The type of windowing function to be applied to the time-domain data.

For Order tracking, a Uniform window is recommended, while for fixed frequency
acquisition, a Hanning window should be applied.

• Frequency Domain Averages. The number of synchronous frequency-domain
samples used to calculate the average frequency spectrum in order to eliminate
random data. 

• Frequency Averaging Type. The method used to calculate the frequency spectrum
using the number of frequency domain averages selected above. The methods
available are Linear (the resultant frequency spectrum is the mean of the value
selected in Frequency Domain Averages), RMS (the resultant frequency spectrum
is the square root of the mean of the value selected in Frequency Domain
Averages), and Peak Hold (the resultant frequency spectrum is the maximum
amplitude at each line from the value selected in the Frequency Domain Averages
field).

On the Adaptive property sheet:

Figure 9-16 : The Adaptive Monitoring Property Sheet

Adaptive Monitoring allows you to set alerts and alarms dynamically, depending on the value
of a chosen speed signal. 

NOTE : Adaptive monitoring requires an accurate and reliable speed measurement.
To set adaptive monitoring parameters accurately, you should consider creating a
trend plot showing the output vibration level against speed, obtained during
run-ups and run-downs. This will help you to define the alarm and alert limits you
want to configure.
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Configure adaptive monitoring as follows: 
1- Select a reference point in the Reference Point list.
2- In the Adaptive Zones area of the window, choose Enabled and select the speed

channel that is to serve as the reference point.
3- The first “From” value is always the Minimum Tracked Speed value for the selected

speed channel. The last “To” value is always the Signal Dynamic value for the selected
channel. Between these two values, you can define up to 14 different tracking zones. The
default values are calculated to create 14 zones of equal size. You can overtype these
defaults with custom “To” values to define customized tracking zones. The “From” values
are automatically re-calculated accordingly.
To define fewer than the maximum 14 zones, type the Signal Dynamic value in any of
the “To” boxes, then click in any other “To” zone. For example, to define 7 zones:

To re-display the default values for all zones, click Initialize Zones.
4- In the Output Select list, choose the output band to be used for adaptive monitoring. 
5- In the Adaptive Limits area of the window, choose Enabled to activate dynamic High

Alert and High Alarm limits.
6- The default High Alert and High Alarm values are the High Alert Amplitude and High

Alarm Amplitude values for the selected output band. Enter any custom values you
wish for any particular zone. The graphic at the top of the window is continuously updated
to display the values of alarms and alerts that you set:

Figure 9-17 : Alert and Alarm Levels

To re-display the default values for all zones, click Initialize Alarms.

Set “To” values 
manually

Maximum signal 
dynamic value 

Maximum value 
copied automatically 
to unused zones

Minimum 
tracked 
speed

High Alarm (Red)High Alert (Yellow)

Zones Signal DynamicMinimum Tracked Speed



CMS Software Manual (Volume 1) MACMS-SW/E 9 - 19
Edition 10 - Jul 26/07

Working with the Architectural View
CREATING A RACK CONFIGURATION

Click on the Show Details button to display a graphic curve of the current Adaptive
Monitoring configuration, for example:

Figure 9-18 : A Typical Adaptive Monitoring Graph

When configuring dynamic channels:
• All dynamic points on the same machine must obtain their speed reference from a speed

channel on the same machine. If you have more than 15 dynamic points configured, you
must pass the speed signal to the other card or cards, for example, using the tacho bus.
This speed reference is required even if you set the machine to “fixed speed” in the
logical view.

• At least one dynamic point is required on each card, in order to trigger and synchronize
data acquisition for offline points or analog points. This dynamic point provides offline
points or analog points with a time reference (timestamp). If you do not have a dynamic
point to measure, this requirement can be met by simply defining a “dummy” point that is
not associated with any dynamic signal coming from the card:

9.7.8 Configuring Analog Channels

Figure 9-19 : Configuring an Analog Channel
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To configure an analog channel:
1- Specify the analog Sensor Family, for example “Thermocouple (E-Type)”. 
2- In the Signal Origin field, specify whether the signal originates from the screw terminal

connectors on the IOC 16T card at the rear of the rack, or from one of the lines of the
VM600 rack’s raw or tacho bus.

3- For standard analog inputs, specify collection units as the Sensor Sensitivity Units from
the list of available unit types, and specify the maximum and minimum values that are to
be captured. 

4- For thermocouple inputs, choose whether the thermocouple is Compensated or
Uncompensated.

5- For Display Units, choose either degrees Fahrenheit or degrees Celsius. The
equivalent Maximum Value and Minimum Value in the chosen display/storage units are
automatically displayed and updated.

On the Limits property sheet, configure the alarm types and events, as described in
Configuring Alarms below.

NOTE : Since µm is not included in the drop down list, it can be entered manually as a
user-defined unit. Press and hold the 'Alt'-key on your keyboard followed by the
number 230. Once the ‘Alt’-key is released, a symbol µ appears in the string field.
If the using the numbers on the keyboard does not create this symbol, then use the
numbers on the keypad.

9.7.9 Configuring Digital Channels

Figure 9-20 : Configuring a Digital Channel

To configure a digital channel:
1- In the Signal Origin field, specify whether the signal originates from the screw terminal

connectors on the IOC 16T card at the rear of the rack, or from one of the bus lines of
the VM600 rack’s raw or tacho bus.

2- For thermocouple inputs, the Sensor Sensitivity Units, Signal Base and Signal
Dynamic values are preset and cannot be modified. 

On the Limits property sheet, configure the alarm types and events, as described in
Configuring Alarms below.
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9.7.10 Configuring Speed (Tacho) Channels

Figure 9-21 : Configuring a Speed (Tacho) Channel

To configure a speed channel, proceed as follows:
1- Type a unique Point Tag for the channel, for example “Speed 1”.
2- In the Machine Attached To list, select the machine to which the channel is connected.
3- In the Signal Origin field, choose whether the signal originates from the screw terminal

connectors on the IOC 16T card at the rear of the rack, or one of the rack’s eight tacho
bus lines.

4- In the Signal Dynamic field, enter the maximum speed (in RPM) to be tracked. The
maximum value is limited to 32000 by the hardware.

5- In the Edge of Detection field, choose either Negative Edge (falling edge) or Positive
Edge (rising edge).

6- Specify the physical Sensor Orientation of the speed sensor, in degrees. The default is
zero.

7- Specify the minimum tracked speed, in RPM. The minimum value possible is 15.

NOTE : It is recommended to not set this value lower than necessary, otherwise data
acquisition may become relatively slow due to the longer time period required for
tacho detection. 60 or 120 should be a suitable value for power generation
machinery running at 3000 RPM or higher.

8- In Tacho Ratio, enter the tacho ratio. If the input source has a gearbox and the tacho
frequency is to be measured on the input shaft, enter the calculated gear ratio between
the input and output shafts. Otherwise, leave the default value of 1. The maximum value
is 128.

9- Optionally, enter a description of the sensor.
On the Limits property sheet, configure the alarm types and events, as described in
Configuring Alarms below.
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9.7.11 Configuring Alarms

Figure 9-22 : Configuring Alarm Limits

On the Limits property sheet of most channel types, you can configure the values necessary
to trigger events. These events can in turn be used to display alarms on Mimic displays or in
graphs and plots:
1- Optionally, click Initialize Alarms. This sets the three “high” values to the maximum

allowed value of the channel specified on the Setup property sheet, and the three “low”
values to the minimum allowed value of the channel. The graphical representation of the
alarm values on the right of the window is updated accordingly. 

2- Specify High Validation, High Alert and High Alarm values for the channel. The values
must be between zero and the Signal Dynamic value set on the Setup property sheet.
The units used are those specified on the Setup property sheet for the respective
channel type, for example, Volts or Degrees Celsius.

3- Specify Low Validation, Low Alert and Low Alarm values for the channel. The values
must be between zero and the Signal Dynamic value set on the Setup property sheet.

4- Optionally, specify a Hysteresis value. Also called “deadband”, hysteresis is that portion
of a signal where a change in input does not produce a corresponding change in output.
Hysteresis can be used to eliminate spurious events caused by the current value
dropping frequently below then rising above the alarm level, generating multiple events.
Enter a value in the currently selected engineering units.

5- Specify the Alarm Priority. Alarm priority can be None, Low or High. Refer to Table 1-1
in Chapter 1 - Introduction for details.
The schematic plot shows the event generation behaviour will react based on the
currently selected parameters.

Refer to 1.2.5 - Limits and Alarm Priorities for details on these values. 

9.7.12 Configuring Frequency Bands
The VM600 CMS Software allows you to specify up to 10 frequency bands for each dynamic
channel to enable the collection, analysis and display of dynamic data. 
Each frequency band (also often referred to as spectral bands or frequency components) can
be set up to look at one line or a range of lines on the frequency spectrum. The start and end
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frequencies of the band can be defined either in terms of multiples of the machine speed
(RPM), or as an absolute frequency value (Hertz).
Each band can indicate RMS, true RMS, peak, peak-to-peak, true peak, true peak-to-peak,
DC (Gap), Smax, or band peak. Acceleration (g), velocity (in/sec, mm/sec) and displacement
(mil, micron) signals are also available and can be converted for display to any standard. 
You can set up events for frequency bands so that measurement data is stored in the
database only if the change of value exceeds a pre-defined threshold. Values can also be
averaged for smoothing or noise reduction while another process is used to calculate
long-term averages.

Figure 9-23 : Configuring Frequency Bands for Dynamic Channels

To configure a frequency band for a channel:
1- Switch to the Architectural view.
2- Expand the channel icon in the structure view and click on the output to configure. The

current or default properties of the output are displayed on the right.
3- If the output’s configuration is similar to that of another output that you have already

configured, consider cloning the configuration, as described in 9.7.13 - Cloning
Configurations.

4- Output Name. Enter a name for the output (1 to 8 alphanumeric characters). For
example, “1X”, or “OVR”. Names must be unique on the channel to which they belong,
but the same names can be used for other channels of the same card. 

5- Output Type. Choose whether the output is time domain-based (that is, shows a
frequency amplitude vs. time graph) or FFT-based (when discrete frequency
components are calculated from sampled time data). 

6- Output Enable. Select Yes to enable this output, or No to disable the output.
7- Output Definition (FFT-based outputs only). Whether the output is to be defined in

terms of Orders (the frequency band start and end positions are specified in terms of



9 - 24 CMS Software Manual (Volume 1) MACMS-SW/E
Edition 10 - Jul 26/07

Working with the Architectural View
CREATING A RACK CONFIGURATION

machine speed multiplication factors), or Hz (the band start and end positions are
specified in Hertz).

8- Sensor Sensitivity Units, Display Units are the units chosen for the vibration channel,
and cannot be modified here.

9- Speed Reference Channel ID (FFT-based outputs only) is the speed channel selected
for use with the vibration channel, and cannot be modified here.

10- Display Fullscale. The maximum value which is to be displayed for the output.
11- Display Mode. The type of data to be displayed for the band. If the Output Type is

FFT-based, the following options are available:
• Peak. Uses the band energy value as the band peak signal value, where the band

energy is:

Band_energy = 

where y is the peak amplitude at each frequency line in the band.

• Peak-Peak. Uses (2 x Band_energy) as the band peak-to-peak signal value (see
above for band energy definition).

• RMS. Uses (Band_energy ÷ ) as the band peak-to-peak signal value (see above
for band energy definition)

• Band Peak. Uses the peak amplitude value within the frequency band.
If the selected Output Type is Time-Domain based, the following options are available:

• True RMS. The arithmetic RMS of the amplitude:

Arithmetic_RMS = 

where y is the value of each sample of the time domain.

• True Peak-Peak. The peak-to-peak amplitude value of the time waveform data.
• True Peak. The peak-to-peak amplitude value of the time waveform data divided by

two.
• DC (Gap). The negative DC output signal of a proximity probe, which indicates the

physical gap distance.
• Smax. This value can only be derived from a speed-driven machine. The value is

based on the synchronously acquired time-series data of two associated channels.
Choose the second channel to be used to derive the Smax value from the
Associated Channel list. It is sufficient to define the Smax output on just one of the
two participating time domain based vibration channels. Defining it twice loads the
system with unnecessary processing and stores redundant information. 

12- Band Start (FFT-based outputs only). The lower limit of the spectral band in Orders or
Hertz, depending on the value selected in the Output Definition field. 

13- Band End (FFT-based outputs only). The upper limit of the spectral band in Orders or
Hertz, depending on the value selected in the Output Definition field. Set the value to
exactly the same value as the Band Start field to select a single frequency or harmonic.

14- Invert Band (FFT-based outputs only).
15- Specify High Validation Amplitude, High Alert Amplitude and High Alarm Amplitude

values for the channel. The values must be between zero and the Display Fullscale
value. The units used are those specified for the channel, for example, Volts or Degrees
Celsius.

16- Specify Low Validation Amplitude, Low Alert Amplitude and Low Alarm Amplitude
values for the channel. The values must be between zero and the Display Fullscale

Σy2
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value. The units used are those specified for the channel, for example, Volts or Degrees
Celsius.

17- Optionally, specify a Hysteresis value. Also called “deadband”, hysteresis is that portion
of a signal where a change in input does not produce a corresponding change in output.
It can be used to eliminate spurious events caused by the current value dropping
frequently below then rising above the alarm level, generating multiple events.

18- Specify the Alarm Priority. Alarm priority can be None, Low or High. See 1.2.5 - Limits
and Alarm Priorities.

To automatically initialise default alarm values, click Initialize Alarms. This sets the three
High event values equal to the Signal Dynamic value, and the three Low event values to zero.

9.7.13 Cloning Configurations

NOTE : You must have Super user privileges to clone configurations.

If you have a number of similar configurations, you can often save a lot of time by “cloning”,
that is, using one object’s configuration as a template which is then copied to other similar
objects. You can then change the values of any parameters that are different between the
two configurations. 
Cloning can be used to copy machines, channels and outputs. 

NOTE : You can also copy card configurations using a slightly different drag and drop
technique. See 9.7.5 - Cloning Cards with Drag and Drop.

Cloning an object uses the same concept as the Windows clipboard. For example, to create
a clone of a machine configuration:
1- Create and configure the machine that is to serve as the template configuration for other

machines attributed to the same station.
2- Right-click the machine name and choose Copy. 
3- Create a second machine. 
4- Right-click on the second machine and choose Paste. The value of all configuration

fields are copied from the source machine definition to this target machine.
5- Change any fields to represent the differences between the two machines. One field that

must be changed, for example, is the Tag, or unique machine identifier. It is also
recommended to change the Description tag. Modify the value of these and any other
fields to reflect differences between the machines, then click the Save button .

You can also copy and paste channels and card configurations. While most configuration
settings are copied, you must specify certain items of required information manually. For
example, a newly created point is not automatically attached to a machine, so it cannot retain
the speed reference from the original point. Also, dynamic points that are copied lose their
Adaptive Monitoring information, since the adaptive reference must be attached to the same
machine as the dynamic point. You must also specify a new name for the copied point. 
Therefore, check the configuration of a copied point carefully, especially if you have copied
to a different card or even a different rack. 
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9.7.14 Configuring Orbit Displays
An orbit display is a special type of synchronous time-domain data obtained from an X- and
Y-probe and therefore measured on two different input channels. Both sets of data are stored
in the database, allowing an orbit display to be generated.
To set up an orbit display:
1- Ensure you have Super user privileges.
2- In the architectural view, select the CMC 16 card to which the two inputs are attached.
3- Right-click on the card and choose Add Orbit, or choose Add Orbit from the Edit menu.

The Orbit setup window is displayed:

Figure 9-24 : Setting Up an Orbit Display

4- Type a unique Tag Name for the orbit display.
5- Specify whether the orbit display is to be Enabled or Disabled. The configurations of

disabled orbit are stored in the database, but measurement data is only collected from
enabled orbits.

6- Specify the channels to the used as the X-Channel and the Y-Channel. The relevant
parameters of the channels chosen appear in the two areas on the right.

7- In order for a meaningful orbit display to be obtained, the two selected channels must
have the following constraints in common:

• The same channel cannot be selected as both X-Channel and Y-Channel.
• Both channels must be defined as Dynamic channels
• Both channels must have the same Sensor Family
• Both channels must have the same Collection Units
• Both channels must have the same Storage Units
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• Both channels must not have integration defined
• Both channels must have the same Speed Reference
• Both channels must be attached to the same machine
• The two channels must have different Sensor Orientations. The difference in probe

angles is not, however, restricted to 90 degrees.
• Both channels must have the background sampling mode “Orders” and the same

bandwidth.
Any constraints which do not match are shown in yellow. Modify the configuration of one
of the selected channels until no constraints are shown in yellow.

8- The Sense of Machine Rotation shows whether the machine being measured is
rotating in a clockwise or counter clockwise (anti-clockwise) direction.

9- For the Historic and Transient Shaft Centerline graphs, the sensor's cold gap and the
bearing's clearance diameter need to be defined. The "cold gap" represents a y-offset
from the zero position, typically acquired when the machine is offline or on turning-gear.
The Bearing Clearance Diameter should be entered, so the outside circle can be drawn
(centred on the x-axis, with the origin y value being half the bearing clearance diameter).

10- Optionally, enter a Description of the orbit.

9.7.15 Channel with Signal Integration Has No Time Domain Output 
If you configure an input channel with integration (single or double) in the Configuration
Editor, the CMC 16 card prepares a single integrated spectrum from which the
post-processing outputs are extracted. Time-domain based band extraction can only be used
when the channel is not integrated:

9.8 Working with Offline Data
Offline data is data stored in the CMS Software database that does not originate from VM600
racks, but from devices or third-party systems connected to the CMS Software. 
Currently, several types of offline data, including Dynamic Data Exchange (DDE), OLE for
Process Control (OPC), Modbus programmable controllers, keyboard-originated and
ODBC-managed data can be imported in this way. 

Figure 9-25 : Signal Integration and Time Domain Extraction
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The number of points per machine is limited to 250. Once more than 250 offline points are
attached to a machine, they will not be stored in the database. However, this is unlikely to be
restrictive in existing installations since this limitation is per machine. 

9.8.1 Adding and Configuring Offline Points
You must use the Configuration Editor to configure the database to be used to store data
originating from keyboard offline points. 
To define and configure an offline point:
1- Start the Configuration Editor and open the target database.

2- Click the access privileges icon and enter a valid Super user password.

3- In the architectural view, select the Offline Systems icon .

4- Right-click and choose the offline point type to add:
• Keyboard-entered points
• Calculated points
• DDE points 
• Modbus points
• ODBC points

These points are created using optional modules of CMS Software, which are described in
the VM600 Condition Monitoring System (CMS) User Manual, Volume 2.
5- Right-click on the offline points group icon that appears in the architectural view and

choose either Add Offline Digital Point or Add Offline Analog Point. Offline data can
be of two types:

• “Digital” or binary data. This type of data can only have two possible values: “0”
(zero) or “1” (one). 

• “Analog” data. This type of data can have any integer or floating point value, for
example “3.14159”.

6- Click on the analog or digital point icon that appears in the
architectural view. 

7- In the properties area of the window, type a unique Point Tag for the offline point.
8- Select the machine to which the sensor is attached.
9- Optionally, enter a Point Description of the offline point.
10- For analog points, select the collection unit for the offline point and configure limits on the

Limits property sheet.

NOTE : When setting up any type of Offline Points do not forget to add the validation limits. 

11- Repeat steps 4 through 10 to add other offline points.

12- Click the Save icon to save the changes.
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To review the status of all offline points of a particular type, click the offline server type’s icon
in the explorer view. For example:

Figure 9-26 : Modbus Offline Points

9.8.2 Duplicating Offline Points
There are two methods of quickly duplicating the configurations of offline points:
• Use the copy and paste procedure described in 9.7.13 - Cloning Configurations to clone

an existing offline point.
• Right-click on the Offline server icon to which the point to be duplicate is attached and

choose Duplicate Offline Digital Point or Duplicate Offline Analog Point. A new point
is created of the same type and with the same configuration as an existing point of the
same type. The Machine attached to field in the copied point is empty. In order to make
the point fully operational, you must attach this point to a machine.

9.8.3 Next Steps
The above description prepares the database for receiving and processing data from offline
points, and displays these points in the configuration tree. It also creates the appropriate data
structures in which the offline data is stored. The processes to “fill” these data structures with
data, however, are separate programs, which are listed in the Data Import/Export section of
the VM600 Administrator program.

NOTE : Whenever you add offline points to the configuration, the database must be
updated ready to receive the offline data. This update is performed either:

- Automatically, the next time that the VMCom communications handler is
launched to establish communications with the VM600 rack.

- Manually, by running the Create Missing Measurement Tables utility described in
7.6.6 - Updating Measurement Tables.

The next step is to set up and configure the link between the source of the offline data and
the database. This is achieved using separate configuration utilities, described in VM600
Condition Monitoring System (CMS) User Manual, Volume 2.
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9.9 Configuring the Logical View
The Logical view is a representation of the machines from which measurement data is
collected. Individual machines can be grouped together into stations, which are in turn
attached to individual databases. The connection between logical and architectural views is
made by defining which channels or points on the VM600 racks are physically connected to
which machines.

9.9.1 Attributing a Station to a Database

NOTE : You must have Super user privileges to modify the configuration of a machine.

To attribute a station (that is, a group of machines) to a database, select the database name
in the logical configuration tree, then either:
• Select New Station from the Database menu.
• Right-click and choose New Station from the pop-up menu that appears.
When the New Station window appears, type a name for the station in the Tag field. This
name must be unique, that is, two or more stations cannot have the same name within the
same database.
Optionally, type some descriptive text into the Description field, for example “Monitoring
station in main machine room”.

9.9.2 Attributing Machines to a Station
One or more machines can be logically associated with each station. 
To attribute a machine to a station:
1- Right-click the Station icon and choose Add Machine to Station.
2- On the New Machine window that appears, type the Tag to assign to the machine. This

name, which must be unique within the station, is used to identify the machine on other
configuration windows. 

3- Optionally, type a Description of the station, for example “Gas Turbine Number 1”.
4- Click OK.
5- Configure the new machine, as described in 9.9.3 - Configuring Machines.
Repeat for all other machines to be defined.
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9.9.3 Configuring Machines

NOTE : You must have Super user privileges to modify the configuration of a machine.

To configure a machine:
1- Switch to the Logical view.
2- Click on the machine to configure. The current or default properties of the machine are

displayed on the right:

Figure 9-27 : Configuring a Machine

NOTE : If the machine’s configuration is similar to that of another machine that you have
already configured, consider cloning the machine’s configuration as described in
9.7.13 - Cloning Configurations.

3- Configure the following parameters on the Setup property sheet for this machine:
a. Modify the unique Tag as required.

b. Specify whether the machine is Speed Driven or Fixed Speed. In either case, enter
the Nominal Speed in RPM, which corresponds to the “running normally on load”
state of the machine.

c. Enter the text label that will be printed at the top of plots to denote the Top Dead
Centre (TDC) for this machine’s bearing. For example, “TDC”.

d. Specify whether the machine rotates in a clockwise only, anti-clockwise (counter
clockwise) only, or both directions.

e. From the list of available points, select those that are attached to this machine.
Speed points become available for selection as the reference speed point for
transient data collected from this machine (see item 4 below).

f. Select a speed channel from the list of attached points and click Set Selected
Channel as Speed Reference. 
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Configure the following parameters on the Logging property sheet for this machine.
Logging settings may vary greatly, depending on the type and purpose of the machine,
its nominal speed, the number of measured points in the system, the rate of growth of
the database and the amount of disk space allowed for the database. The values shown
in Figure 9-28 are typical for a test bed machine with a nominal speed of 24000 RPM.

Figure 9-28 : Logging Properties

In the Background Mode area of the window, specify parameters to determine the spacing
of data points on trend curves generated with data from this machine. Specify the normal and
alarm storage intervals (in hours, minutes and seconds), analog resolution (as a percentage),
and compression ratio to be used. Refer to 1.6 - Trending for details.
You can also specify the Averaging Interval. By default, the CMS Software generates
average values for data. These values can be displayed within the Data Analyser module, for
example, as the average trend. This parameter sets the time frame for generation of those
values. It cannot be switched off—you can ignore this value if you do not need to display
averaged data.
In the Alternative Mode (Scheduled) area of the window, specify the time interval at which
to gather data sets when running . You can specify different time intervals for
spectrum/waveform and orbit data acquisitions. Refer to 1.3.3 - Alternative Operating Mode
for details.
Specify the time and/or speed interval at which to gather data when the CMS Software is
running in transient operating mode. Refer to 1.3.2 - Transient Operating Mode for details.
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The Transient Mode portion of the window is used to set the transient trend data collection
rate:

Figure 9-29 : Configuring Transient Mode

Although the CMC 16 card is rated with a minimum storage interval of 200 ms
(configuration of a single speed signal for all similarly configured channels on the card at
a sampling bandwidth greater than 2.5 kHz), you cannot display this data against time
with the CMS Software. Within the database, timestamp intervals are limited to a full
second, so you would have to store up to 5 points with the same timestamp. You can,
however, plot the transient trend against the speed (also stored in every measured point)
to obtain a full picture of your curve.
A collection rate of less than 1 second can only be achieved using a relatively tight speed
setting. 
In the Trend Interval box, specify a minimum storage interval for transient mode. When
the CMS Software detects the machine entering transient mode, it takes a trend setting
when the specified storage interval is passed. Data is also stored in the database if the
change in speed exceeds the specified value before the time interval is passed. 
In the example shown above, this means that a sample will be taken every 5 seconds. If
the speed increases by 30 RPM before the 5 seconds have expired, data acquisition is
effected at that moment (plus the time until the card is ready to accept the data: the
minimum storage interval).
Both mechanisms can be disabled. Set a Speed (RPM) value of 0 to regularly acquire
data every x seconds, minutes or hours regardless of changes in machine speed (once
transient mode is detected). Set a Trend Interval value of 0 hours, 0 minutes and
0 seconds to acquire data in transient mode whenever the change in speed exceeds the
configured value.
For slow-adjusting machines, set a longer trend interval (for example, 30 to 60 minutes).
See also Appendix A - Troubleshooting and Frequently Asked Questions for further tips
on how to set the Trend Interval value.

4- Configure the following parameters on the Transient property sheet for this machine:
a. Select the speed channel to be used as the reference speed channel to be used for

this machine. The speed channels available for selection are those attached to this
machine on the Setup property sheet (see item 3 above). Refer to 1.4 - Machine
States for more information.

b. Specify values for the transient duration (in minutes, the default is 0), and the RPM
at which overspeed, lowspeed, and lowspeed cutoff triggers are activated. Refer to
1.4 - Machine States for more information.

The transient duration is defined on a machines logical view transient page. This feature
determines the time period in which the systems after having detected a transient stays in
transient mode (i.e. the sampling rate specified on the machines logical view logging page).
However, once returned to nominal speed, the transient is not detected. shows an example
of historical trends
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Figure 9-30 : Preview of Transient Page

Figure 9-31 : Example of Historical Transients

5- Use the Notepad facility to add any optional comments about this machine. 

6- When you have finished, click the Save button to write any changes to the database.

NOTE : You are automatically prompted to save changes whenever you click on another
machine.

7- Download the configuration to the VM600 racks, as described in 9.14 - Downloading the
Configuration to the Rack.
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9.9.4 Disabling and Enabling Machines
Machine configurations can be temporarily disabled then re-enabled when necessary. 
To disable or enable a machine:
1- Right-click on the machine in the logical view.
2- Select Enable/Disable Selected Machine.
Disabled machines appear crossed out in the logical view. Re-enabling a configuration
returns the machine’s icon to its normal state.

9.10 Minimum Rack Configuration
A newly-created configuration must contain a minimum number of items before it can be
downloaded to a rack:
• In the architectural view:

• One VM600 rack
• One CMC 16 card
• One point configured on one channel

• In the logical view:
• One station
• One machine 
• One attached point.

9.11 Performing Consistency Checks
The Configuration Editor performs a series of consistency checks both automatically
(whenever you open a database or change privilege levels), or manually. 
You can save and print the results of the consistency checks.
The consistency checks check the complex settings and dependencies for measuring points
and their relations in architectural and logical view evolution of requirements and
relationships in the database may lead to inconsistent data 
The consistency checks test for three types of errors:
•   Integrity Checks. These are automatically corrected by CMS Software.
•   Manual Update Required Checks. You must correct these errors.
•   Field Checks, which require corrective measures.
To manually perform consistency checks:
1- Select the top-level database in either Logical or Architectural view.
2- Choose Consistency Checks from the Database menu.
3- Choose either Performs Checks to launch the checks manually, or View Previous

Results to display the results of the previous tests (whether performed automatically or
manually).
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Figure 9-32 shows the results of consistency checks:

Figure 9-32 : Consistency Checks

You can print the results, or save the results to a file into HTML format.

If the consistency checks include recommended changes, the icon on the toolbar is
activated. Click this icon to automatically apply the recommended changes. 
For example:

Figure 9-33 : Updates Recommended by Consistency Checks

After clicking the update button , the window changes to:

Figure 9-34 : Updates Recommended by Consistency Checks

9.12 Dumping Database Data to File
You can request the Configuration Editor to save an image of the database’s current
configuration into a comma-separated value (CSV) format file.
This database image helps Vibro-Meter support personnel to view the current configuration
of a system. In addition, a printout of the database image can service as official
documentation of a VM600 system’s configuration, for example, for internal audit purposes.
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This database image is smaller in size and easier to produce than a snapshot copy of the
database.
To create a database image:
1- Choose Dump to File from the Database menu.
2- Specify the name and location of the image file (.csv) to be generated.
3- Click Save.
Figure 9-35 shows a portion of a database image file, opened as an Excel spreadsheet:

Figure 9-35 : A Database Image File

9.13 Displaying a Database Summary
You can also request the Configuration Editor to save an image of the database’s current
configuration in an HTML format file.
This image helps Vibro-Meter support personnel to view the current configuration of a
system. In addition, a printout of the database image can service as official documentation of
a VM600 system’s configuration, for example, for internal audit purposes.
This database image is smaller in size and easier to produce than a snapshot copy of the
database.
To create a database summary:

1- Click the  icon on the Configuration Editor’s toolbar.

2- Specify the name and location of the image file (.html) to be generated.
3- Click Save.
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Figure 9-36 shows an example:

Figure 9-36 : A Database Summary File

9.14 Downloading the Configuration to the Rack
When you have configured all stations, machines, racks, cards, and channels, you can initiate
downloading of the configuration to the appropriate racks and cards.
By default, the configuration is automatically downloaded to all racks and all cards whenever
the VMCom communications module is started. Refer to Chapter 8 - Setting Up the VMCom
Communications Handler for details. If the VMCom communications module is already
running (for example, as a Windows system service), you can manually initiate the
downloading process from within the Configuration Editor module.
To download the configuration:

1- Select the top-level database icon  in the Logical or Architectural view.

2- Obtain Super user privileges.
3- Test that a connection exists to the VMCom communications module:

a. Select the Communication Info property sheet. 

b. Click the Connection icon  on the toolbar. If a valid connection exists, the
following message is displayed in the console area:

where Example_Gas_Turbine is the system DSN of the database and
Example_Gas_Turbine is also the system DSN of the database server.

c. If any other message appears, refer to Appendix A - Troubleshooting and
Frequently Asked Questions.
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d. Click the Commit icon  on the toolbar to begin downloading the rack
configuration. If the configuration is successfully downloaded, the following
message is displayed in the console area:

If any other message appears, refer to Appendix A - Troubleshooting and Frequent-
ly Asked Questions.

9.15 Configuring the IOC 16T Card
In a VM600 rack, CMC 16 and IOC 16T cards must always be installed together, as a pair.
The IOC 16T card must be installed in the slot directly behind the CMC 16 card in the VM600
rack.
In order for data signals from measuring equipment to be displayed correctly in the CMS
Software, the IOC 16T card configuration must match exactly the CMC 16 card configuration
as defined with the Configuration Editor module. Once the configuration of the CMC 16 has
been downloaded to the card, you must therefore ensure that the IOC 16T card’s hardware
configuration matches the software configuration.
The IOC 16T card contains a number of user-configurable switches, each corresponding to
a signal coming either from one of the card’s rear connectors, or the VM600 rack’s raw or
tacho bus. When a switch is set to the ON position, the signal coming from the rear connector
is blocked. When a switch is set to the OFF position, the signal coming from the rear
connector is enabled and passed to the CMC 16 card.
Refer to the VM600 Condition Monitoring System (CMS) Hardware Manual for full details.

9.15.1 Printing the Schematic Diagram
To help you set the switches on the IOC 16T card correctly, the Configuration Editor provides
a computer-generated schematic diagram of a IOC 16T card showing the switch positions
needed to match the current software configuration. You can use this schematic diagram to
help you configure the IOC 16T card.
To view and print the schematic diagram:
1- Switch to the architectural view.
2- Select the rack containing the CMC 16 card.
3- Select the IOC Jumper Matrix property sheet.
4- Right-click on the image and choose Print. 
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Figure 9-37 below shows an example of a schematic diagram.

Figure 9-37 : Schematic Diagram of an IOC 16T Card

Parts currently
disabled 

Parts not yet 
configured in 
Configuration Editor 

Switches that are 
configurable 
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9.15.2 Configuring the IOC 16T Card

To configure the jumper switches on the IOC 16T card:
1- Remove the IOC 16T card from the VM600 rack.
2- Using the printout of the schematic diagram, identify each jumper switch block on the

card in turn and check that the jumpers and rotary switches are in the same position as
on the printed schematic diagram. For example:

Figure 9-38 : Checking Switch Settings on a Real Card and the Schematic Diagram

NOTE : On a real card, rotary switches resemble either  (10 positions) or  (5 positions)

3- Whenever necessary, change the jumper or rotary switch setting on the card to match
the setting shown in the schematic diagram. In the above example, the switches in switch
block 15 would need to be changed as follows:

Refer to the VM 600 Condition Monitoring System (CMS) Hardware Manual
for the procedures to use to safely remove cards from and install cards into
a VM600 rack.

The jumpers and switches on an IOC 16T card are very sensitive. Always
used a small screwdriver or suitable configuration tool to change jumper or
rotary switch positions. Incorrect switch settings or imprecise rotary
switch settings can cause missing or incorrect measurement data to be
stored in the database.

Channel 15,
Switch 3 (SW3)

IOC 16T (shown for
P/N 200-565-000-012)
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a. Rotate the rotary switch 1 (SW1) to the fully vertical position.

b. Move the raised part of switch 2 (SW2) to the right (ON position)

c. Move the raised part of switch 3 (SW3) to the right (ON position)

d. Move the bottom part of switch 7 (SW7) to the left (OFF position) 

For the meaning of the switch positions, refer to the VM600 Condition Monitoring System
(CMS) Hardware Manual.

4- To perform an additional check that the jumpers are set correctly, you can display a list
of the required switch settings. On the IOC Jumper Matrix property sheet, right-click on
the image to display a contextual menu and choose Jumper Information. The following
window is displayed:

Figure 9-39 : Jumper Summary

5- Reinstall the IOC 16T in the rack when all switch settings have been set correctly.

NOTE : There is no need to remove the CMC 16 card from the rack as part of the
reconfiguration procedure.
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10 USING THE MIMIC MODULE

10.1 Introduction
Mimic is a graphical application that provides the operator with a customized view of the
machinery being monitored by the VM600 CMS Software system. 
The types of data you can view in Mimic include historic and transient data, “live” data coming
directly from one or more VM600 racks, and data from “offline” systems. 
To view the data, you create one or more Mimic documents. Mimic documents can contain a
variety of predefined objects, such as a Value Indicator or an embedded Excel spreadsheet,
which display data in a graphical format.
Mimic is also a “portal” providing one-click access to other CMS Software modules, as shown
in Figure 10-1 below: 

Mimic

Data 
Analyser

Configuration 
Editor Database

Browser

Event
Viewer

Figure 10-1 : Interrelating CMS Software Modules
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10.2 Before Using Mimic
Before using Mimic, you must:
1- Set up and configure a database. This involves:

• Creating at least one database.
• Configuring an ODBC system DSN and user account to access the database.
• Creating and setting up a database server for the database and setting it up to run

automatically. 
See Chapter 7 - Administering Databases for details.

NOTE : If Mimic is unable to establish a connection to a database when starting up, you will
not be able to view any measurement data from the database. However, you can
still edit previously created Mimic documents.

2- Optionally, start the VMCom communications handler. If VMCom is running, you will be
able to display “live” measurement data in your Mimic documents. Otherwise, you can
only display measurement data that has previously been stored in the database.

3- See Chapter 8 - Setting Up the VMCom Communications Handler for details.
4- Use the Configuration Editor to define the initial machine, rack and card configuration

and store this configuration in the database.
See Chapter 9 - Creating a Rack Configuration for details.

10.3 Starting Mimic
You can start Mimic by either:
• Choosing Start > Programs > VM600 CMS Software > Mimic
• Starting the VM600 Administrator program, choosing Applications in the structure view

on the left, then double-clicking Mimic.

10.4 Selecting a Database (Mimic)
When you start Mimic, depending on the options chosen in the VM600 Administrator, Mimic
starts directly on the previously used database or the Select ODBC Data Source window
opens. Refer to Chapter 6.6 - Administrator Options for further details.
If you have previously created a default Mimic document for the database, the Mimic main
window is displayed. Otherwise, you are prompted to either browse for a Mimic document to
open, or to open Mimic with no loaded document (refer to 10.9.1 - Specifying a Default Mimic
Document for further information): 

Figure 10-2 : No Default Document

Choose Yes to display a list of Mimic documents stored in the selected database. You can
then select a Mimic document to be displayed initially.
Choose No to open Mimic with no documents. 
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10.5 The Mimic Main Window
When started, the Mimic main window and default document are displayed. An example is
shown in Figure 10-3:

Figure 10-3 : The Mimic Main Window with Default Document

The Mimic main window is made up of:
• At the top, the icon bar.
• To the left, logical and links views of the current configuration stored in the database. See

Logical and Links Views on page 10-4 below for details.
• In the middle, the mimic document.
• To the right, the currently loaded Mimic document.
• At the bottom, the status bar. 

Baseline 
Control

Band 
Selector

Linked 
Objects 
Button
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10.5.0.1 The Icon Bar

The icon bar contains icons providing one-click access to other VM600 modules as well as
security settings and online help:

Figure 10-4 : The Icon Bar

10.5.0.2 Logical and Links Views 

During the configuration process, a mapping between the Logical and the Links Views is
performed, by simply attaching measurement channels of the hardware (the “Links View”) to
machines (the “Logical View”). All data processing, data storage, and data management for
viewing and analysis is based on the logical view.

10.5.0.2.1 The Links View

Launch the Configuration
Editor, Data Analyser,
Database Browser, or CMS
Event Viewer programs

Close all open Mimic
objects and documents,
as well as any programs
launched from within
Mimic

Access 
other user 

levels 

Edit the current
Mimic document
(only for master
and super users)

Display 
Online Help

Reset timers for
all machines

Display the
Logical/Links
View

Go to previous,
next or original
views

The Links view shows graphically how the
Mimic documents associated with a
database are interrelated, and allows you to
easily navigate through them. 
The Links view is created automatically
during system configuration, or by linking
graphical objects in one Mimic document to
another document. 
You can create any number of Mimic
documents and structure them as you wish.
One document is defined as “default”
document, displayed at the top of the Links
view structure and which appears by default
whenever Mimic is started. Below the default
document, the Links view can contain any
number of sub-documents, accessible by
clicking on links defined in higher-level Mimic
documents.
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10.5.0.3 The Logical View

10.5.0.4 The Document Window

The right-hand side of the main window displays the current Mimic document. When first
started, Mimic loads a default Mimic document if one has been defined. Provided the VMCom
communications handler is running, the value and status indicators contained in the Mimic
document show “live” measurement data values coming from the VM600 rack. Otherwise,
the most recently stored values in the database are displayed. 
From CMS version 2.2 upwards, the Baseline Feature (Figure 10-3) enables users to switch
between current values, those stored in the database and the difference between them
(delta). The baseline switch button indicates which is currently displayed. The Band Selector
(Figure 10-3) allows users to switch the display between the different configured bands of the
value indicators. The Linked Objects Button allows users to navigate between different Mimic
screens (for example, go to offline points).
To change the appearance of the Mimic document, or load a different document, you must
enter a special Edit mode. This is described in 10.8 - The Mimic Document Editor.

The Logical view shows the VM600 system
hierarchy from an operator’s perspective, that
is, the structure in terms of:
• Stations
• Machines
• Points
• Outputs
By double-clicking on an item in the Logical
view, or right-clicking and choosing a menu
entry, you can display real-time graphs of the
data originating from any part of the structure
(see 10.6 - Displaying Graphs), or launch the
Configuration Editor to modify the system
configuration.
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10.5.0.5 The Status Bar

The status bar, along the bottom edge of the Mimic main window, contains up-to-date
indications of the Mimic module’s status:

If a user presses and holds ‘Ctrl’ and ‘Shift’ whilst over the VMCom Online Area, and then
clicks the left mouse button, the connection can be verified (Figure 10-6)

10.6 Displaying Graphs
From the logical view of the Mimic window, you can display measurement data graphically
and list events associated with any selected output.
You can also use a favorites window to display the data from several outputs on the same
graph.

10.6.0.1 Single Point or Output Graphs

To display a graph for a single point or output:
1- In the logical view, select the point or output for which to display data.
2- Right-click and select the type of graph to display. The list of available graphs is

contextual, for example, for a Speed (tacho) point, Realtime Trend and Bar Graph are
available.
Alternatively, double-click to display the Favorites window. See Figure 10-8.
To display a list of events associated with the selected output, choose Events. The Event
Viewer is launched (see Chapter 13 - Using the CMS Event Viewer).

ODBC system DSN of the
current database

VMCom Online Area: Indicates 
whether the VMCom 
communications handler is 
online (Green) or offline (Gray).

The current privilege level.
Click to display the Change
Privilege Level window.

Indicates whether Alerts have not been
acknowledged (Green), Alarms have not
been acknowledged, (Red), or all events
have been acknowledged (grey). Click to
display the VM600 Event Viewer.

Figure 10-5 : The Status Bar

Figure 10-6 : Verification of the Connection
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The Graph Viewer is launched to display the appropriate graph type, for example:

Figure 10-7 : A Realtime Trend Graph for a Speed Point

10.6.0.2 Several Points or Outputs Graphs

To display the output from several points or outputs on the same graph:
1- In the logical view, double-click the machine or station to which the points or outputs are

attached.
2- The Favorites window is displayed:

Figure 10-8 : The Favorites Window

3- Select the values to display.
4- Choose the form of data to display from the list of Available Graphs.
5- Click Display.

NOTE : If a value is crossed out in the Favorites window (for example ), the point or
output cannot be represented in the selected graph type. For example, the values
from a digital output cannot be displayed in oscilloscope (Long Waveform) form.
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10.7 Security
In common with other VM600 modules, Mimic defines four different security levels to control
access to potentially sensitive features of the application.
When you first start Mimic, for example, you are granted read-only access. This means that
you can view live measurement data in Mimic documents, but you cannot make any changes
to the documents. By contrast, Super user level allows you to modify any aspects of a Mimic
document and save the changes you make to the database.

NOTE : Passwords are case sensitive, that is, “user”, “User”, and “USER” are three
different passwords.

The current user level is displayed in the status bar of Mimic (see Figure 10-5).

10.7.1 Default Passwords

10.7.1.1 Read Access

There is no Read password: this is the default access level and no password is required.
The default User password is “user”.
The default Master user password is “master”.
The default Super user password is “super”.

10.7.2 Privilege Levels
Table 10-1 lists, for each privilege level, which Mimic functions are authorized for users
having the appropriate privilege level:

NOTE : When launching other CMS Software modules from within Mimic, the current Mimic
privilege level is “inherited” by the other module. For example, if you have Super
level privileges in Mimic and launch the Data Analyser (see Figure 10-4), Super
level privileges are available while using the Data Analyser. The Configuration
Editor is a special case: since only one user can modify configurations at any one
time, Super level privileges may be refused if they have already been granted to
another user. In this case, User level privileges are granted instead.

Table 10-1 : Privilege Levels

Function
Privilege Level

Read User Master Super

View current configuration 9 9 9 9

Edit and save Mimic documents 9 9

Delete Mimic documents 9

Access Mimic subdocuments 1

1. Access to Mimic subdocuments can also be configured using macros. Refer to Using Macros in
the General Properties Window on page 10-20.

1 1 1
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10.7.3 Entering Passwords
To enter a password:

1- Click the password button on the Mimic icon bar, or choose Tools > Security.

2- The Change Privilege Level window is displayed:

Figure 10-9 : The Change Privilege Level Window

3- Choose the required level of Privileges: Read, User, Master or Super.
4- Type the corresponding Password and click OK.
All features that are supported by the privilege level are displayed or activated.

10.7.4 Modifying Passwords
Passwords are stored in the database. You can use the Configuration Editor to modify the
passwords for any of the privilege levels. Refer to Chapter 9 - Creating a Rack Configuration.

10.8 The Mimic Document Editor
To create, edit or save Mimic documents or to modify Mimic options, you must enter Edit
mode. When you have finished modifying the Mimic document, you switch back to Run mode
to view the document as it appears to end users, for example, operators in the machine room.

10.8.1 Switching between Run and Edit Modes
When you first start Mimic, Mimic documents are displayed in Run mode, that is, they display
measurement data but the format of the Mimic documents themselves cannot be modified.
To create new Mimic documents or modify existing ones, you must enter a special Edit mode. 
To exit Run mode and enter Edit mode:
1- Ensure you have Super user privileges (refer to 10.7 - Security).

2- Click the Switch Edit/Run mode icon on the Mimic icon bar to enter Edit mode.

When in Edit mode, the following icon bars appear at the top of the Mimic window:

Figure 10-10 : The Edit Mode Icon Bar

To learn about the function of icons on the icon mode, use the bubble help that appears when
you place the mouse over an icon.
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You can drag and drop an icon bar to a new position, for example, to change the order in
which the icon bars appear or to rearrange the icons on 3 or 4 rows.
To exit Edit mode and enter Run mode:

1- Click the Switch Edit/Run mode icon  on the Mimic icon bar to return to Run mode.

When in Run mode, the icon bar returns to that shown in Figure 10-4.

10.9 Setting Mimic Options
You can set a number of options in Mimic. For example, you can choose whether to start
Mimic in fullscreen mode or not.
To set Mimic options:
1- Ensure you have super user privileges (refer to 10.7 - Security).

2- Click the Switch Edit/Run mode icon on the Mimic icon bar to enter Edit mode.

3- Choose Tools > Options. The Program Options window is displayed:

Figure 10-11 : The Program Options Window

4- Set the following options as required:
• Initially Fullscreen. Select this checkbox to maximise the main window when

starting Mimic.
• No Close for Read user. Select this checkbox to prevent users with Read privileges

from closing Mimic. 
• Pass double-clicks for ActiveX in Running Mode. When selected,

double-clicking on an ActiveX object in Run mode launches the application linked to
the object. Otherwise, when not selected, double-clicks are ignored. For example, if
this option is selected and you insert a Microsoft Word document in a Mimic
document as an ActiveX object (see ActiveX Objects on page 10-17),
double-clicking the icon in Run mode launches Microsoft Word and displays the
document.
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• Program Settings. Select Same for all users to apply all options to all users. Select
Custom for each user to restore the program options selected by individual users,
based on their Windows user ID and password.

• File Locations. Specify the folders in which to store CMS Software executable
programs and tree views.

• Update current values every. Specify the frequency in seconds with which current
values are updated.

• Show values as valid for maximum of. Specify the number of seconds for which
values are shown as being valid. This is used with timer objects to set the number
of seconds that timers are active for.

• Revert to Read Privileges after. Specify the number of minutes of inactivity before
Super user privileges are automatically reset to Read level privileges. 

• Hide Favorites window after. Specify the number of seconds that the Favorites
window (see Figure 10-8) remains open before being closed automatically.

• Close Windows opened from Mimic after. Specify the number of minutes after
which any window opened from within Mimic, for example, the CMS Event viewer or
Data Analyser windows, are closed automatically.

• Close windows opened Mimic on exit. Select this option to specify that all
windows opened from within Mimic are automatically closed when you close the
Mimic window. This includes all Mimic documents and other CMS programs.

5- Click OK to set the options and return to the main Mimic window.
Any changed options are applied the next time you start Mimic.

10.9.1 Specifying a Default Mimic Document 
You can create any number of Mimic documents. Mimic documents are stored in the part of
the database that is reserved for configuration data. 
One Mimic document can be designated as the “default” Mimic document. This is the
document that is loaded automatically whenever Mimic is started. If you do not designate a
default document, Mimic prompts you for the Mimic document to load when started.
To specify the default Mimic document:
1- Obtain super user privileges. See 10.7.2 - Privilege Levels.

2- Click the Switch Edit/Run mode icon on the Mimic icon bar to enter Edit mode.

3- Load the Mimic document you want to set as the default document.
4- Choose File > Set as default.

10.9.2 Working with Objects
Mimic documents are composed of one or more objects, for example, images, value,
multi-value and status indicators, bar charts, geometrical shapes, or text boxes. 
When you create a new Mimic document, it is empty. You build up the contents of the
document by adding objects to it. For value indicators, you associate outputs with the object
by dragging nodes from the Logical View window of Mimic onto the object. This automatically
creates an association between the database and the object.

10.9.2.1 Creating New Objects

To add a new object to the document:
1- Click in the Mimic document to activate the icon bars.
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2- Click an icon on the object icon bar (or use the menus) to select the type of object to
create, for example:

3- Move the mouse into the document area. The mouse cursor changes shape, depending
on the type of object selected.

4- “Draw” the object on the document window by clicking and holding down the left mouse
button, dragging until the object is the required size, then releasing the mouse button:

5- For value and status indicators, associate a measurement point displayed in the logical
view window (see 10.5 - The Mimic Main Window) with the object by dragging the
measurement point from the logical view and dropping it on the object.

6- Finally, set the properties of the object, for example, the style of bar graph to be displayed
or the border width of a box, by double-clicking on the object, or right-clicking and
selecting Properties. See 10.9.6 - Setting Object Properties for more details.

10.9.2.2 Cloning Objects

You can also create a new object by “cloning” an existing one. To do this, either:
• Copy and paste the object
• Hold down the ‘Ctrl’ key, click the object to be cloned, drag the mouse to a new location,

then release the ‘Ctrl’ key and mouse button.

NOTE : The cloned object appears exactly on top of the original object. Move it immediately
to its new destination to avoid confusion.

Once cloned, you can modify the object’s properties as required.

10.9.3 The Objects Palette
Objects are grouped together on the Objects palette available in Edit mode:

10.9.3.1 The Selection Pointer

To select any of the objects in a Mimic document, click the Selection pointer icon first, then
click on the object. You can then resize the object, modify its properties, or apply one of the
tools on the Tools palette (see below).

10.9.3.2 Geometrical Objects

Geometrical objects allow you to draw static objects in a Mimic document, for example to
draw borders around a value indicator, or to visually group together several objects.
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You can draw (from left to right): 
• Straight lines. Click and hold down the left mouse button to select the start point of the

line, move the mouse and release the mouse button to select the end point. Double-click
the line (or select the line, right-click and choose Properties) to set the line’s properties.
For example, you can display the line as a solid or dashed line, or with an arrow at one
end.

• Rectangles. Click and hold down the left mouse button, move the mouse to the
diagonally opposite corner of the rectangle, and click again. 

• Rectangles with rounded corners. As above, but draws a rectangle with rounded corners.
To adjust the shape of the rectangle:

a. Move the mouse over the handle half-way down the right-hand side of the rectangle
until the mouse pointer changes to a 4-headed arrow . 

b. Click and hold down the left mouse button.

c. Move the button towards the centre of the rectangle. 

d. Release the mouse button when the shape is as required.

• Ellipses. Click and hold down the left mouse button, move the mouse to the diagonally
opposite point on the ellipse, and release the mouse button. 

• Polygons. Click the left mouse button to select the start point, move the mouse and click
again to select the next vertex of the polygon. Repeat to draw more vertices, then
double-click to complete the polygon.

10.9.3.3 Value Indicators  

Value indicators show the realtime value of dynamic measurement data associated with a
predefined point or output on a VM600 rack. For example:

A value indicator can be associated with any speed (tacho), analog, digital, and thermocouple
input channel by dragging the channel’s icon from the database’s logical view onto the value
indicator.
By modifying the properties of a value indicator, you can choose to display a simple numerical
value indicator, a combined bar graph and numerical value indicator (as in the above
example), or other formats. Users can also switch between displaying the phase and the
amplitude and displaying live, baseline or delta values.
Value indicators can also display information about the alarm levels defined for any given
channel. You can display alarm levels either as a color-coded axis of a bar graph or by
color-coding the numerical value itself.
When in Run mode, the frequency with which the value indicator is refreshed depends on the
overall load on the system, for example, the number of channels that have been defined and
are receiving live data.
For more detailed examples on the use of Value indicators as two-state indicators, see
10.12 - Configuring Two-State Indicators
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10.9.3.4 Minimum/Maximum Value Indicators

Minimum/Maximum Value indicators allow you to select multiple input channels and display
the maximum, minimum, or average of the values.
For more details on Minimum/Maximum Value indicators, refer to 10.10 - Configuring
Min/Max Indicators.

10.9.3.5 Status Indicators

Status indicators provide a realtime indication of the number and type of alarm raised by any
of the machines or stations being monitored by the system.
A status indicator provides a quick overview of the number of outputs in alarm, alert, and
validation status (Figure 10-12).

Figure 10-12 : Status Indicator

NOTE : As alarm events are acknowledged, they are no longer counted in the Status
Indicator’s total. However, the output itself remains in alarm status.

Total number of
outputs currently
in alarm status

Total number of outputs
currently in alert status

Total number of
outputs in normal
status

Total number of
disabled outputs

Total number of
speed faults

Total number of
outputs currently
outside defined
validation levels
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10.9.3.6 Machine Status 

A Machine Status indicator allows you to display the current status of a machine, for example:

Figure 10-13 : Machine Status Indicator

The indicator displays the current speed value for a selected machine. 
The following buttons on the Mimic toolbar relate to timers:

 Click the Reset Timers button to restart all timers that have not yet expired. 

 Click the Start Timers button to restart all expired timers.

10.9.3.7 Band Control

Band control objects display a menu from which you can choose a selected output to display.
See 10.11 - Using Band Control Indicators.

10.9.3.8 Update Timer

Timer objects allow you to associate a timer with a machine. Timers are used to visually
indicate the amount of time elapsed since measurement data was last updated: when the
timer expires, the timer object changes color. You can choose to display timers as digital
values, pie charts, or bar charts.
A timer object displays the amount of time that has elapsed since the selected measurement
data was last updated. The maximum value of a counter is given by the Show values as
valid for maximum of Mimic option (see 10.9 - Setting Mimic Options). For example, if this
value is set to 60 seconds, the timer starts at 60 seconds and expires when it reaches zero. 

10.9.3.9 Baseline Control 

The Baseline feature allows users to take a snapshot of data when the machine is in good
condition (e.g. after commissioning). These data can then be used as a global reference.
Degradation and sudden changes in vibration pattern observed at a later time can then be

Machine is stopped (i.e. the
speed is below the low speed

cutoff)

Machine is in run-up/run-down (i.e.
the speed is between the low

speed cutoff and the low speed
trigger)

Machine is running-on-load 
(i.e. the speed is between the 
low speed trigger and 
overspeed trigger)

Machine is in overspeed 
(i.e. the speed is above the 
overspeed trigger)
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compared to this baseline. There is one baseline timestamp per logical machine. The Trend
Baseline is applicable to trend data. Once a trend baseline timestamp has been saved, the
baseline control switch allows users to switch between: i) live data, ii) the latest values saved
on or just before the timestamp and iii) the difference between i and ii (delta).
Figure 10-14 is an example where no baseline has ever been set for a machine. This display
can be accessed using a right mouse click. Using this menu, the baseline can be set (new or
update) and the display can be switched between Live Data, Baseline or Delta.

Figure 10-14 : Baseline Control

Further information on baseline control, refer to 10.13- Configuring Baseline Controls.

10.9.3.10 Text Objects

Text objects display a static string of text in a font and with font size that you define. 
Text objects can also contain links to other Mimic documents, so that when the operator clicks
on the text object, the other Mimic document is displayed in its place.

10.9.3.11 Pictures

Insert a picture object to place an image in a Mimic document. 
When you insert the object, Mimic prompts you to choose the image file to insert. You can
choose images in BMP, JPEG, GIF, or ICO format.

NOTE : You can also define an image as the background image of a Mimic document. See
10.9.8 - Setting a Background Image for details.
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10.9.3.12 Symbol Factory 

Displays the Symbol Factory window:

Figure 10-15 : The Symbol Factory Window

The Symbol Factory is a library of over 4,000 graphics relating to industrial automation,
including pumps, pipes, valves, tanks, mixers, motors, ducts, electrical symbols, flow meters,
material handling, sensors, PLCs, transmitters, and ISA symbols. 
If you installed CMS Software using the “DEMO” license number, only a demonstration
version of the Symbol Factory is available. This version has the following limitations:
• Only the first symbol in each category can be included in Mimic documents or exported

to other formats.
• You cannot create your own categories of symbols
• You cannot import symbols from other sources.
When you install the CMS Software using a full license, none of these restrictions apply.
To insert a symbol in a Mimic document:
1- Select the category of symbol to include in your Mimic document.
2- Select the symbol to use and click Copy.
3- Select your Mimic document and paste the symbol (Edit > Paste)
4- Select the symbol and resize it as necessary.

NOTE : The Symbol Factory is not available on CMS installations in DEMO-mode

10.9.3.13 ActiveX Objects

Inserts an ActiveX object into your Mimic document. You can then open and edit the linked
document in Run mode by double-clicking on the object. Examples of ActiveX objects include
word processing documents, spreadsheets and slide presentations, but the list of available
ActiveX object types depends on which ActiveX-compatible applications are installed on the
local PC.
You can choose to insert either an icon or a part of the document itself.
If the “Pass double-clicks for ActiveX in Running Mode” program option is selected (see
10.9 - Setting Mimic Options), switching to Run mode and double-clicking the ActiveX object
launches the linked program. 
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When you double-click the object, in either Edit or Run mode, Mimic’s menus may be
replaced by those of the program linked to the object. For example, Microsoft Word menus
may appear on the Mimic toolbar. This behaviour, however, varies from program to program.

10.9.4 The Tools Palette
The Tools palette is a separate icon bar available in Edit mode:

Figure 10-16 : The Tools Palette

The Tools palette contains icons to transform selected objects in a number of ways, as
summarized in Table 10-2.

Table 10-2 : Tools Palette Description

Icon Title Description

Bring to Front For objects that overlap, move the selected object to the front

Move to Back For objects that overlap, move the selected object to the back

Move Forwards For objects that overlap, move the selected object forward one 
layer

Move 
Backwards

For objects that overlap, move the selected object backwards 
one layer

Flip Horizontally Flip the object horizontally

Flip Vertically Flip the object vertically

Fill Color Fill the selected object with a selected color

Line Color Set the border of the selected object to a selected color

Change Font Modify the text properties (font and font size) of a selected text 
object

Group Group several selected objects together

Ungroup Separate previously grouped objects

Save Group to 
File Save a group of objects to file

Load Group 
from File Load a previously saved group of objects from file
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10.9.5 Keyboard Shortcuts
You can use the following keyboard shortcuts in Mimic documents.

Table 10-3 : Keyboard Shortcuts  

Key Description

Alt+Enter Edit selected object's properties

- Move object backward one level

= or + Move object forward one level

_ (underscore) or Ctrl+- Send object to back

+ or Ctrl-+ Bring object to front

E or e Draw an ellipse

L or l Draw a line

N or n Draw a rounded rectangle

R or r Draw a rectangle

S or s Select

Ctrl+S Save file

Ctrl+O Open a file

Ctrl+P Print

Ctrl+A Select All

Ctrl+C or Ctrl+Ins Copy

Ctrl+V or Shift+Ins Paste

Ctrl+X or Shift+Del Cut

Ctrl+Z or Alt+BkSp Undo

Del Clear

Esc Cancel edit

F5 Refresh

F6 Next active pane

Shift+F6 Previous active pane

Ctrl+← Align with left edge

Ctrl+↓ Align with bottom

Ctrl+→ Align with right edge

Ctrl+↑ Align with top edge
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10.9.6 Setting Object Properties
An object’s properties determine its physical appearance when in Run mode, and for dynamic
objects, the source of the data that it displays. 
To set an object’s properties, double-click the object, right-click on the object and choose
Properties, or select the object and press Alt+Enter.

10.9.6.1 Setting General Properties

Each object type has a different Properties window, for example, for a Value Indicator:

Figure 10-17 : A Properties Window

The format of the General property sheet is different for each object type. In general,
however, the left-hand side of the window contains settings that determine the appearance
of the object when you switch to Run mode, while the right-hand side of the window allows
you to define links to other Mimic documents and specify the format of the data. 

10.9.6.2 Using Macros in the General Properties Window

You can type the following macro names in the Object connection field of the General
property sheet to display the corresponding value automatically when in Run mode. This is
described in 10.14.2 - Creating Links to Other Mimic Documents:

NOTE : There must be no space between the macro name and the command-line options.
File paths that contain spaces must be enclosed in quotes (“ ”). 

[CMD]commandline Treat the command line text following the macro name as 
a Windows command.

[SUPER]mimic_doc_name Only display the specified Mimic document if the user 
currently has Super user privileges.

[MASTER]mimic_doc_name Only display the specified Mimic document if the user 
currently has Master or Super user privileges.

[USER]mimic_doc_name Only display the specified Mimic document if the user 
currently has User, Master or Super user privileges.
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For example, to launch a realtime waveform plot on a point with Point=26, using the DSN
“myDB”, enter the following string into the Object Connection field”:
[CMD]“C:\Program Files\VM600_CMS\Bin\RealWave.exe” DSN=”myDB”; POINT=26;
If the user does not have the required privileges, the link is not activated and no visual
indication that the object is linked to a Mimic sub-document is given.
To display several points on the same plot, use the following syntax:
... POINT=26 29 50 62

Notice that there must be a single space between the point numbers.
To display the data as a bar graph instead:
1- Replace “RealWave.exe” by “Bargraph.exe” 
2- Specify both the point identifier and output band identifier, separated by a period (“.”) for

each point on the bar graph. For example:
[CMD]”C:\Program Files\VM600_CMS\Bin\Bargraph.exe” DSN=”myDB”;

POINT=26.0 26.1 29.1;

10.9.6.3 Setting Data Properties

For all objects capable of displaying data (e.g. value indicators), a Data property page
contains properties that determine the source and format of the data to be displayed by the
object (Figure 10-18). 

Figure 10-18 : The Data Property Sheet for a Value Indicator

As the Configuration Editor attributes a Unit to each online point, the Digital Points are also
given the Unit Volt. Displaying this point in the Mimic as a Value indicator then also shows V
as unit unless you untick the Units box on the Data thumb tab of the Value indicator's
Properties.
The Value Output Format dialog box (Figure 10-19) is opened by clicking “Format” in the
Value Indicator Properties dialog box. This allows users to change the settings of a value or
min/max indicator. The output can be preset to be switchable (from the band control) or to
always display Amplitude or Phase values. The Value type can be chosen between Float
(most common) exponential or Integer display. In the case of integer display, the decimal
places button becomes disabled. Ticking the Evaluate Expression Box allows users to
display results calculated from configured data value (Figure 10-20).
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Figure 10-19 : Value Output Format

Figure 10-20 : Expression Builder

On clicking “Font” in the Value Indicator Properties dialog box (Figure 10-18), the Font dialog
box appears (Figure 10-21). This can be used to change the font of the displayed text.
Figure 10-22 shows an example of changing the display font from lime to fuchsia.

Figure 10-21 : Changing the Font
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Figure 10-22 : Example of Changing the Display Font from Lime to Fuchsia

10.9.6.4 Using Macros on the Data Property Sheet

You can type the following macro names in the Caption or Units fields of the Data property
sheets of Value and MultiValue indicators to display the corresponding value automatically
when in Run mode:

[POINT_NAME]
Display the name of the point associated with the object. 
For example, if you drag a point named “Speed” and drop it 
onto a Value Indicator, “Speed” is displayed as the caption.

[OUTPUT_NAME]

Display the name of the output channel associated with the 
object. For example, if you drag a point named “Channel 1” 
and drop it onto a Value Indicator, “Channel 1” is displayed 
as the caption.

[DB_UNITS]

Display the measurement units used by the associated 
point or output. The value is extracted from the database. 
For example, if you drag an absolute vibration point and 
drop it onto a Value Indicator, “mm/sec” may be displayed 
as the caption (assuming this is the value of the Display 
Unit field for this output in the Configuration Editor).

[RECT_FUN]

For dynamic points, display the name of the rectifier 
function assigned to the point or output in the Configuration 
Editor, that is, one of the following:
• Peak
• Peak-to-Peak
• RMS
• True Peak
• True Peak-Peak
• True RMS
• DC (Gap)
• Smax

Refer to the Configuration Editor online help for details. 
Rectifier functions are explained in 1.2.3 - Rectifiers:
Time-Domain Based Outputs vs FFT-Based Outputs.

[AMPL_PH]

Displays either “Amplitude” or “Phase”, depending on the 
displayed value type (switch in band control). This 
continues displaying in degrees or value when the indicator 
is configured accordingly.
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The following window shows an output in Run mode and the corresponding macros:

Click Help for detailed information on setting the properties.

10.9.7 Creating and Managing Groups of Objects
You can group objects together so that they become a single logical unit. This has a number
of advantages:
1- You can move, copy, and delete the group as if it were a single object.
2- You can save the object group to disk. Object groups can then be inserted into other

Mimic documents.
To create an object group:
1- Select the objects to group together. If the objects are positioned close to each other, the

easiest way to do this is to drag the mouse over the objects. Otherwise, you can select
individual objects by holding down the Shift key and clicking on each object in turn.

2- Click the Group icon  on the tools palette, or choose Format > Group.

To ungroup objects:
1- Select an object that belongs to a group.

2- Click the Ungroup icon on the tools palette, or choose Format > Ungroup.

To save an object group to disk:
1- Select the object group by selecting an object that belongs to the group.

2- Click the Save to Group icon  on the tools palette, or choose Format > Save
Group.

3- Browse to a folder and select a file name for the object group. Object groups are saved
with a *.gr extension.

To insert a previously saved object group into a Mimic document:
1- Ensure no objects are selected in the Mimic document.

2- Click the Insert Group icon  on the tools palette, or choose Format > Save Group.

3- Browse and choose the Group file (*.gr) that contains the object group and click Open.

[POINT_NAME]

[OUTPUT_NAME]

[DB_UNITS] 

[RECT_FUN] 

Caption field

Units field

Data field
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10.9.8 Setting a Background Image
To set a background image for a Mimic document:

1- Insert a picture object in a Mimic document.

2- Resize the image to cover the entire area of the Mimic document.

3- Click the Move to Back icon  on the Tools palette to move the image to the
background.

10.10 Configuring Min/Max Indicators
To configure a Min/Max indicator to display the minimum, maximum, or average value of a
number of outputs:
1- Create a Min/Max Indicator object (as described in 10.9.2 - Working with Objects) and

display its Properties window.
2- Select the Data property page.
3- Click Browse to display the MultiValue Indicator Properties window:

Figure 10-23 : The MultiValue Indicator Properties Window

4- In the Available Values list, double-click on the outputs to be used. The outputs are
added to the Selected Values list.

5- Optionally, configure the Caption and Measurement Units to use for the display. You
can use any of the macros described in Using Macros in the General Properties Window
on page 10-20.

6- Optionally, choose a Mimic document to use to display the result.
7- Optionally, create an expression to be applied to the result. 
8- In the Show list, choose whether to display the Maximum, Minimum, or Average value.
9- Click OK twice.
10- Switch to Run mode. The control displays the appropriate value. By default, the control’s

caption displays the name of the output that is generating the displayed value. No caption
is displayed if the average value is being displayed.
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10.11 Using Band Control Indicators
To configure a band control indicator:
1- Insert value indicators (see 10.9.2 - Working with Objects) to be selected by the band

control object into the current Mimic document. To do this, you can either:
• Create a value indicator for each frequency band configured for a dynamic channel,

then drag and drop a single frequency band output from the Logical view on to the
respective value indicator, 

• Insert a single value indicator, then drag and drop the dynamic channel in which the
frequency bands are defined onto the object. In this case, the value indicator’s title
shows the name of the channel followed by “-Common”, for example:

Figure 10-24 : Value Indicator

NOTE : The same principle applies when choosing between always displaying amplitude
or phase in 2 separate value indicators, or keeping the display switchable.

2- Insert a Band Control object  into the document.

3- Switch to Run mode. Click OK to save the changes you have made.
4- Click on the Band Control object. A menu appears, showing the labels of all frequency

bands configured in the current database, for example:

Figure 10-25 : Frequency Bands Available for a Band Control Object

5- From this menu, you can choose to:
• Switch between displaying Phase and Amplitude for all value indicators in the

current document configured as 'switchable'. Those configured as Phase-Indicators
always display Degrees and the Amplitude-Indicators always displays Amplitude.

• Choose a frequency band label from the list. In this case, the selected frequency
band is displayed in all value indicator objects configured as “common” dynamic
channel outputs. 
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For example:

Figure 10-26 : Band Control Selection

To modify the default frequency band and mode displayed by the band control object:
1- Switch to Edit mode
2- Right-click on the Band Control object and choose Properties.
3- In the Defaults area of the Properties window, select the default Output to be displayed

and whether to display the Amplitude or Phase of frequency bands by default.

10.12 Configuring Two-State Indicators
To configure a Value Indicator as a two-state “on-off” switch:
1- Create a Value Indicator object (as described in 10.9.2 - Working with Objects) and

display its Properties window.
2- In the Show list, select Two-State Indicator.
3- Select the Data property sheet.
4- Click Format. The Value Switch Behaviour - Condition Builder window is displayed, as

shown in Figure 10-27:

Figure 10-27 : The Value Switch Behaviour - Condition Builder Window

Display the “SMAX” 
frequency band 

output

Display the “vib” 
frequency band 

output
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This window allows you to specify the conditions under which the two-state indicator is either
“off” or “on”:
5- Specify the condition. First, select the data range to check in the Value is list. You can

choose between the following types:
• In the Interval. Use the Value 1 and Value 2 buttons that appear to set the

appropriate values for the upper and lower bounds of the data range. When the
value is within this range, the indicator is switched to the “on” position.

• More than. Click the Value button that appears to specify the value. When the data
is greater than the specified value, the indicator is switched to the “on” position.

NOTE : To specify a “less than” condition, specify a greater than condition for the “off” state.

• Equal to. Click the Value button that appears and specify the value. When the data
exactly matches the specified value, the indicator is switched to the “on” position.
Otherwise, the indicator displays the “off” position.

• between Low and High Alert. Similar to the “In the interval” mode, with predefined
bounds. Use to perform a specific action when an Alert goes outside a valid range.

• between Low and High Alarm. Similar to the “In the interval” mode, with predefined
bounds. Use to perform a specific action when an Alarm goes outside a valid range.

• in the Valid Range. Similar to the “In the interval” mode, with predefined bounds.
Use to perform a specific action when the displayed value goes outside a valid
range.

6- Select the type of action for the “on” and “off” states of the two-state indicator. You can
choose various types of actions to perform:

• Do Nothing. This is useful if the indicator is to perform an action only when in one
state. See 10.12.1 - Configuring Two-State Indicators to Display Multiple Images for
an example.

• Display Picture. Click the browse button and select the image file to display.
10.12.1 - Configuring Two-State Indicators to Display Multiple Images for an
example.

• Display Text. Type the text to display in the text box that appears.
• Pop-Up Message box. This displays a pop-up message box when the condition

changes state. Note that the message box is only displayed once, when the switch
first changes state.

• Execute Shell Command. This is an advanced feature that launches a
user-defined program whenever the condition changes state.

• Play Sounds. Click the browse button and select a Sound file to play when in a
given state. See 10.12.2 - Configuring a Two-State Indicator to Play an Audible
Alarm for an example.

• Open Mimic page. Click the browse button and select a Mimic document to open
when a given condition is met.

7- Check the summary information. Use the Configuration summary field at the bottom of
the window to check the conditions and actions assigned to this indicator. 

8- Click OK.

10.12.1 Configuring Two-State Indicators to Display Multiple Images
You can position several Value Indicator objects exactly on top of each other and configure
each to display a different image. The first (topmost) indicator does nothing, the second one
(logically underneath the first one) becomes visible. If both the first and second indicators are
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false and set to “no action”, the third indicator (logically beneath both the first and second
objects) might display some information. This feature can be used, for example, to display a
dynamic “traffic light” indication: green when a value is within a “normal” range, yellow when
outside this range of values, and red if the value exceeds a third, “danger” range. This
situation is illustrated in Figure 10-28:

Figure 10-28 : Using Lamps to Indicate Alarm and Alert Levels

To do this using multiple two-state indicators:
1- Create a Value Indicator object (as described in 10.9.2 - Working with Objects) and

display its Properties window.
2- Select No Border and No Fill.
3- In the Show list, select Two-State Indicator.
4- Select the Data property sheet.
5- Deselect the Caption and Units options.
6- Click Format and select between High and Low Alarms in the Value is field.
7- Select Do Nothing for When Switched to OFF and Display Picture for When

Switched to ON, as shown in Figure 10-29. In this configuration, whenever the Do
Nothing setting is true, the Value Indicator is ignored, and the object immediately below
it in the Mimic document is tested. If, however, the value is false, an image, in this case
a yellow lamp, is displayed.

Figure 10-29 : Setting Up a Transparent Value Indicator

No signal

Low Alarm

Low Alert

High Alert

High Alarm
Red Lamp

Red Lamp

Yellow Lamp

Yellow Lamp

Green Lamp

Violet Lamp



10 - 30 CMS Software Manual (Volume 1) MACMS-SW/E
Edition 10 - Jul 26/07

Configuring Two-State Indicators
USING THE MIMIC MODULE

8- Create a second Value Indicator object and configure it like the first object but with the
following differences:

• Select between Low and High Alerts in the Value Is field.
• Select a green lamp image in the Parameter field.

9- Create a third Value Indicator object and configure it like the other objects but with the
following differences:

• Select in the Value Range in the Value Is field.
• Select Display a Picture in the When Switched to OFF field and select a purple

lamp image in the Parameter field 
• Select Display a Picture in the When Switched to ON field and select a red lamp

image in the Parameter field.
10- Select the first Value Indicator created and choose Move to Front from the Format

menu.
11- Select the second Value Indicator created and choose Move Backward from the Format

menu.
12- Select the third Value Indicator created and choose Move to Back from the Format

menu.
13- Move all three objects into exactly the same position on the Mimic document.
14- Save the changes you have made to the Mimic document.
15- Switch to Run mode and test the indicator.

NOTE : For an example of such an indicator, open the group object “Lamp_Indicator.gr”
(Format > Insert Group from File), provided with the VM600 CMS Software in the
Examples folder, ungroup the object and examine the individual objects’
properties. 

10.12.2 Configuring a Two-State Indicator to Play an Audible Alarm
To configure a two-state indicator to play an audible alarm whenever a given value or range
of values is exceeded:
1- Create a Value Indicator object and display its Properties window.
2- In the Show list, select Two-State Indicator.
3- Select the Data property sheet.
4- Click Format. 
5- Select a condition from the Value is box.
6- In the list of available options for either When Switched to OFF or When Switched to

ON, select Play Sounds.
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7- In the Parameter field, either type the path and file name of a Wave Sound file (*.wav).
Alternatively, click the browse button, browse to a folder containing the Wave Sound file
(*.wav) to use, select a file and click Open.

Figure 10-30 : Selecting a Sound File

NOTE : A number of useful sound files are delivered with Windows. For example, in
Windows XP, browse to the folder C:\WINNT\Media.

8- Click OK to save the object’s properties.
9- Save the changes you have made to the Mimic document.
10- Switch to Run mode.

10.13 Configuring Baseline Controls
The Baseline Control allows users to switch the display between the current values and those
stored at the time-base or the delta between the two. The baseline switch button shows what
is currently displayed (LIVE = current data, BL = baseline data stored at the time-base for the
machine, DELTA = the difference between the two).

10.13.1 Setting Baseline Control Properties
To configure a Baseline Control:
1- Create a Baseline Control object (as described in 10.9.2- Working with Objects) and
display its Properties window (Figure 10-31).
2- On the right hand side of the Baseline Control Properties, select the Caption required

(See 10.13.2- Using Macros in the Baseline Control Window).
3- Change the font of the caption using the font button if required. 
4- Change the border and fill colors if required.
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5- Attach the Baseline Control to the Machine to be monitored. Verify that this is the same
machine displayed on the Mimic being created.

Figure 10-31 : Band Control Properties

10.13.2 Using Macros in the Baseline Control Window
The meaning of the baseline control macros are as outlined below:

10.14 Creating Mimic Subdocuments
Mimic allows you to define a hierarchy of interconnected Mimic documents and to navigate
between documents by clicking on text objects that have been configured as links to other
documents:

Figure 10-32 : A Hierarchy of Linked Mimic Documents

[BL_STATE] Displays either “LIVE”, “BL” or “DELTA”, depending on the 
displayed data (switch on Baseline control).

[MACHINE_NAME] Displays the name of the machine associated with the 
Baseline control.

[BL_TIME] Displays the timestamp of the set Baseline for the machine 
associated with the Baseline control.

Mimic
sub-document 1

Mimic
sub-document 2

Default Mimic Document1
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10.14.1 Creating Subdocuments
To create a new Mimic document:
1- Ensure you have Super user access rights (refer to 10.7 - Security).
2- Enter Edit mode by clicking the Edit icon on the icon bar. See 10.8 - The Mimic

Document Editor.
3- Choose File > New.
4- Create the objects and define the appearance of the new document, as described in

10.8 - The Mimic Document Editor.
5- Choose File > Save as.
6- In the Save As window, type a name for the new document, for example:

Figure 10-33 : The Save As Window

7- Click OK. 

10.14.2 Creating Links to Other Mimic Documents
Once you have finished creating a new Mimic document, you can either set the new
document as the default Mimic document (see 10.9.1 - Specifying a Default Mimic
Document), or create links to the document from another Mimic document. 
To create a link to a Mimic document:
1- In Mimic’s Link View, double-click on the document that is contain the link to the new

document. Typically, for example, a link would be created from the top-level default
document to one or more subdocuments.

2- Insert a text object in the document to contain the document.
3- Double-click on the text object to display the object’s property sheet.
4- Click the browse button to the right of the Object Connection field. A list of existing

Mimic documents appears:

Figure 10-34 : List of Existing Mimic Documents
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NOTE : If Mimic documents are being saved to disk (see 10.9 - Setting Mimic Options), a
standard Windows browse window appears for you to select a Mimic document
(*.m).

5- Select the Mimic document to be opened when the link is activated and click OK.
6- Optionally, prefix the Mimic document name that appears in the Object connection field

with a macro to control user privileges to activate the link, for example “[SUPER]”. Refer
to Using Macros in the General Properties Window on page 10-20 for details.

7- Set any other properties of the text object, for example, the background color and font.

NOTE : It is a good idea to choose a distinctive style for links and apply it consistently to all
text that contains links to other documents. For example, define all links as blue,
underlined text. This way, it is easier for the operator to distinguish links from
normal text objects.

8- Click OK to close the Text Properties window.

10.14.3 Updating the Links View
Once a new document has been created and linked to by other documents, you should
update the Links view to take account of the new document structure.
To update the Links view:

1- In Edit mode, click the Rebuild Links icon  on the tool bar, or choose View >
Rebuild Tree.

2- The Links View is updated to include the new document.

10.14.4 Testing Links
To test a link from one Mimic document to a sub-document:
1- Switch to Run mode.
2- Click on the text object that contains the link. The linked to sub-document appears

automatically.
If the target Mimic document does not appear, access to the document may be limited to
users with a specific privilege level. Refer to 10.9.6 - Setting Object Properties for details.

10.14.5 Managing Mimic Documents
You can rename or delete existing Mimic documents, write individual Mimic documents to
disk and load documents from disk using the Mimic Document manager.
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To display the Document Manager, enter Edit mode and choose Tools > DB Documents
Manager. The Database Record Manager window is displayed:

Figure 10-35 : The Database Record Manager Window

From this window, you can:
• Select a Mimic document and click Delete to remove the document permanently from the

database.
• Select a Mimic document and click Rename to rename the document.
• Click Add from File to load a previously saved Mimic document (*.m) from disk and store

it in the database.
• Select a Mimic document and click Save to File to write a Mimic file to disk. Browse to

the folder in which to store the document, modify the default name if required, and click
OK. Mimic documents are stored with a .m extension.

• Click Exit to return to Mimic.
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11 USING THE DATABASE BROWSER

11.1 Introduction
The Database Browser module is a graphical tool used to display data from the database.
The Database Browser allows you to view the complete contents of the database. It
graphically shows all stored data sets in an intuitive time-line representation, and allows you
to quickly navigate to the data set of interest. The Database Browser provides direct links to
the Data Analysis and Event Viewer modules. 

11.2 Before Using the Database Browser
Before using the Database Browser, you must:
1- Set up and configure a database. This involves:

• Creating at least one database.
• Configuring an ODBC system DSN and user account to access the database.
• Creating and setting up a database server for the database and setting it up to run

automatically. 
See Chapter 7 - Administering Databases for details.

2- Use the Configuration Editor to define the VM600 racks, cards, and outputs used to
gather data, and store this configuration in the database.
See Chapter 9 - Creating a Rack Configuration for details.

11.3 Starting the Database Browser
Start the Database Browser manually by:
1- Choosing Start > Programs > VM600 CMS Software > DB Browser
2- Starting the VM600 Administrator program, choosing Applications in the structure view

on the left, then double-clicking Database Browser.
You can also start the Database Browser from within Mimic. Refer to Chapter 10 - Using the
Mimic Module.

11.4 Selecting a Database (Database Browser)
If the Database Browser is started from within Mimic, the current database is used as the
source of measurement data. However, if the Database Browser is started manually, the
database used depends on the options chosen in the VM600 Administrator. The Database
Browser starts directly on the previously used database or the Select ODBC Data Source
window opens. Refer to Chapter 6.6 - Administrator Options for further details.

11.5 The Main Window
The Database Browser main window, shown in Figure 11-1, is divided into two main parts:
1- The top half of the window allows you to select the outputs and types of data to analyse. 
2- The bottom half of the window displays a graph of the selected data.
3- Circled elements have been defined as Baseline values.
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Figure 11-1 : The Database Browser Main Window

11.6 Selecting the Data to Use
To select the data to use:
1- To select the output or outputs to use, click Add. The following window is displayed:

Figure 11-2 : Adding Points

2- Click one or more output points. The points are added to the Points list on the main
window.
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3- On the main window, select the type of data to use:
• Choose All to use all the data from the selected output(s).
• Choose one or more of the other data types to use:

4- Select or directly edit the start (From) and end (To) ranges for the data to be used. You
can apply a filter to the From range. Click Current time to insert the local PC’s current
system time into the To field.

5- Click one of the following buttons:
• Analyse. Launches the Data Analyser module.
• Event List. Displays the Event List window.
• Browse. Display a plot of the selected output data in the bottom half of the window.
• Direct Display. Display a plot of the data in a separate window, using the Data

Analyser module to display the data.

11.6.1 Browsing Data
When you click Browse to work with the data directly within the Database Browser, you can
access the functions on the toolbar, which is similar to that of the Data Analyser module:

Figure 11-3 : Database Browser Toolbar

Refer to Chapter 12 - Using the Data Analyser to Create Graphs for details on each of the
icons. Use the Marker icon , for example, to mark a data point. The value of the data point
then appears underneath the graph, as shown in Figure 11-4.

Figure 11-4 : Marking a Point
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11.6.2 Displaying Data in the Data Analyser Module
By clicking Direct Display on the main window and working on the graph within the Data
Analyser module. An example graph is shown in Figure 11-5. Refer to Chapter 12 - Using the
Data Analyser to Create Graphs for further details.

Figure 11-5 : An Example of a Graph in Direct Display Mode

11.6.3 Next/Previous Functions
All plot types for displaying discrete data sets, such as waveforms, spectra, or orbits, allow
you to directly scan through the data sets for the selected points using the Next and Previous
buttons:

11.6.4 Data Management of User-Requested Data
You can save data sets into the database by first freezing the plot then saving it. This
effectively add the data set into the automatically acquired data sets, acquired on schedule
or alarm. This is represented on the Database Browser as well as the Analyser. 

11.6.4.1 To freeze a plot: 

Click the Stop symbol

11.6.4.2 Saving the data: 

Click the Save symbol
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12 USING THE DATA ANALYSER TO CREATE GRAPHS

12.1 Introduction
The Data Analyser module is a graphical tool used to display measurement data. 
The tool takes selected data from the data measurement points defined in the database,
applies user- or system-defined filters to the data, and displays the data in a variety of graphs,
plots or charts.
Typical filters that can be applied to the data are time, alarm status, machine status, or a
freely configurable filter that can be constructed based on any speed, analog, or digital data. 

12.2 Before Using the Data Analyser
Before using the Data Analyser, you must:
1- Set up and configure a database. This involves:

• Creating at least one database 
• Configuring an ODBC system DSN and user account to access the database.
• Creating and setting up a database server for the database and setting it up to run

automatically. 
See Chapter 7 - Administering Databases for details.

2- Optionally, start the VMCom communications handler. If VMCom is running, you will be
able to display “live” measurement data in the Data Analyser. Otherwise, you can only
display historic data that has previously been stored in the database.
See Chapter 8 - Setting Up the VMCom Communications Handler for details.

3- Use the Configuration Editor to define the VM600 racks, cards, and outputs used to
gather data, and store this configuration in the database.
See Chapter 9 - Creating a Rack Configuration for details.

12.3 Configuring System Time
CMS Software includes modules that graphically plot collected data. It is important that all the
data that is plotted is timestamped in a single continuous flow. If the PC on which the CMS
software is installed is configured to automatically adjust the system time for daylight saving
hours, this can cause data to be incorrectly plotted. For this reason, it is advisable to switch
off automatic daylight savings hour adjustment.
To deactivate automatic daylight savings hour adjustment:
1- Click Start > Settings > Control Panel.
2- Open the Date and Time applet.
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3- Click the Time Zone property sheet:

Figure 12-1 : The Day/Time Properties Window

4- Deselect the Automatically adjust clock for daylight savings changes check box
5- Click OK.

12.4 Starting the Data Analyser
The Data Analyser can be started either manually or from within other CMS Software
modules.
Start the Data Analyser manually by:
1- Choosing Start > Programs > VM600 Software > Analyser
2- Starting the VM600 Administrator program, choosing Applications in the structure view

on the left, then double-clicking Data Analyser.
You can also start the Data Analyser from within:
• Mimic
• The Database Browser.

12.5 Selecting a Database
If the Data Analyser is started from within Mimic or the Database Browser, the current
database is used as the source of measurement data. However, if the Data Analyser is
started manually, the database used depends on the options chosen in the VM600
Administrator. The Database Browser starts directly on the previously used database or the
Select ODBC Data Source window opens. Refer to Chapter 6.6 - Administrator Options for
further details.

12.6 The Main Window
The Data Analyser main window, shown in Figure 12-2, is divided into two main parts:
1- The left hand side of the window shows a logical view of the stations, machines, racks

and outputs defined in the selected database. 
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2- The right hand side of the window lists selection criteria for the type of data to be used,
the type of graph, plot or chart to be created, and any user or system filters that are to be
applied to the data.

Figure 12-2 : The Data Analyser Main Window

12.7 Creating Graphs
There are several steps to creating a graph:
1- Choose the type of data to use for the graph
2- Choose the type of graph, plot or chart to create
3- Choose the source of the data
4- Apply optional user- or system-defined filters 
5- Display the data

12.7.1 Selecting the Data Type
Graphs of three types of data can be generated:
• Historic data—previously captured data extracted from the database.
• Realtime data—live data coming from the machine or machines being monitored.
• Transient data—data of a limited duration, characteristic of the run-up and run-down

phases of a machine.
To select the data type:
1- Select HISTORIC, REALTIME or TRANSIENT from the Data Type list.
2- If you are using the air gap monitoring module, optionally select AIR GAP

DIAGNOSTICS from the Data Type list.
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12.7.2 Selecting the Graph Type
Not all graph types are suitable for all data types. The Data Analyser presents a contextual
list of available graph types when you select the data type.
Table 12-1 shows the types of graph available for each of the data types:
Refer to Chapter 1 - Introduction for a more detailed description of each of the graph types.

To select a graph type:
1- Select the Display Type as described in Chapter 12.7.1 - Selecting the Data Type.
2- Select an available Graph Type.
Depending on your selection, the Data Analyser updates the Logical View to show all relevant
stations, machines and channels for which the selected graph type is available, and displays
measurement data and filter information in the lower part of the window. 

Table 12-1 : Available Graph Types  

Data Type Available Graphs

HISTORIC

WAVEFORM
SPECTRUM
ORBIT
SHAFT CENTRELINE
TREND
HISTORIC POLAR
WATERFALL 
CORRELATION PLOT
MACHINE NOTES

REALTIME

BARGRAPH
REALTIME TREND
WAVEFORM
SPECTRUM
ORBIT
REALTIME POLAR
MACHINE NOTES

TRANSIENT

CASCADE
TRANSIENT TREND
BODE
SHAFT CENTRELINE
POLAR GRAPH
MULTIPLE POLAR GRAPH
MACHINE NOTES

AIR GAP DIAGNOSTICS

ROTOR SHAPE
SIGNATURE
ROTOR POLAR
POLE TREND
MACHINE NOTES
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12.7.3 Selecting the Data to Display
The next step is to select the data to be displayed. The data selection procedure differs
according to the graph type. For example:
• For a machine notes graph, select a machine in the Logical View and click Select. Any

machine notes that have been added appear in the Note List field. See the online help
to learn how to add machine notes.

• For all other types of realtime graph:
a. Select the point in the Logical View

b. Click Add
• For trend data:

a. Select the point in the Logical View, 

b. Click Select.
c. Select points in the list of Measurement Data and click Add.

d. Select a From and To time and date.

12.7.4 Applying a System or Extended Filter
Once a selection is made for a display type, a point list and a time filter, click Display to show
the appropriate plot. In addition to predefined filter criteria (“System” filters), additional filter
criteria can be applied using user-defined conditions (“Extended” filters): 

Figure 12-3 : Creating a Filter

Extended filters allow you to define certain conditions of the machinery based on variables,
such as analog, speed, or digital points. Extended filters are applied in addition to any system
filters that may already be in place. They allow you to look for specific operating conditions,
instead of showing all the historic data that is available in the database. 
For example, instead of showing a trend curve for a certain vibration value over the entire
period of data capture, it is possible to only show a subset of this data, and to display a trend
curve over a certain period while the machine was running at a speed within a certain range. 
You can construct your own filters, based on any analog, digital, or speed point, and save
them for future reuse.
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The following shows an example: 

Figure 12-4 : Example of an Extended Filter

This window allows you to:
1- Create filters and save them for use in the current session
2- Edit existing filters
3- Save filters for use in future sessions
4- Delete existing filters

12.7.5 Displaying the Graph
To display the graph, click Display.
The following figure shows an example:

Figure 12-5 : A Realtime Trend Graph

To view the measured points, choose Display Symbols from the View menu, or

click on the toolbar.
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12.8 Working with Graphs
Whilst a graph is displayed, its appearance can be changed using various buttons on the tool
bar. Depending on the chosen mode (scaling, comments, point select), different commands
/ bars are available as described below.

12.8.1 Display points and limits

12.8.2 Scaling / Zoom

The scaling mode allows users to zoom in and out (  or  ) after clicking a tool followed
by a graph. Alternatively, the mouse wheel can be used. It is also possible to zoom by
dragging a rectangle over the area of interest whilst holding down the left mouse button. Once
a zoom has been chosen, users can switch from one zoom to another by pressing and
holding the ‘Alt’ key. 

The panning tool ( ) allows users to move around a graph. Pressing and holding the left
mouse button allows users to ‘grip’ the graph and move it. This tool can also be activated

whilst zooming by pressing and holding the Ctrl key. The rescaling buttons  allow
users to rescale graphs (x and y rescaling, just x rescaling or just y rescaling).

12.8.3 Pick a point / Marker

Pick a point functions allow users to click onto any point on a graph. In graphs with several
plots, the following options are available:

Once a point has been chosen, its details are shown in the legend (Figure 12-6, a). A

comment can then be added by clicking the comment icon  to attach a text box to the
marked point. The Marker Info button (Figure 12-6, b) allows users to add the point's details
into the comment.

The display Symbols tool, gives a graph with a point for each measurement

The show limits tool is only available on trends

Toggles the position of amplitude and phase (amplitude above phase -
European convention; phase above amplitude - US convention)

Common marker: The selection in one plot automatically positions the
cursor to the same point on other plots.

Single marker: Changing the selected point is only carried out in the
graph selected.
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Figure 12-6 : Adding a Comment to a Point on a Graph

12.8.4 Labels and their density

1- Editing Comments

Click on the Labels icon  to pick up the comment and replace it with using the left mouse
button. A single left click selects the comment (Figure 12-7, a), then clicking the left button in
the text region allows users to edit the comment. (Figure 12-7, b). The comment is then
validated using another left click (Figure 12-7, c).

NOTE : Take care when selecting comments. A double-click on the left mouse button hides
the comment.

Figure 12-7 : Editing Comments

2- Define comments to display
Depending on the graph displayed there are various options available to choose which
comments to display.

In the Transient Polar for example, using the  tool the minimal distance between two labels
(10, 25, 50, 75, 100 pixels) can be defined. Any label(s) between these pixels are hidden.

Using the  tool a number from 2 to 10 can be selected, which causes only one out of 2, 3,
4,… labels to be displayed.

3- Using the Settings  tool, the appearance of comments (e.g. bounding rectangle,
transparent background) and function labels can be defined (refer to 12.8.5- Settings)

a) b) 

a) b) c)
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12.8.5 Settings
Layout preferences for the Data Analyser plots can be selected and saved using the settings

tool . The default settings  comprise of:
1- General settings (Figure 12-8, a) such as i) display data in Speed (RPM) or Frequency

(Hertz), ii) to show phase above amplitude in a Bode plot (US convention), iii) to show or

hide the symbols  and show or hide speed labels.
2- Labels (Figure 12-8, b) to define appearance (e.g. bounding rectangle, transparent

background) and function. The later may vary between graphs (e.g. display only speed,
only time or both, with or without units on the Transient Polar plot). 

3- Tools (Figure 12-8, c) to allow users to save preferences, such as i) which tools should
be selected when a graph is opened, ii) whether the common zoom is switched on or off,
iii) how to display labels and iv) whether the common marker is switched on or off.

Figure 12-8 : Settings Showing a) General, b) Labels and c) Tools

For each of the graphs a separate entry is made in the registry, so you can choose different
settings depending on the type of graph to be displayed.

12.8.6 Data Baseline 

The Baseline feature  captures snapshots any time (e.g. when the machine is running in
good condition such as after commissioning). These data can then be used as a global
reference. Degradation and sudden changes in vibration pattern later on can then be
compared to this baseline.
For the Data Baseline, an individual measurement can be chosen locally on each
vibration-channel data (Historic Waveform, Spectrum, Orbit or Transient) as baseline for this
specific Channel and Type. 

NOTE : The Trend Baseline for the entire Machine is not changed when the baseline
feature is used.

To set a Data Baseline, firstly change to Super privilege level. The currently displayed graph
can then be defined to be the Baseline value for the selected channel and type. Graph from
other measurements now have checkboxes in the legend to allow users to decide whether to

a) b) c)
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display not only the selected graph but also the previously defined Baseline or the difference
between the baseline and the current graph.
The baseline can be updated as required. There is one Baseline available for each channel
band for each of the following historic graphs: Waveform, Long Waveform, Spectrum, Orbit
and Transient.

Figure 12-9 : Graph Showing Historic Data and the Difference Between these Data and the 
Baseline (Delta)

12.8.7 Menu bar functions
Figure 12-10 shows a range of the menu bar functions available.

Figure 12-10 : Menu Bar Functions

The menu bar comprises of a list of functions, the most important of which are described in
subsequent sections.

12.8.7.1 File

1- Print Preview allows users to preview how the graph will print before actually printing.
2- Print Setup opens the standard Windows Print dialog box, so that print settings can be

selected. 
3- Printer Background allows users to replace the grayscale background with a white

background. 
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12.8.7.2 Edit

1- Copy Graph allows users to make a copy of the graph currently on display. It is similar
to using the print screen key on a keyboard, except only the graph is copied.

2- Export Data exports all points from this graph into a text file. It is suggested that an
appropriate format is *.dat).

12.8.7.3 View

Figure 12-11 shows the View functions available on the menu bar. The view functions allow
users to change the appearance of graphs. The options are the same as those on the toolbar
(Section 12.8.2). 
The contents of the drop-down menu change according to the type of data being displayed.
For example, the view menu allows users to:

• Advance to the next or previous dataset in Historic data.
• Toggle between amplitude and phase display in a Bode diagram.
• Amend the labels of Polar Plots.
• Delete graph headers and footers (in settings).
• A new window can be opened to display plotted data.
• Single lines or the entire content of the plot can be copied onto the clipboard.

Figure 12-11 : View Functions on the Menu Bar Showing a) Historic Waveform Menu, 
b) Transient Polar Plot Menu and c) Trend Graph Data

12.8.7.4 Tools, privileges, window and help

Figure 12-12 shows the Tools, Privileges, window and help menu bars.

a) b) c)
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Figure 12-12 : Other Drop-down Menus of the Menu Bar

1- The Tools drop-down menu offers the same functions as described for the toolbar in
12.8.2,  page 12.7 to 12.8.4,  page 12.8.

2- The Privileges drop-down menu allows users to change to Super-mode if this change
was not made when opening the Data Analyser.

3- The Window drop-down menu allows users to control the appearance of windows on the
screen and change the active window

4- The Help drop-down menu allows users to enter the online help, where information
about the topic of interest may be provided. In the Help-information is contained
information regarding the version of CMS installed.
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13 USING THE CMS EVENT VIEWER 

13.1 Introduction
The CMS Software system performs limit checks for each configured output, at every
processing cycle. Any exceedances, or amplitude changes across a user-defined limit, are
logged into the database.
The CMS Event Viewer is used to display events in the database that have either been
generated automatically by the system, or manually by users. You can filter the displayed
events according to a variety of criteria.
The CMS Event Viewer can be launched either directly from the VM600 Administrator, or
from within various other CMS Software modules, including Mimic, the Data Analyser and the
Database Browser. 
Invoking the CMS Event Viewer within another module is context-sensitive, that is, the
contents of the CMS Event Viewer window relate directly to the module from where it was
launched. For example, invoking it from the “Unacknowledged Events” indicator in the Mimic
module shows only unacknowledged events, whereas invoking it from a machine in the Mimic
logical view shows only events related to the selected machine. 

Figure 13-1 : The CMS Event Viewer Window

The CMS Event Viewer shows, in list form, the events that apply, according to particular filters
and sort criteria that you can set. 

You can update the list at any time by clicking the Refresh button . 

The CMS Event Viewer is primarily used by the operator in conjunction with Mimic, providing
immediate notification of any new occurrences in the system. New events are initially flagged
as “unacknowledged” until the operator manually acknowledges having read their contents.
However, the CMS Event Viewer is also useful for performing detailed data analysis, and
comparing the event log with measurement data. More specifically, the alarm event log is a
good starting point for searching for more detailed data that were triggered by limit
exceedance of specific outputs. 

13.2 Selecting a Database (Event Viewer)
If the Event Viewer is started from within Mimic or the Database Browser, the current
database is used as the source of measurement data. However, if the Data Analyser is
started manually, the database used depends on the options chosen in the VM600
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Administrator. The Database Browser starts directly on the previously used database or the
Select ODBC Data Source window opens. Refer to Chapter 6.6 - Administrator Options for
further details.

13.3 Privilege Levels
All users can view the list of events in the CMS Event Viewer.
Before being able to acknowledge events, however, you must have Super or Master user
privileges. 
To gain Super or Master user privileges:

1- Click the Password button , or choose Tools > Privileges.
2- Choose Super or Master. The Change Privilege Level window is displayed:

Figure 13-2 : The Change Privilege Level Window

3- Type the Super or Master password and click OK.
See Chapter 9 - Creating a Rack Configuration for more information on system security,
including the default passwords to use and how to modify passwords.

13.4 Acknowledging Events
To acknowledge an event:
1- Obtain Super or Master user privileges, as described above.
2- Double-click on the event in the event list, or select the event and click the Acknowledge

button .
3- On the Event Detail window, type an optional note describing the reason for

acknowledging the event. Click Add Note to automatically add to the note the current
time or the time that the event occurred.

4- Select Acknowledged.
5- Click Close. Alternatively, click Previous or Next to acknowledge the event immediately

above or below this event in the list, respectively.
Depending on the filter that is being applied, the acknowledged event may be removed from
the event list. 
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13.5 Sorting the Event Log
To modify the order in which events are listed:

1- Click the Sort icon . The Sort window is displayed:

Figure 13-3 : The Sort List Window

2- In the Sort by list, choose the column to be used as the primary sort key.
3- Choose Ascending to sort the entries in ascending alphabetical order, or Descending

to sort in descending order. 
4- Click OK. 

13.6 Filtering the Event Log
You can choose to display only those types of event that interest you.
To filter events: 

1- Click the Filter icon , or choose Tools > Filter Messages.
2- On the Filter Events window, choose the type of events to display. For example, to

display only events that have occurred with the past 7 days:

Figure 13-4 : Filtering Events

3- Click OK.
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The Event Browser can be invoked from various places throughout the CMS Software.
Depending on the context, it is invoked as if a filter, such as “only unacknowledged alarms”,
had been preset manually. 

13.6.1 Removing Filter Settings

To remove an active filter, click the Filter icon  on the toolbar. The display reverts to
normal. 

13.6.2 Changing Filter Settings
Preset filter settings remain unchanged, regardless of whether they are actually applied. It is
therefore possible to re-activate the same filter settings by clicking the Filter icon again. The
data is highlighted, and the previously set filter settings re-applied. 
This is useful in order to trace events that have been acknowledged, and therefore
disappeared from the list of unacknowledged events. 

13.7 Customizing the Event Log
You can customize the event log to display just the information of interest to you.
To add or remove columns:

1- Click the Customize icon , or choose View > Select Columns.

2- On the Select Columns to Display window, use the arrows between the columns to add
or remove columns as required, or Move Up and Move Down to change the order in
which the selected columns appear in the list:

Figure 13-5 : Select CMS Event Viewer Columns

3- Click OK when finished.

13.7.1 Display descriptions
To keep track of the history of a machine text can be added to each entry in the Events List.
New events can be created to add a text description at a certain time. Thus, explanations can
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be left about events that have occurred. To view these comments, click the 'column'-button
in the event viewer and add the Description column to the selected Fields list. This can then
be positioned as appropriate (Figure 13-6).

Figure 13-6 : Display of Event Viewer with Descriptions

13.8 Exporting the Event Log
You can export the contents of the event log to a file for further processing by other
applications.
To export the event log:

1- Click the Export icon , or choose File > Save List.

2- Specify the name of the file to export and click Save. The event log is exported to a
comma-separated text file (.csv) on the disk. You can then, for example, archive the data
or subsequently import the contents of the file into another application, such as a
spreadsheet, for further analysis.
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A TROUBLESHOOTING AND FREQUENTLY ASKED 
QUESTIONS

Q. Why does nothing happen when I double-click the VMCom shortcut on my 
desktop?

A. Verify the following:

1- Right-click on the shortcut and choose Properties. For VMCom to start, the value of the
DSN=”myDB” parameter must match that of a database that is currently running as a
Database Server. Refer to 8.3.2 - Running VMCom from the VM600 Administrator for
details.

2- Check that the physical database file associated with the DSN is the same as that being
managed by the database server. To check which physical database file is associated
with a system DSN:

a. Start the ODBC Administrator program, for example, from the VM600 Administrator
program.

b. Click the System DSN property sheet.

c. Select the system DSN that is specified in the VMCom shortcut properties.

d. Click Configure.

e. Click the Database property sheet.

f. The name of the database appears in the Database file field.

To check which physical database file is being managed by a database server:
a. Start the Sybase Central program

b. Select the Services node on the left-hand side of the window.

c. Right-click on the Database Server and choose Properties.

d. Click the Configuration property sheet. The database being used appears in the
Parameters box, for example “sample.db”.

Q. What do “VMCom is disconnected by user...” messages in the application 
log file mean?

A.  Messages of the form “VMCom is disconnected by user : npar : 2003-03-07 07:35:19”
are generated by the Mimic application when the VMCom communications handler is running
in debug mode (using the -D command-line option). Periodically (every 15 seconds), Mimic
checks that the VMCom communications handler is still running by disconnecting then
reconnecting. In debug mode, these messages are written to the Windows application log file. 
These messages are harmless and have no negative impact on system performance.
However, due to the large number of entries generated in the application log file, you should
consider either removing the debug option (see 7.5.2 - Modifying Database Server
Command Line Parameters), or taking steps to limit the size of the application log file (see
8.8 - Managing the Application Log File).
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Q. What do the error messages returned by the VMCom Service Setup 
Program mean?

A. Only one VMCom service can exist at any one time. If the following error message is
displayed in a popup window:
failure: CreateService (0x431)

a VMCom service already exists and the program is unable to create another one. Open the
Windows Services window and identify the existing service’s name.

Q. I start VMCom first, then Mimic, but “VMCom offline” still appears in red 
on the status line. Why?

A. The most likely cause is that the database server required by the VMCom
communications handler is not running. Proceed as follows:
1- Exit Mimic.
2- Stop VMCom by clicking on the VMCom icon in the system tray and clicking Shutdown.
3- Check that the database server and VMCom are accessing the same database, as

described previously. 
4- In Sybase Central, start the database server.
5- Start VMCom.
6- Start Mimic. 

Q. Why does “Unacknowledged messages” appear in red at the bottom of 
the Mimic window, and what should I do about it?

A. This message indicates that alert or alarm indications, or a variety of other possible error
conditions, have been detected by the CMS Software system but no operator or administrator
has yet acknowledged having read all such messages. To acknowledge a message:
1- Double-click on the “Unacknowledged messages” area of the Mimic window. The Event

Viewer module is launched. 
2- Make sure you have Super user privileges in Event Viewer.
3- Double-click on any listed event that shows “No” in the “Acknowledged” column.
4- Optionally, type a brief comment explaining the reason for the fault, or the solution to the

fault.
5- Select Acknowledged.
6- Type your name and click OK.
7- Use the Next and Previous buttons to navigate other unacknowledged events in the list,

then click OK.
8- Close the Event Viewer when all events have been acknowledged. The status bar area

is now green.
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Q. When I return from lunch, all my open Mimic documents have been 
closed. Why?

A. A timeout is set in the Mimic options. To remove or increase the timeout:

1- Make sure you have Super user privileges in Mimic.
2- Enter Edit mode.
3- Choose Tools > Options.
4- Either deselect the Close windows opened from Mimic after option, or enter a larger

timeout value.
5- Click OK.
6- Return to Run mode.

Q. Why is no value being displayed in Mimic for my Analog input?

A. Verify the following points:

1- Check that the IOC 16T channel to which the input is physically connected matches a
channel number configured as an Analog input in the Configuration Editor. 

2- Remove the IOC 16T card from the VM600 rack and check that the jumper settings
match those shown on the schematic diagram printed from the Configuration Editor.
Refer to 9.15 - Configuring the IOC 16T Card on page 9-39 for a description of the
procedure to follow.

3- Open the Mimic document and check that the object that should be displaying the value
is correctly configured. Drag and drop the correct output or output from the architectural
view onto the object and watch for any error messages that Mimic displays.

Q. Why does Windows display error/warning messages saying “Application 
Log Full”?

A. The VMCom communications handler writes messages to the Windows application log
file whenever an event occurs. For example, an entry is written to the application log file
whenever a CMS Software application connects to or disconnects from the VMCom
communications handler. When running the VMCom communications handler in debug
mode, the large number of events can cause the application log file to overflow, causing
“Application Log Full” error messages to be displayed. 
Limit the size of the application log file as described in 8.8 - Managing the Application Log
File.

Q. My Database Has Overflowed the Partition!

A. The cause of this problem is usually that the application log file has grown rapidly.
Although databases on other partitions should continue to function normally, it may be
impossible to start the database server for the affected database. 
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When this happens, it may also become impossible to delete the application log file for the
database, stop the database server, or change the database parameters to use no log file.
To recover from this situation, you can attempt to launch dbsrv8.exe manually using the “-f”
parameter. Refer to the Sybase Central online help for more information.
Refer to 7.1.4 - Transaction Log Files for more information on estimating and controlling the
size of transaction log files.

Q. Why do I get a “Column not found: Column ‘FW2’ Not Found” error when I 
open a database in the Configuration Editor?

A. The most likely cause of this message is that you are running the CMS Software with a
database that was created with an earlier version of the software and has not yet been
updated to the current version. In this case, try running the Update Internal Database
Structure utility from within the VM600 Administrator program.

Q. How do I know which version of Adaptive Server Anywhere is installed?

A. To find out which version is installed:

1- Launch Sybase Central by choosing Start > Programs > Sybase SQL Anywhere 8 >
Sybase Central

2- Choose Help > About Sybase Central. The Sybase Central window is displayed
(Figure A-1).

Figure A-1 : Sybase Central Window

In this case, the version is “8.0.3.5444”.
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Q. How can I improve the performance of my database?

A. The processing load and storage demands of a database are likely to increase
significantly over time. As a consequence, database performance can degrade. To improve
performance:
1- Verify that the database is using a transaction log file and is not using a mirror file.

Changing these settings is described in 7.6.9 - Changing Transaction Log File Settings. 
2- Check that the database server’s cache memory allocation is the optimum size (see

7.5.3 - Database Server Cache Memory Size Optimization).
3- Consider upgrading the PC that is running the database, for example by installing larger

and faster disk drives, more RAM, faster processors, faster network communications,
and so on.

Q. How do I fix problems connecting to the VMCom communications 
handler?

A. This problem exhibits various symptoms, depending on the context of usage of the CMS
Software, the system administration of the host PC and client PC's and the current type of
activity. The following symptoms are indicative of this issue:
COMMIT doesn't work from Configuration Editor: 
• When attempting to perform a COMMIT, the Configuration Editor window shows

“VMCom appears to be offline”
• VMCom does not react to the request and continues to run normally. 
CONNECTION doesn't work from the Configuration Editor
• When attempting a connection, Configuration Editor Window shows “VMCom appears to

be offline”
• VMCom does not react to the request and continue to run normally. 
Real-Time Plots 
• When attempting to launch real-time plots (waveforms, spectra, orbits, and so on), the

connection fails and the Real-Time Plot window shows “VMCOM offline” in the title bar.
Incorrect VMCom status in Mimic
• Mimic window shows “VMCom offline” although the VMCom process is actually running

Q. Background Information about the CMS internal communication 
mechanism
The VMCom communications handler is responsible for exchanging data with CMC 16 cards
through the network. It downloads configuration data to the hardware, and uploads
measurement data and status information from the VM600 racks and stores it in the
database. 
While most of these tasks are carried out independently by the process, some activities
require user interaction with the VMCom process, such as manually triggering the download
of configuration data to the card (COMMIT), or the acquisition of specific user-requested
datasets, such as real-time spectra, real-time waveforms, or real-time orbits. 
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At a lower lever, the mechanism used for those actions uses a “pipe” connection, which
requires that the currently logged in Windows user has access to the directory where the
program VMCom.exe is running. In a distributed architecture (when the system is operated
from several machines over a network), this has certain consequences on the administration
of those machines. The next section highlights conditions that need to be met in order to
guarantee the functioning of the pipe connection mechanism. 

A. Use the following checklist to help solve the problem:

1- Host identification
When running, the VMCom communications handler process “signs” its presence within the
database by writing the host name of the PC on which it is running into a field inside the
CONFIGURATION table of the database. Other programs that need to connect to VMCom,
or check that it is running, rely on this signature to detect whether the VMCom process is
running. Whenever a connection to VMCom is needed, these programs attempt to connect
to the pipe of the VMCom process on the PC identified by this host name. 
The host name of the PC where VMCom is running must be known, and visible from all
client machines. In a client/server environment, the server and clients must be located on
the same network, belong to the same subnet or use appropriate gateways, and must be able
to recognize the host name (for example, by looking up the name in the “hosts” file on the
local PC, or using a domain name server).
2- Windows Networking Components
Two components of Windows operating systems are required for connecting to the VMCom
process over the network:
• Client for Microsoft Networks, to be able to “see” the host over a network
• File and Printer Sharing for Microsoft Networks, to be able to share files over the

network, thus allowing components to connect to a pipe. 
While both these components are part of the standard Windows operating system, they must
be installed on the PC where VMCom is running. Otherwise, it is not possible to establish the
pipe connection. 
Check that both components are installed on the computer. If one or other is not: 
• Install > Client > select Client for Microsoft Networks > OK
• Install > Service > File and Printer Sharing > OK
3- Windows Users/System Administration
Users logged on to a CMS host or client computer must have access to the directory where
the currently running VMCom.exe program is located. This implies that the current Windows
user must have appropriate privileges to the installation directory of the CMS Software on the
host computer. 
When accessing the system from a client machine, the user name and password on the local
Windows system (client machine), must also be recognized as authorized users on the server
machine. 
Typically it is recommended to configure dedicated Windows users on the host as well as on
all client machines, with unique user names and passwords.
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Q. Why don’t I get the expected results?

A. Check the following in the Configuration Editor:

• For transient data, check that the sampling duration is not set to zero.
• If no output signal is available, check the band mapping for the output.

• If the signal shape for a dynamic signal is  and you expected ,
check that the Integration setting is None.

• If unexpected orders are received, check the reference Fixed Speed value for the
machine to which the channel is connected (in the Architectural view.

• Always configure at least one speed channel for each card, even if it is not used directly
for the channel’s processing.

• If Smax trend data is being acquired, check that order tracking and fixed frequency
features are both switched off.

Q. Should I Use Daylight Savings Time?

CMS Software always shows you a continuous sequence of data on plots. This data is always
stored in Universal Coordinated Time (UTC), without any reference to summer or winter time,
that is, independent of the system clock setting on your computer.
However, if the “Automatically adjust clock for daylight saving changes” setting is set on your
computer, the displayed times are calculated from the actual time adjusted for daylight saving
time. So, during summer you will see points displayed correctly, but winter points will be one
hour out. In winter, the opposite happens and the summer points will be one hour out.

A. Deselect the “Automatically adjust clock for daylight saving changes” checkbox
(accessible from Start > Control Panel > Date and Time):, as shown in Figure A-2.

Figure A-2 : Date and Time Properties
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Q. How do I perform trend refinement in background mode?

A. To capture quick changes in amplitude in background mode when the machine is running
on load, use the Trend Refinement setting on the machine’s Logging page in the Logical
View of the Configuration Editor (Figure A-3).

Figure A-3 : Logging Page of Logical View

If, when running on-load, the system detects that the measured values between two realtime
trend points are further apart than x% of FSD (full scale deflection, configured as the Analog
Resolution), it writes every acquired trend point into the database.
With the Compression Ratio setting, you can further adapt the Analog Resolution to be
smaller when it approaches the alarm levels.
Example A: Analog Resolution 20% of FSD and Compression Ratio equals 1: the Analog
Resolution effectively used always stays at 20% of FSD (see the black line in Figure A-4).
Example B: Analog Resolution 20% of FSD and Compression Ratio equals 2: the Analog
Resolution effectively used is 20% of FSD only when the values are between the alarm
values (LowAlarm + ½ (HighAlarm - LowAlarm). As the value gets closer to the alarm values,
the analog resolution is reduced to its percentage divided by the compression ration (that is,
20% / 2 = 10%) (see blue line in Figure A-4).

Figure A-4 : Sample Trends

NOTE : A small Analog Resolution value can cause the trend buffer to rollover (that is, to
overwrite the oldest data before it has been sent to the database).

NOTE : You can only choose one percentage value for the machine, even though signals
may be configured differently (peak and peak-to-peak).

NOTE : Analog Resolution is only active when the machine status is running “on load” (see
1.4 - Machine States on page 1-9).
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Q. Which direction for the offset definition of relative vibration points?

A. Positive and negative directions can be defined as follows:

• Positive direction - further away from the probe - more negative
• Negative direction - closer to the probe - less negative
In CMS, the same mathematical approach is used for the positive and negative DC Signal
range (Figure A-5).

Figure A-5 : Positive and negative signal ranges

As a result, in CMS:
• A positive offset value means that the measuring range is virtually shifted away from the

target. 
• A negative offset value means that the measuring range is virtually shifted towards the

target.

NOTE : Only DC Gap outputs take into account the DC offset.

Q. What if remote access to the system fails?

A. If you need to access your database from more than one other computer you need to
uninstall Sybase and choose a higher number of licensed seats in the setup. The Help/About
Sybase only states the version of Sybase running. No other setup information is provided.
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Q. How is it possible to log and trend the behaviour of non-dynamic Points

A. Dynamic points drive logging of trend data, which leads to restraints when integrating
non-dynamic points (e.g. offline points, tacho or analog points) into the CMS Database.
Offline points must be attached to a machine in the logical view. Figure A-6 shows the output
from a vibration point with one output enabled.

Figure A-6 : Historic Trend Change in the OPC Points with Changing Speed and Vibration 
Levels

When all vibration channels from a machine are detached, no further data from that machine
is stored into the database. Where several machines are equipped with VM600_CMS
monitoring and others are not, it may be useful to integrate process variables (from Modbus
or OPC) from all machines into the CMS database. To facilitate this, a workaround in the
configuration is required: 
1- The offline points are attached to an existing CMS-machine
2- The virtual speed and dynamic points is defined for an extra logical machine where all

other offline points are attached. A spare speed channel can then be fed from the
tachobus in that rack (providing the MPC card feeds onto both tacho buses). For the
vibration channel, the easiest method is to feed one rear signal onto two channels.
Otherwise, an MPS signal can be used (not included in the CMS configuration) and fed
it onto a free raw bus.

On machines without speed and vibration points realtime values can still be received, but the
historical data from the machine will not be stored into the database.
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Q. How can I run CMS 2.0 and upwards with Sybase 8.02

A. It is recommended that CMS 2.0 is used with Sybase 8.03. If absolutely necessary,
CMS 2.0 can be used with Sybase 8.02, but it is necessary to solve database issues
(Figure A-7).

Figure A-7 : Error Creating a New Database using CMS 2.0 and Sybase 8.02.

New databases are created using the file C:\Program Files\VM600_CMS\DB\empty.db in the
VM Administrator (Figure A-8). The error when installing CMS 2.0 / 2.1 / 2.2 is caused by the
empty.db file being generated in Sybase 8.03 , but Sybase 8.02 is running.

Figure A-8 : Location of empty.db File
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To resolve this issue one of the following procedures can be used once CMS 2.x has been
installed:
1- Rename the file empty.db to empty803.db (1 330 KB)
2- Download the file empty802.db from Vibro-Meter’s FTP-server at:

ftp://vmchftp.vibro-meter.com. A username and password can be obtained by e-mailing:
techsupport.ch@vibro-meter.com.

3- Make a copy of the file empty802.db and rename it empty.db (1 064 KB)
OR
1- Rename the file empty.db to empty803.db (1 330 KB)
2- Uninstall CMS 2.x
3- Install CMS 1.5.4
4- Make a copy of the file empty802.db and rename it empty.db (1 064 KB)
5- Install CMS 2.x
Once complete, make sure the empty.db you are using is not the 1 064 KB file. The file
system should now be as in Figure A-9.

Figure A-9 : File System After Changing empty.db

Q. Why do I need to open the configuration editor when deleting a database?

A. When using the Delete Data from Database function on a freshly copied database in the
VM600 Admin's Database Utilities the user is requested to open the database in the
Configuration Editor.
During the copy process the Configuration table is left empty as it contains information
specific to the PC it runs on. Opening the Configuration Editor on a new database initializes
the configuration table with data (i.e. passwords, the host it has been running on and the time
when the database was last modified). This task has to be completed on a new database
once and it must be affected manually.
Alternatively, the advanced copy (choose Configuration + Mimic) can be used. A new
database from VM600 Admin's Database Utilities needs to be created. This completes the
Configuration Table with all required information so that the advanced copy can proceed
without the extra step of opening the Configuration editor. 
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Q. Can I run 2 VMComs on the same rack?

A. It is important when setting up several units/machines of the same type (and therefore
copy the same database and setup onto several PCs) to remember to change the IP-address
in the database. If this is not done, holes appear in your acquired data missing data appear
on the second system (Figure A-10). In this case, check whether a second VMCom is running
on the same CPU-M/on the same rack (Figure A-11).

Figure A-10 : Results from Incorrect Setup of DB A and DB B

Figure A-11 : a) Correct and b) Incorrect Setup of 2 VMComs

In Figure A-10, VMCom A was started at 10:30. All data were correctly stored until VMCom
B was started at 11:09. As the configuration of DB B had to be adapted to the 10 minute
logging rate, a Commit was made at about 11:10. Since this takes several minutes is may be
why no values were stored for the 11:10 measurement (i.e. due to the reset of the card).

a) DB A

b) DB B

a) Correct setup b) Incorrect setup
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Q. Why do I not get real-time graphs via remote access?

A. If you receive a blank screen when opening (for example) the Realtime Waveform from
Mimic on the Remote Computer (VMCom is running on a different PC - where the DB and the
DBServer also run), then this may be caused by i) access permission and the configuration
of File and Printer Sharing Service and ii) lack of permission to access the realtime data pipe
on CMS server machine running VMCom.
Other possible symptoms of this problem include:
1- When trying the Connect or sending a Commit from the Configuration Editor it shows a

"VMCom appears to be offline" message.
2- The Mimic shows a grey VMCom indicator in the Status Bar.
If any of the above issues are experienced, then check whether it is possible to:
1- Ping the server?
2- See the server in network neighbourhood using standard browse network window of

Windows explorer.
3- See the contents of the server in Windows explorer - shared folders list, shared printers,

scheduled tasks. You may not have permission to browse the shared folders themselves,
but you must have the permission to connect to the server on the remote computer. 

On both computers, you MUST verify in the LAN connection properties that "File and Printer
sharing" and "Client for Microsoft Networks" are installed and enabled (Figure A-12).

Figure A-12 : Local Area Connection Properties

Once the above has been carried out (or checked) enable the Server PC (where VMCom is
running) for File Sharing. In the Windows Explorer click on the right mouse button on any
Folder or even the disk itself. Open the ‘Sharing and Security…’ tool (Figure A-13).
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Figure A-13 : Windows Sharing and Security Tool

Next, click to confirm that you understand the security risks, but want to share files without
running the wizard, then OK .

Figure A-14 : Windows DB Properties

Then select “Just enable the file sharing” and click OK.

Figure A-15 : Just Enable File Sharing Option

Once this is complete, the file sharing in windows can be again disabled if required. The
remote computer now starts displaying the requested Waveform.
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B ABBREVIATIONS
The table below defines the abbreviations found in this manual and associated Vibro-Meter
documentation.

Abbreviation Definition

AC Alternating Current

Amp Ampere

ANSI American National Standards Institute

ASCII American Standard Code for Information 
Interchange

BMP Bitmap

BW Bandwidth

CCW Counter-clockwise (anti-clockwise)

CD-ROM Compact Disk - Read Only Memory

cpm Cycles Per Minute

CMC Condition Monitoring Card

CMS Condition Monitoring System

CPU Central Processing Unit

CRC Cyclic Redundancy Check

CSV Comma Separated Values

CU Collection Unit

CW Clockwise

DAT Digital Audio Tape

DB Database

DBMS Database Management System

DC Direct Current

DCS Distributed Control System

DDE Dynamic Data Exchange

DHCP Dynamic Host Configuration Protocol

DSN Data Source Name

DSP Digital Signal Processor

FFT Fast Fourier Transform

FTP File Transfer Protocol

g gravity (Unit of Acceleration)
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GB Gigabyte

GIF Graphic Interchange Format

GUI Graphical User Interface

HP High Pressure (Turbine)

HW Hardware

Hz Hertz

ID Identifier

IOC Input / Output Card

IP Internet Protocol

ISO International Standards Organisation

JPEG Joint Photographics Experts Group

kHz Kilohertz (103 Hertz)

kV Kilovolt (103 Volts)

LAN Local Area Network

LED Light Emitting Diode

LP Low Pressure (Turbine)

mA Milliamp (10-3 Ampere)

max. Maximum

MHz Megahertz

min. Minimum

mins Minutes

MPC Machinery Protection Card

MPS Machinery Protection System

MTS Minimum Tracked Speed

N/A Not Applicable

NT New Technology

OC Open Collector

ODBC Open Database Connectivity

OLE Object Linking and Embedding

OPC Open Connectivity

Pa Pascal (SI Unit of Pressure)

PC Personal Computer

Abbreviation Definition
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PLC Programmable Logic Controller

pF Pico Farad (10-12 Farad)

P/N Part Number

ppm Parts Per Million

psi Pounds per Square Inch

PWD Password

RAID Redundant Array of Inexpensive Disks

RAM Random Access Memory

RLC Relay Card

RMS Root Mean Square

ROM Read Only Memory

RPC Remote Procedure Call

RPM Revolutions Per Minute

RTU Remote Terminal Unit

SQL Structured Query Language

SVGA Super Video Graphics Array

TCP/IP Transmission Control Protocol/Internet Protocol

TCS Turbine Control System

TDC Top Dead Centre

Ts Sampling Duration

UDP User Datagram Protocol

UID User ID

V Volts

VAC Voltage, Alternating Current

VDC Voltage, Direct Current

VM600
Vibro-Meter’s VM600 Series (Machinery 
Protection Systems and
Condition and Performance Monitoring Systems)

VMCom VM600 Communications Handler

Abbreviation Definition
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C INDEX

Symbols
.bat 7-24
.csv 13-5

.db 7-2, 7-7

.gr 10-24

.log 7-2, 7-21, 7-34

.m 10-35

.txt 7-39

.wav 10-31

A
acknowledging events 13-2
ActiveX objects 10-17
Adaptive Server Anywhere

as database management system 2-3
backup utility 7-37
cache memory parameters 7-19
command-line parameters 7-9
installation options 4-1
installed version of A-4
installing 4-1
SQL version used by 7-35
uninstalling 4-7
upgrading 4-4

alarm (audible), creating 10-30
alarm exceedence 1-6
alarm priority 9-22
alarm threshold 1-9, 1-15, 1-19
alarms

data acquisition rates 1-12
priority 1-4, 1-6
storage interval 1-19
thresholds of 1-4
to activate Alternative mode 1-9

alert threshold 1-4
alternative mode 1-9, 1-15
AMPL_PH macro 10-23

amplitude
displaying in Mimic 10-23
exceedences 1-20
exceedences, logging 13-1
filtering data in range 1-19
highest, as band peak 1-4, 9-24
of first harmonic 1-3

Analog Resolution parameter 1-19
applicability of software -xv
application log file 8-11, A-1
architectural view 9-7
audible alarm, creating in Mimic 10-30
averaging interval 9-32

B
background

images in Mimic 10-25
operating mode 1-8

backing up
databases 7-36—7-39
databases with Adaptive Server Anywhere 

utility 7-37
transaction log file 7-39

band peak rectifier function 1-4
bands

See frequency bands
bus, raw/tacho of VM600 rack 9-14, 9-15, 9-39

C
cache memory 7-18
cards

CMC 16. See CMC 16 card
configuring 9-11
CPUM 2-6, 9-11
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IOC 16T. See IOC 16T card
IOCN 2-6
MPC 4 (machinery protection) 9-14
RPS 6U 9-11

changing passwords 9-6
channels

associating value indicator with 10-13
configuring 9-13, 9-23
displayed as value indicator 10-13
reference speed 9-33
viewing in architectural view 9-7

characteristic numbers 1-3
client application 7-3
client/server architecture 3-7, 7-3
cloning 9-25
cloning configurations 9-12, 9-25
CMC 16 card

defining in Configuration Editor 9-7
DIAG LED 8-2
downloading firmware to 5-2
part number of 2-6
supported firmware versions 5-1
TCP/IP address of 8-2

CMC 16. See  CMC 16 card
CMD macro 10-20
CMS cards 1-1
CMS Software

installing 4-1
modules, overview of 3-7
operating modes 1-8
reinstalling 4-5
upgrading 4-5

commands
executing shell 10-28
ipconfig 7-11
ping 7-12
to run programs from value indicator 10-28
translation by ODBC driver 7-3
Windows (running from macro) 10-20

comma-separated file 13-5
committing configurations 3-3, 9-1
communications handler

See VMCom communications handler
communications protocol 7-5
Compression Ratio parameter 1-19
configuration

data 7-4

recommended minimum hardware 2-5
Configuration Editor

architectural view 9-7
configuring cards 9-11
configuring channels 9-13, 9-23
configuring machines 9-31
configuring outputs 9-13, 9-23
configuring racks 9-10
copying and pasting configurations 9-25
creating new configurations 9-35
defining new cards in 9-7
defining new machines 9-30
defining new stations 9-7
logical view 9-6
overview 9-1
printing IOC 16T configuration 9-39
switching views in 9-7
viewing current configuration in 9-6

configurations
CMS Software 2-2
committing 3-3, 9-1
copying 7-26
creating new 9-35
distributed 2-2
downloading to rack 9-38
modifying 10-8
single-PC 2-2
template 7-30

configuring
cards in Configuration Editor 9-11
channels in Configuration Editor 9-13, 9-23
IOC 16T card 9-8, 9-41
machines in Configuration Editor 9-31
outputs in Configuration Editor 9-13, 9-23
racks in Configuration Editor 9-10
two-state value indicators 10-27

connecting
to a database server 7-17
to databases with ODBC 3-6, 7-3

console window 8-9
copying

and pasting configurations 9-25
configurations 7-26
databases 7-22, 7-26
measurement data 7-22

copying card configurations 9-12, 9-25
CPUM card
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part number of 2-6
specifying TCP/IP address of 9-10

CreateService (when creating a service) A-2
creating

groups of objects 10-24
Mimic subdocuments 10-32
new configurations 9-35
new objects in Mimic 10-11
physical database files 7-5
remote ODBC link 7-14

customizing
event log 13-4

cutoff, lowspeed 1-9, 1-10

D
data

acquisition modes 1-2
acquisition rates 1-12
configuration 7-4
historic 12-3
measurement 7-4
realtime 12-3
selecting for graphs 12-5
spectrum 1-3
transient 12-3
trend 1-3

Data Analyser
creating graphs in 12-3
displaying data in 11-4
displaying graphs 12-6
filters 12-5
graph types 12-4
introduction 12-1
main window, parts of 12-2
overview 3-4
prerequisites 12-1
starting 12-2

data source name 7-4
data sources 7-3
database

definition of 7-1
preparing to accept data 7-5
selecting for Mimic 10-2
selecting for use 9-3
structure of 7-4
structure view 9-4

Database Browser

applying filters in 11-3
introduction 11-1
main window, parts of 11-1
overview of 3-4
prerequisites 11-1
selecting outputs 11-2
selecting points 11-2
starting 11-1

database files (physical) 7-5
database management system (DBMS) 7-1
database performance

impact of mirror file 7-34
optimizing with cache memory 7-18

database server
stopping with Sybase Central 7-19

database servers
command-line parameters 7-8
connecting to 7-17
controlling access to 7-16
creating 7-7
definition of 7-1
deleting 7-20
ensuring running A-2
establishing remote connections to 7-12
in VM600 architecture 3-2
modifying parameters of 7-18
name, specifying 7-13
ODBC compliant 7-3
optimising cache memory of 7-18
PC, installing software on 4-1
specifying name of 7-8
starting automatically 7-10
starting manually 7-10
stopping 7-19
testing connections to 7-14

database software
overview 3-3
uninstalling 4-7

database tables
creating missing 7-31
relational 7-1

databases
backing up 7-36—7-39
copying 7-22, 7-26
including login information when creating 7-7

DB_UNITS macro 10-23
dbeng8.exe 8-3
dbsrv8.exe 8-3
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DC (Gap)
display base 9-15
display units 9-16
in frequency band configurations 9-24
measurement type 9-15
rectifier function 9-23
signal polarity 9-15

DDE Client/Server utility 3-6
deadband

See hysteresis
debug mode (of VMCom communications han-
dler) 8-6
default

Mimic document 10-2
passwords 9-5
passwords in Mimic 10-8

DeleteService (when deleting a service) 8-11
deleting

database servers 7-20
measurement data 7-32
Mimic documents 10-35
old measurement data 8-7
VMCom services 8-11

demonstration mode 4-3
DIAG LED (on CMC 16 card) 8-2
display

and analysis modules 3-1
supported types 2-5

distributed configurations 2-2
Distributed Control System (DCS) 3-9
documents

default Mimic 10-2
managing Mimic 10-34
specifying default Mimic 10-11
testing links between Mimic 10-34

downloading
configurations to racks 9-38
data to rack 8-1
preventing 8-6
privilege level for 9-4

drag and dropping a card’s configuration 9-12
DSN

creating a new 7-12
file 7-4
machine 7-4
system 7-4
user 7-3

dynamic data exchange (DDE)
See DDE

E
edit mode, Mimic 10-9
ellipses, drawing in Mimic 10-13
event log

customizing 13-4
exporting 13-5
filtering 13-3

event logging 1-20
Event Viewer

accessing from Database Browser 3-4
accessing from Mimic 10-6
acknowledging events in 13-2
context-sensitivity 13-1
customizing 13-4
displaying events with 10-6
exporting data from 13-5
filtering data in 13-3
filtering events with 13-3
introduction 13-1
overview of 3-5
privilege levels 13-2

events
acknowledging 13-2
high alarm 1-21
speed-related 1-21
unacknowledged 3-5, 13-1, A-2

exceedence
alarm 1-6

exporting
event log 13-5

extended filters 12-5

F
Fast Fourier Transform (FFT) 1-3
Favorites window (Mimic) 10-7
file DSNs 7-4

See also DSN
filtering

in CMS Event Viewer 13-3
in Database Analyser 12-5
in Database Browser 11-2
trend data 12-5
using CMS Event Viewer 3-5
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filters
applying 12-5
applying in Database Browser 11-3
event log 13-3
extended 12-5
removing (Event Viewer) 13-4
settings for 13-4
system 12-5

firmware
downloading to CMC 16 card 5-2

firmware versions
for CMC 16 card 5-1

first harmonic 1-3, 1-4
frequency bands

as FFT-based outputs 1-4
configuring 9-22
end value 9-24
extracting 1-4
intensity 1-3
peak amplitude of 9-24
setting thresholds for 1-4
spectral analysis of 1-12
spectral energy of 1-4
start and end positions 9-23
start value 9-24

frequently asked questions A-1
functions, rectifier 1-4

G
graphs

creating in Data Analyser 12-3
displaying 12-6
displaying from Mimic 10-6
selecting data for 12-5
types in Data Analyser 12-4
types supported by Mimic 3-5

grouping, objects 10-24

H
hardware requirements 2-6
high alert/alarm events 1-21
historic data 12-3
host name, of CPU card 9-10
hysteresis 1-20, 9-22, 9-25

I
images

formats supported in Mimic 10-16
setting background 10-25

including database login information 7-7
indicators, value 10-13
inheriting privilege levels 10-8
installing

Adaptive Server Anywhere 4-1
installing in demonstration mode 4-3
installing the CMS Software 4-1
Interactive SQL tool 7-3
IOC 16T card

configuring 9-8, 9-41
part number of 2-6
printing configuration 9-39
raw bus 9-39
rotary switches 9-41
schematic diagram of 9-40
tacho bus 9-39

IOCN card
part number of 2-6

ipconfig command 7-11

J
jumpers (on IOC16T card) 9-39

K
keyboard

inputs, as offline data 3-6
shortcuts 10-19

keyboard interface
introduction 3-7

L
license key 4-3, 6-5
lines, drawing in Mimic 10-13
links

between Mimic documents 10-33
testing 10-34
view, updating 10-34

log files
application 8-11, A-1
transaction A-5
viewing contents of 7-35
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logging, event 1-20
logical view 9-6, 10-4
login information

including when creating databases 7-7
long waveform (oscilloscope) data 1-17, 10-7
lowspeed cutoff threshold 1-9
Lube Oil Analysis System 3-9

M
machine DSN 7-4
machine states

On-load 1-9
Operational transient 1-10
Run-down 1-10
Run-up 1-9
stopped 1-9

machinery protection system (MPS) 1-1
machines

configuring 9-31
defining new in Configuration Editor 9-30

macros
AMPL_PH 10-23
CMD 10-20
DB_UNITS 10-23
MASTER 10-20
OUTPUT_NAME 10-23
POINT_NAME 10-23
REC_FUN 10-23
SUPER 10-20
syntax 10-20
USER 10-20
using to access Mimic documents 10-8

managing
databases 7-1
groups of objects 10-24
Mimic documents 10-34

manual
operating mode 1-9
start of database server 7-10
start of VMCom 8-1, 8-2

MASTER macro 10-20
Master privileges 9-5
measurement data

copying 7-22
deleting from database 7-32
in VM600 database 7-4

Mimic
accessing other modules with 10-1
cloning objects 10-12
default document 10-2
displaying graphs in 10-6
documents, managing 10-34
drawing text objects 10-16
image formats supported 10-16
introduction to 10-1
keyboard shortcuts 10-19
main window, parts of 10-3
objects 10-11
options, setting 10-10
overview 3-4
prerequisites 10-2
privilege levels 10-8
running in demonstration mode 4-3
security 10-8
selecting a database 10-2
setting timeout A-3
specifying default document 10-11
starting 10-2
status indicators 10-14
subdocuments 10-32
supported graph types 3-5
testing links 10-34
timer objects 10-15
value indicators 10-13
views 10-4

Mimic documents
deleting 10-35
linking 10-33
setting background image of 10-25

mirror file, database performance with 7-34
Modbus

Client/Server utility 3-7
protocol 7-5

modes
alternative 1-9, 1-15
background 1-8
data acquisition 1-2
manual 1-9
switching Mimic 10-9
transient 1-9

Modicon 3-7
modules

accessing from Mimic 10-1



A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

CMS Software Manual (Volume 1) MACMS-SW/E C - 7
Edition 10 - Jul 26/07

Configuration Editor 3-3
Data Analyser 3-4, 11-4, 12-1
Database Browser 3-4
database software 3-3
Event Viewer 3-5
Mimic 3-4
VM600 Administrator 3-3
VMCom Communications Handler 3-3

O
objects

changing Z-order of 10-18
cloning 10-12
grouping 10-24
inserting OLE 10-17
linking Mimic 10-33
Mimic 10-11
setting properties of 10-20
ungrouping 10-24

ODBC
compliance for database 3-3
data sources 7-3
overview 3-6, 7-3

offline data
OPC 3-7

offline points
copying 9-29
copying data for 7-28
creating 9-28
in databases 7-5
storing keyboard data in 9-28
viewing status of 9-29

OLE objects, in Mimic documents 10-17
On-load machine state 1-9
Open DataBase Connectivity

See  ODBC
OpenService (when opening a service) 8-11
operating modes

alternative 1-9
background 1-8
manual 1-9
transient 1-9

Operational transient machine state 1-10
options

Mimic 10-10
orbit acquisition

in Alternative mode 1-9

restrictions 9-27
storing data 9-26
X- and Y-probes 1-16

orbit data 1-9
oscilloscope waveform

See long waveform
OUTPUT_NAME macro 10-23
outputs

configuring 9-13, 9-23
graphing 10-7
selecting in Database Browser 11-2
specifying with Mimic macro 10-23

Overspeed Trigger threshold 1-10

P
parameters

Analog Resolution 1-19
Compression Ratio 1-19
to set cache memory size 7-19

part numbers (of VM600 cards) 2-6
passwords

changing 9-6
default 9-5
default (Mimic) 10-8
entering 9-5

peak-to-peak rectifier function 9-23
phase

displaying in Mimic 10-23
from AMPL_PH macro 10-23, 10-32
order tracking and 9-15
parameter 1-3
run-down 12-3
run-up 12-3

physical database files
as ODBC data source 7-3
creating 7-5

ping command 7-12
plots

transient cascade 1-14
waterfall 1-14

POINT_NAME macro 10-23
points

measurement units 10-23
selecting in Database Browser 11-2
specifying with Mimic macros 10-23

polygons, drawing in Mimic 10-13
power supply card (RPS 6U) 9-11
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priority, of alarms 1-4, 9-22
privilege levels

granting with MASTER macro 10-20
granting with SUPER macro 10-20
granting with USER macro 10-20
in Event Viewer 13-2
inheriting 10-8
Master 9-5
Mimic 10-8
reverting to User after timeout 10-11
setting 9-4
Super 9-5
User 9-5

probes
See also orbit acquisition
X- and Y- 1-16, 9-26

program options, Mimic 10-10
programs

dbbackup.exe 7-38
dbeng8.exe 8-3
dbsrv8.exe 8-3
RealWave.exe 10-21
setup.exe 4-1
VMCom.exe 4-6, 8-11

properties
application log 8-12
channel 9-13
CMC 16 card 9-12
data server 7-18
DBBackup advanced 7-38
machine 9-31
Mimic data 10-21
Mimic object 10-12
Min/Max Indicator 10-25
MultiValue indicator 10-25
setting Mimic object 10-20
two-state indicator 10-27
value indicator (Mimic) 10-13, 10-30
VM600 rack 9-10
VMCom communications handler 8-3, A-1
Windows service 8-10

proximity probe 9-24

Q
query

See also SQL

R
rack power supply card (RPS 6U) 9-11
racks

See VM600 racks
raw bus (on IOC 16T card) 9-39
raw signal 1-3
realtime data 12-3
RECT_FUN macro 10-23
rectangles

drawing in Mimic 10-13
rounded, changing shape of 10-13
rounded, drawing in Mimic 10-13

rectifier functions
band peak 1-4, 9-23
DC (Gap) 9-23
in Mimic macros 10-23
peak 9-23
peak-to-peak 9-23
RMS 1-4, 9-23
Smax 1-4, 9-23
true peak 1-4, 9-23
true peak-to-peak 1-4, 9-23
True RMS 1-4
true RMS 9-23

reference speed channel 1-10, 9-33
reinstalling CMS Software 4-5
release notes -xvi
remote connections, establishing 7-12
remote ODBC DSN 7-13
remote ODBC link, creating 7-14
requirements

general hardware 2-4
operating system 2-4
VM600 hardware 2-6

RMS rectifier function 1-4
rotary switches (on IOC 16T card) 9-41
RPS 6U card 9-11
Run mode, Mimic

displaying values with macros 10-24
switching to 10-9

Run-down machine state 1-10
Run-up machine state 1-9

S
saving

changes to database 9-4
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Database Browser plots in database 11-4
event log to disk 13-5
groups of objects to file 10-18, 10-24
Mimic documents 10-8, 10-35
Mimic subdocuments 10-33
physical database files 7-6

security
in Mimic 10-8
of database servers 7-16
preventing Mimic close for Read level 10-10
reverting to Read privileges 10-11

selecting
a database 9-3
values to graph in Mimic 10-7

servers
See database servers

service, setting up VMCom as a 8-5
services

checking whether running 4-5
deleting 8-11
starting automatically 7-10
starting database servers as 7-10
starting with Sybase Central 7-11

shortcuts, keyboard (Mimic) 10-19
signal processing 1-3
signal, raw 1-3
single PC configurations 2-2
Smax

configuring frequency band as 9-24
data acquisition 1-12
rectifier function 1-4, 9-23

snapshot copy of a database, creating 7-22
sounds, playing in Mimic 10-28, 10-30
spectral bands

See frequency bands
spectral components

See frequency bands
spectrum data 1-3
speed

as measurement point type 3-5
channels 1-10
machine 1-9
nominal 1-10
reference channel 9-33
related events 1-21

SQL
92 3-3
scripts 4-3

statements 7-3
tools 7-3
version used by Adaptive Server Anywhere 

7-35
SQL Anywhere Adaptive Server

See Adaptive Server Anywhere
starting

database servers automatically 7-10
Mimic 10-2
Sybase Central 7-7

state, machine 1-9
stations

appending to rack 7-29
attributing machines to 9-30
attributing to database 9-30
defining new in Configuration Editor 9-7
graphing 10-7
naming rules 7-30

status indicator 10-14
Stopped machine state 1-9
stopping

database servers 7-19
VMCom communications handler 8-10

storage interval, of alarms 1-19
straight lines, drawing in Mimic 10-13
structure view, of database 9-4
Structured Query Language

See SQL
subdocuments, creating Mimic 10-32
SUPER macro 10-20
Super user privileges 9-5
switching views 9-7
Sybase Central 4-1

backing up databases 7-37
creating user IDs 7-17
database servers list 7-8
installing 4-1
starting 7-7
starting services manually 7-11
stopping database server with 7-19
using to create log file 7-33
viewing log file contents 7-35

Sybase SQL Anywhere
See Adaptive Server Anywhere

system DSNs 7-4
See also DSN

system filters 12-5
system tray 7-9, 8-9
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T
tacho

See speed
tacho bus (on IOC 16T card) 9-39
task list, Windows 8-3
TCP/IP address

of CMC 16 cards 8-2
of racks, defining 9-10

templates 9-25
text

as objects in Mimic 10-16
third-party tools

DDE Client/Server utility 3-6
Modbus Client/Server 3-7

thresholds
alarm 1-4
alert 1-4
lowspeed cutoff 1-9
Overspeed Trigger 1-10
setting for output bands 1-4

timeouts
Mimic 10-11, A-3

timer objects 10-15
tools

DDE Client/Server 3-6
Interactive SQL 7-3
Modbus Client/server 3-7

transaction log file
and database performance A-5
backing up 7-39
specifying use of a 7-34

transient data
cascade plot 1-14
displaying 12-3

transient operating mode 1-9
trend data

applying filter to 12-5
displaying subset of 12-5
overview 1-3

troubleshooting A-1
true peak rectifier function 1-4, 9-23
true peak-to-peak rectifier function 1-4, 9-23
True RMS rectifier function 1-4
Turbine Control System 3-9
two-state value indicators 10-27

U
unacknowledged events 3-5, 13-1
unacknowledged messages A-2
ungrouping objects 10-24
uninstalling

Adaptive Server Anywhere 4-7
database software 4-7

updating, Mimic links view 10-34
upgrading CMS Software 4-5
user DSNs 7-3

See also DSN
user ID

creating with Sybase Central 7-17
default 7-7
in VMCom parameters 8-7
including in login information 7-7
to access database server 7-16
Windows (Mimic) 10-11

USER macro 10-20
User privileges 9-5

V
validation levels 1-5
value indicators

associating with channels 10-13
creating 10-13
running programs from 10-28
two-state, configuring 10-27

views
architectural 9-7
links (in Mimic) 10-4
logical 9-6
logical (in Mimic) 10-4
switching 9-7

VM600 Administrator module
introduction 6-1
overview 3-3
shortcuts 8-9

VM600 racks
appending 7-29
cache memory size 7-19
cards in 1-1
configuring 7-4, 9-10
displaying realtime data from 3-4
downloading configurations to 3-2, 9-38
physical location of 9-10
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power supply card RPS 6U 9-11
specifying TCP/IP address of 9-10

VMCom communications handler
checking whether running 9-2
command-line parameters 8-5
console window 8-9
CreateService code A-2
debug mode 8-6
DeleteService code 8-11
deleting old data 8-7
introduction 8-1
OpenService code 8-11
overview 3-3
setting up as a service 8-5
starting from the desktop 8-2
starting manually 8-1
stopping 8-10
troubleshooting A-1
using database server A-2

VMCom.exe process 4-6

W
waterfall plot 1-14
Windows

commands in CMD macro 10-20
commands, running from macro 10-20
services. See services
system tray 7-9, 8-9
task list 8-3

X
X- and Y-probes 1-16, 9-26

Z
Z-order, of Mimic objects 10-18
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PRODUCT DEFECT REPORT
Should you have any problem with your Vibro-Meter product, please contact your Vibro-Meter agent. You
may need to return a defective unit to Vibro-Meter. If you do, please photocopy then fill in this form (in
English) and attach it to the defective unit. Your completed Product Defect Report is important
because it can help us rapidly solve the problem.

NOTE : Always provide a filled-in photocopy of the Product Defect Report for each defective unit. The
report must accompany the unit at all times.

Contact Details: You or the designated Contact Person for your company.     

Product Details: Plug-in modules display Product Detail information on a sticker pasted on the unit.     

Problems Observed: 

Is the problem (put an ⌧ where appropriate) : 

Name Job Title 

Company Email 

Address 

Country Post Code 

Telephone Fax 

Signature Date 

Module type: 

Serial number (S/N): Part number (P/N): 

Vibro-Meter order number: 

Date of purchase: Site where used: 

(Please continue on back of sheet if necessary)

� Always evident ? � Intermittent ? � Temperature dependent?
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Please use this space for any additional information:
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DOCUMENT EVALUATION FORM
Vibro-Meter welcomes your evaluation of this document. Your comments and suggestions help us
improve the quality of our documentation.   

Circle Yes or No to answer the following questions: 

Comments 

Contact Details: You or the designated Contact Person for your company:     

Document Title CMS Software Manual (Volume 1) 

Reference : MACMS-SW/E Edition : Edition 10 Date of 
Issue : Jul 26/07

• Is the document well organized? Yes No 
• Is the information technically accurate? Yes No 
• Would you like more technical detail? Yes No 
• Are the instructions clear and complete? Yes No 
• Are the descriptions easy to understand? Yes No 
• Are the examples and diagrams/photos helpful? Yes No 
• Are there enough examples and diagrams/photos? Yes No 
• Is the style/wording easy to read? Yes No 
• Is any information not included? (please list in “Comments” below) Yes No 

(Please continue on back of sheet if necessary)

Name Job Title 

Company Email 

Address 

Signature Date 

Please mail, email or fax this document evaluation form to: 

Technical Publications 

Vibro-Meter SA 

Route de Moncor 4 

1701 Fribourg, Switzerland 

web: www.vibro-meter.com , email: techpubs.ch@vibro-meter.com, Fax: +41 (0)26 407 15 55

http://www.vibro-meter.com
mailto:techpubs.ch@vibro-meter.com
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Please use this space for any additional comments:
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